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Legal Notices

Warranty

The only warranties for HP products and services are set forth in the express warranty statements accompanying such 
products and services. Nothing herein should be construed as constituting an additional warranty. HP shall not be 
liable for technical or editorial errors or omissions contained herein.

The information contained herein is subject to change without notice.

Restricted Rights Legend

Confidential computer software. Valid license from HP required for possession, use or copying. Consistent with FAR 
12.211 and 12.212, Commercial Computer Software, Computer Software Documentation, and Technical Data for 
Commercial Items are licensed to the U.S. Government under vendor's standard commercial license.

Copyright Notices

© Copyright 1997-2010 Hewlett-Packard Development Company, L.P.

Trademark Notices

Adobe® is a trademark of Adobe Systems Incorporated.

Intel®, Intel® Itanium®, Intel® Xeon®, and Pentium® are trademarks of Intel Corporation in the U.S. and other 
countries.

Java™ is a U.S. trademark of Sun Microsystems, Inc.

Microsoft®, Windows®, Windows® XP, and Windows Vista® are U.S. registered trademarks of Microsoft 
Corporation.

Oracle® is a registered trademark of Oracle Corporation and/or its affiliates.

UNIX® is a registered trademark of The Open Group.
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Documentation Updates

This manual’s title page contains the following identifying information:

 Software version number, which indicates the software version

 Document release date, which changes each time the document is updated

 Software release date, which indicates the release date of this version of the software

To check for recent updates, or to verify that you are using the most recent edition of a document, go to:

h20230.www2.hp.com/selfsolve/manuals

You will also receive updated or new editions if you subscribe to the appropriate product support service. Contact 
your HP sales representative for details.

Why version number 9.10?

PPM Center is an integrated part of the HP BTO Operations version 9 portfolio. Using this version number aligns 
PPM Center with other products that are releasing in the same time frame. PPM Center 9.10 builds on  
PPM Center 8.0x and is an extension of that product version family. Product releases within the HP BTO Operations 
version 9 portfolio will feature shared technology, common platforms, integrations, solutions, upgrade tools, and 
professional services offerings.
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Support

You can visit the HP Software Support Web site at:

hp.com/go/hpsoftwaresupport

HP Software Support Online provides an efficient way to access interactive technical support tools. As a valued 
support customer, you can benefit by using the support site to:

 Search for knowledge documents of interest

 Submit and track support cases and enhancement requests

 Download software patches

 Manage support contracts

 Look up HP support contacts

 Review information about available services

 Enter into discussions with other software customers

 Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also require a support 
contract.

To find more information about access levels, go to: 

h20230.www2.hp.com/new_access_levels.jsp

To register for an HP Passport ID, go to: 

h20229.www2.hp.com/passport-registration.html
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1 Getting Started with HP Solution 
Integrations
Introduction to HP Solution Integrations

PPM Center integrations support Change Management and Release 
Management within your organization. Many of these integrations use  
HP Application Lifecycle Management (ALM) software, which adds to PPM 
Center a set of entities that support standard Information Technology 
Infrastructure Library (ITIL) processes. These entities can be configured to 
meet your business needs. 

ALM software facilitates integrating PPM Center with the following 
applications:

 HP Service Manager, for management of Service Manager changes and 
associated PPM Center requests

 HP Universal Configuration Management Database (Universal CMDB), 
for impact analysis of PPM Center requests

 HP Quality Center

 HP Release Control

In addition, without using ALM software, PPM Center can be integrated with:

 HP Service Manager, for integration of PPM Center tasks with Service 
Manager RFCs

 HP Universal CMDB, for service portfolio functionality 

These integrations help your IT organization standardize and enforce processes 
that manage application changes throughout the entire software development 
lifecycle, including development, testing, and deployment.
11



The System Requirements and Compatibility Matrix describes which versions 
of these products are supported for integration with PPM Center.

Introduction to ITIL and HP Solution Integrations

The Information Technology Infrastructure Library (ITIL) offers the world’s 
most widely accepted approach to IT Service Management (ITSM), furthering 
the goal of aligning IT with business goals and priorities. ITIL provides 
frameworks for both the organization of ITSM as well as a cohesive set of 
industry best practices.

ITIL is a process framework, and HP Project and Portfolio Management 
Center (PPM Center) is unique in its ability to customize, automate, and 
digitize processes, simplifying repeatability, enforcement, and measurement.

ITIL defines the Service Support discipline. Building on this advanced-process 
model, HP Application Lifecycle Management (ALM) software provides 
predefined request types (forms), workflows, and special commands to 
automate processes and information gathering, portlets and reports to track key 
performance indicators (KPIs), and ALM-specific security groups. 

ALM supports the following ITIL processes:

 Change Management. Overview of ITIL Change Management on page 14 
provides an overview of the ITIL Change Management process and how 
ALM supports the process. Chapter 3, Using ALM Entities, on page 31 
describes the entities provided by ALM for ITIL Change Management.

 Release Management. Overview of ITIL Release Management on page 16 
provides an overview of the ITIL Release Management process and how 
ALM supports the process. Chapter 3, Using ALM Entities, on page 31 
describes the entities provided by ALM for ITIL Release Management.

ALM can be used as a starting point, and then extended to support the process 
requirements that meet the specific needs of your organization. Using these 
tools, ALM helps enforce repeatable ITIL processes to reduce their operating 
cost and risk.
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Chapter 2, Installing and Setting Up ALM Software, on page 23 provides 
instructions for installing ALM and configuring PPM Center to ensure that the 
integrations function properly.

Chapter 3, Using ALM Entities, on page 31 provides information about the 
ALM entities, except for a few that are used only for integration of PPM 
Center with Quality Center. 

ALM facilitates integration of PPM Center with the Service Manager service 
desk application. Using this integration, changes in Service Manager can be 
automatically converted to ALM requests for change (RFCs) and imported into 
PPM Center. In addition, fields in PPM Center can be configured to send 
updates back to the originating changes in Service Manager. For more 
information, see Integration of PPM Center Requests with Service Manager 
Changes, Using ALM on page 18 and Chapter 4, Integrating PPM Center 
Requests with HP Service Manager Changes, Using ALM, on page 91.

For additional Change Management and Release Management functionality, 
ALM provides the ability to integrate PPM Center with Universal CMDB, with 
Quality Center, and with Release Control. Using these integrations and 
appropriate approvals throughout the process, the ALM - Request for Change 
workflow does the following:

 Uses Universal CMDB to perform preliminary impact analysis on a 
proposed change.

 Automatically creates Quality Center requirements or defects based on 
associated PPM Center requests and keeps their fields synchronized, 
providing data visibility in both applications and ensuring that QA 
personnel create and execute appropriate test plans.

 When adding a package to a release, provides links in an ALM portlet to 
Release Control for that release. Release Control displays impact and 
collision analysis for the release that is poised for deployment to a 
production (live) system.

For more information about integration of PPM Center with Universal CMDB, 
see Integration of PPM Center with Universal CMDB for Impact Analysis of 
Requests, Using ALM on page 19 and Chapter 5, Integrating PPM Center with 
HP Universal CMDB, Using ALM, on page 137.
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For more information about integration of PPM Center with Quality Center, 
see Integration of PPM Center with Quality Center, Using ALM on page 20 
and Chapter 6, Integrating PPM Center with HP Quality Center, Using ALM, 
on page 149.

For more information about integration of PPM Center with Release Control, 
see Integration of PPM Center with Release Control, Using ALM on page 21 
and Chapter 7, Integrating PPM Center with HP Release Control, Using ALM, 
on page 245.

In addition, without using ALM software, PPM Center tasks can be integrated 
with Service Manager RFCs, as described in Chapter 8, Integrating PPM 
Center Tasks with HP Service Manager RFCs, on page 251.

Also without using ALM software, PPM Center can be integrated with 
Universal CMDB to provide service portfolio functionality, as described in 
Chapter 9, Integrating PPM Center with HP Universal CMDB for Service 
Portfolio, on page 269.

Overview of ITIL Change Management

ITIL defines a change as the addition, modification, or removal of an 
approved, supported, or baselined hardware component, network, software, 
application, environment, system, or desktop build, or associated 
documentation. The primary goal of the ITIL Change Management process is 
to ensure that standardized methods and procedures are used for efficient and 
prompt handling of all changes, in order to minimize the impact of 
change-related incidents upon service quality. Although changes often arise as 
a result of unexpected problems, most changes result from planned requests for 
change (RFCs) from the business or IT organization.

ALM software allows users to submit RFCs along a predefined Request for 
Change process toward resolution. ALM portlets can be added to a user’s PPM 
Dashboard to monitor key performance indicators (KPIs) related to the 
submitted RFCs. Additionally, reports can be run to obtain summaries and 
scheduling details.
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Chapter 3, Using ALM Entities, on page 31 discusses the PPM Center entities 
that ALM provides for use in the ITIL Change Management process, including 
the following:

 Change Management request type, named ALM - Request for Change 
(RFC)

 Associated Change Management workflow, named ALM - Request For 
Change 

 Associated Change Management portlets

 Associated Change Management reports

These ALM entities simplify each of the supported integrations with PPM 
Center, as introduced in Optional PPM Center Integrations on page 17.

Change Management Roles

The following roles play an active part in the ITIL Change Management 
process:

 System Owner

 Change Manager

 CAB group (Change Advisory Board) or CAB/EC group (Change 
Advisory Board – Emergency Committee)

o Change Manager 

o Customer(s) 

o Applications Development Manager

o QA Manager

o Operations Manager (or maintainers where appropriate) 

 Change Builder

 Independent Tester

 Applications Development Manager
Getting Started with HP Solution Integrations 15



In addition to being valuable divisions of responsibility, these roles are used to 
designate user security for the default ALM - Request For Change workflow 
(see ALM - Request For Change Workflow on page 41).

Overview of ITIL Release Management

ITIL defines a release as a collection of new and/or changed components that 
are tested and introduced into the live (production) environment together. The 
ITIL Release Management process helps to design and implement efficient 
procedures for the distribution and installation of changes. This process 
includes coordinating build and testing activities to help ensure that only the 
authorized and tested versions of changes are implemented in production. 
Ultimately, releasing a change requires the following actions:

 Developing the change

 Designing the change

 Testing the change for functionality, quality, and performance

 Pushing the change into production

ALM software makes it easier for users to collect information for a release 
using a release form, which is submitted along a predefined release 
management process (see ALM - Release Request Workflow on page 74). After 
the initial release process steps have been completed, the release is created and 
the RFCs that are being processed along the ALM - Request For Change 
workflow (see ALM - Request For Change Workflow on page 41) can be added 
to the release in preparation for its deployment to the test and live 
environments. The release management process then moves through testing 
and deployment steps toward completion. ALM portlets can be added to a 
user’s PPM Dashboard to monitor the status of releases. Additionally, reports 
can be run to obtain release summaries and scheduling details.

Chapter 3, Using ALM Entities, on page 31 discusses the PPM Center entities 
that ALM provides for use in the ITIL Release Management process, including 
the following:
16 Chapter 1



 Release Management request type, named ALM - Release Management

 Associated Release Management workflow, named ALM - Release 
Request 

 Associated Release Management portlets

 Associated Release Management reports

Release Management Roles

The following roles play an active part in the ITIL Release Management 
process:

 Release Manager

 Test Manager

 Applications Development Manager

 Operations Manager

 Change Manager

 CAB group (Change Advisory Board)

In addition to being valuable divisions of responsibility, these roles are used to 
designate user security for the default ALM - Release Request workflow (see 
ALM - Release Request Workflow on page 74).

Optional PPM Center Integrations 

As described in the following sections, PPM Center version 9.10 can be 
integrated with various HP products to enhance the functionality of PPM 
Center and those products.

Product documentation for PPM Center and the products with which it 
integrates is available at the following Web site:

h20230.www2.hp.com/selfsolve/manuals 
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Integration of PPM Center Requests with Service Manager Changes, Using 
ALM

Integrating PPM Center with the Service Manager service desk application 
using ALM software provides the following benefits:

 Changes that originate in Service Manager can be automatically imported 
into PPM Center as requests that PPM Center manages.

 Changes in Service Manager can be automatically updated, based on 
revisions to requests in PPM Center.

 PPM Center acts as a single, comprehensive repository of application 
change requests collected throughout IT, including change records (tickets) 
from Service Manager.

The ALM software provides configurable adapter files that serve as the 
software interface between PPM Center and Service Manager. An adapter file 
includes filters and field mappings to convert changes from one data model to 
the other.

This guide assumes that Service Manager has been installed and is available 
for integration. 

For detailed information about configuring and using integration of PPM 
Center with Service Manager, including details about configuring parameters 
in the server.conf file, see Chapter 4, Integrating PPM Center Requests with 
HP Service Manager Changes, Using ALM, on page 91.

Any request type you use for Service Manager must include the fields in the Service 
Desk System Info section of the ALM - Request for Change (RFC) request type, as 
shown in Table 3-2 on page 35, and those fields must be completed. For detailed 
request type field specifications, see the ALM - Request for Change (RFC) request 
type in the PPM Workbench.
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Using Integration of PPM Center with Quality Center To Enhance Integration of PPM 
Center with Service Manager 

Functionality of integration of PPM Center with Service Manager is enhanced 
if PPM Center and Quality Center are also integrated—in both Service 
Manager and PPM Center, you can see the Quality Center statuses for an RFC. 

See ALM - Request for Change (RFC) Request Type on page 32 for 
descriptions of the ALM - Request for Change (RFC) request type fields that 
are related to integration of PPM Center with Quality Center.

Integration of PPM Center with Universal CMDB for Impact Analysis of 
Requests, Using ALM

Integrating PPM Center with Universal CMDB using ALM software provides 
the following benefits:

 The Change Advisory Board can use the integration to run an impact 
analysis in Universal CMDB and forecast the effects that each change 
request will have on the organization’s IT environment. 

 The resulting report provides the Change Advisory Board with an 
indication of how the organization’s system will cope with each change if 
the change is later developed and deployed, and thus assists the Change 
Advisory Board in deciding whether to approve certain changes for 
development.

 Your system infrastructure, such as servers or applications, might get 
modified while the software change is being developed and evaluated for 
quality. As a result, the original impact analysis for the change might not 
be valid. After the change has been evaluated and approved for 
deployment, you can perform another impact analysis.

This guide assumes that Universal CMDB has been installed and is available 
for integration. 

For general information about the benefits of integrating PPM Center and Quality 
Center whether or not PPM Center and Service Manager are integrated, see 
Integration of PPM Center with Quality Center, Using ALM on page 20. 
Getting Started with HP Solution Integrations 19



For detailed information about configuring and using integration of PPM 
Center with Universal CMDB for impact analysis of requests, including details 
about configuring parameters in the server.conf file, see Chapter 5, 
Integrating PPM Center with HP Universal CMDB, Using ALM, on page 137. 

Integration of PPM Center with Quality Center, Using ALM

Integrating PPM Center with Quality Center using ALM software allows you 
to incorporate the quality assurance (QA) process into the change request 
development process, providing the following benefits:

 Integration and enforcement of QA testing into the change process. The 
process can be initiated when the development process begins, and QA 
planning activities can proceed in parallel with development. The QA 
teams can then spend more time testing changes after development has 
been completed.

 Management and tracking of test requirements, plans, and results in 
Quality Center version 10.00, with visibility in PPM Center,.

 Data sharing between PPM Center and Quality Center.

 Automatic activation of Quality Center processes by PPM Center. Creating 
a request in PPM Center can create a requirement or defect in Quality 
Center. 

 Automatic creation of a request in PPM Center when a defect is created in 
Quality Center version 11.00.

 Automatic ongoing synchronization of defects and requirements in Quality 
Center with requests in PPM Center, as well as hierarchical 
synchronization of requirements in Quality Center with requests in PPM 
Center. 

This guide assumes that Quality Center has been installed and is available for 
integration. 

For detailed information about configuring and using integration of PPM 
Center with Quality Center, see Chapter 6, Integrating PPM Center with HP 
Quality Center, Using ALM, on page 149. Configuration procedures are 
different for integration with Quality Center version 10.00 and version 11.00, 
and the chapter describes integration with each of those versions.
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Integration of PPM Center with Release Control, Using ALM

Integrating PPM Center with Release Control using ALM software allows you 
to assist IT managers and the Change Advisory Board in providing the 
following benefits:

 Assessing the business impact of changes that have been developed and 
tested, and deciding whether to approve the changes for deployment

 Providing information about the components in the organization’s IT 
environment that will be impacted by the developed changes

 Proactively sending notifications of the business risk involved in each 
change

 Identifying potential conflicts among concurrently scheduled changes

 Improving visibility over the change deployment process

During the impact analysis phase of the Request for Change lifecycle, if PPM 
Center is integrated with both Release Control and Universal CMDB, the 
Launch HP Release Control button appears on the request. When launched, 
Release Control provides additional impact analysis that helps users assess and 
approve changes.

For each change request, the ALM - Releases portlet provides a link to log in to 
Release Control, where various tabs contain information about the change 
requests. 

This guide assumes that Release Control has been installed and is available for 
integration. 

For detailed information about configuring and using integration of PPM 
Center with Release Control, including details about configuring parameters in 
the server.conf file, see Chapter 7, Integrating PPM Center with HP Release 
Control, Using ALM, on page 245. 
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Integration of PPM Center Project Tasks with Service Manager RFCs

You can integrate PPM Center project tasks with Service Manager requests for 
change (RFCs) to allow PPM Center project managers to specify which tasks 
in a project, if any, automatically create corresponding RFCs in Service 
Manager. As the RFCs are completed in Service Manager, the statuses of the 
associated PPM Center tasks are automatically set to Complete (or Cancelled).

For more information about the integration of PPM Center tasks with Service 
Manager RFCs, see Chapter 8, Integrating PPM Center Tasks with HP Service 
Manager RFCs, on page 251.

Integration of PPM Center with Universal CMDB for Service Portfolio

You can integrate PPM Center with Universal CMDB for service portfolio 
functionality—the tracking of labor costs categorized by service. In a PPM 
Center request, users can select (and may be required to select) a service from a 
list of services related to IT initiatives. The services can be as specified in ITIL 
definitions. With this integration, the service list is retrieved from Universal 
CMDB when needed. 

For more information about retrieving service lists in this way, see Chapter 9, 
Integrating PPM Center with HP Universal CMDB for Service Portfolio, 
on page 269.

This integration does not use the ALM entities and does not require installing the ALM 
software.

This integration does not use the ALM entities and does not require installing the ALM 
software.

Service lists can also be managed in PPM Center for use in requests and project 
tasks. For more information, see the HP Demand Management User’s Guide 
regarding requests and the HP Project Management User’s Guide regarding tasks.
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2 Installing and Setting Up ALM Software
Overview of Installation and Configuration

Installing and setting up ALM software includes the following procedures, as 
described in this chapter:

 Installing the ALM software

 Configuring particular ALM-related entities in PPM Center

 Restarting the PPM Server

Configuration activities that are unique to the integrations with HP Service 
Manager, HP Quality Center, HP Release Control, and HP Universal CMDB 
are described in their respective chapters.

System Requirements

To use ALM, you must install ALM version 9.10 in either of the following 
cases:

 You used ALM version 2.00 entities with PPM Center version 8.00, and 
PPM Center was then upgraded to version 9.10.

 PPM Center is at version 9.10 and ALM has not been previously installed.

To use the request types and workflows provided by ALM, verify that you 
have user licenses for PPM Center Demand Management. For information 
about permissions, configuration, and security, see the HP Demand 
Management Configuration Guide and the Security Model Guide and 
Reference. 
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Installing HP Application Lifecycle Management

Install HP Application Lifecycle Management (ALM) as described in the 
following sections. 

General Preparations for Installation

To prepare for installation:

1. Obtain the ALM software.

2. Log on to the PPM Server.

3. Confirm that the system requirements have been met. See System 
Requirements on page 23.

4. Save the ALM installation file (ppm-910-ALM.jar) to the <PPM_Home> 
directory. <PPM_Home> represents the path where the PPM Center instance 
is installed. For example: xyzserver/E/PPMServer.

Perform Backup and Restart the PPM Server in Restricted Mode

The steps in this section are recommended but not required. 

Before installation, do the following:

1. Back up the database and file system for the PPM Server.

2. Stop the PPM Server and restart it in restricted mode, as follows:

a. Stop the PPM Server.

You do not need to unpack the installation file. The installation process 
automatically unpacks it.

For more information about the steps in this procedure, see the Installation and 
Administration Guide. 
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b. Run the following script: 

sh ./setServerMode.sh RESTRICTED

c. Start the PPM Server.

Run the Installation Script

To run the installation script to install the ALM software:

1. Navigate to the <PPM_Home>/bin directory.

2. Run the following script:

sh ./kDeploy.sh -i ALM

3. As kDeploy.sh runs, respond to its prompts.

When the installation completes successfully, the following message is 
displayed:

Deployment ALM has been successfully installed.

The following sections in this chapter describe initial configuration of ALM.

Configuring ALM-Related Entities in PPM Center

After installing ALM software, perform the procedures described in the 
following sections.

Creating Contact User Data

To use the ALM - Request for Change (RFC) request type, you must create a 
global user data field of type Contact User Data, whether or not you will be 
establishing any of the integrations of PPM Center with other applications. 
When you select a contact in the RFC, the value in the contact’s USER_DATA1 
field populates the Contact Location field in the RFC. Table 2-1 describes the 
important parameters for this field. Figure 2-1 shows the User Data Context 
window.
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In the PPM Workbench, select Configuration > User Data and select Contact 

User Data to access the User Data Context window. For more information 
about creating user data, see the HP Demand Management Configuration 
Guide. 

Figure 2-1. Contact user data field

Table 2-1. Contact user data field parameters

Field Name Value

Prompt Location:

Token LOCATION

User Data Column USER_DATA1

Displayed Y

Component Type Text Field

Validation (any text field of reasonable length)
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Configuring the CRT - Priority - Enabled Validation

To use the ALM - Request for Change (RFC) request type, you must add the 
values listed in Table 2-2 to the CRT - Priority - Enabled validation, whether or 
not you will be establishing any of the integrations of PPM Center with other 
applications. These priority values are used as default values and in rules. The 
rules determine priority from values specified in the Impact and Severity fields 
in the RFC. Figure 2-2 shows the Validation window.

In the PPM Workbench, select Configuration > Validations and select 
CRT - Priority - Enabled to access the Validation window. For more 
information about modifying validations, see the Commands, Tokens, and 
Validations Guide and Reference. 

Figure 2-2. CRT - Priority - Enabled validation

Table 2-2. Values to add to CRT - Priority - Enabled validation

Code Meaning

MEDIUM Medium

IMMEDIATE Immediate

PLANNING Planning
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Assigning Users to ALM Security Groups

ALM provides the following security groups:

 ALM - Application Developer

 ALM - Applications Development Manager

 ALM - CAB group (Change Advisory Board)

 ALM - Change Builder

 ALM - Change Manager

 ALM - Customer

 ALM - IT Executive Board

 ALM - Independent Tester

 ALM - Operations Manager

 ALM - QA Manager

 ALM - Release Manager

 ALM - SOX - System Owner

Users must belong to an appropriate security group to be able to see particular 
portlets. Add users to these security groups, whether or not you will be 
establishing any of the integrations of PPM Center with other applications. In 
the PPM Workbench, select Sys Admin > Users, open a user, and click the 
Security Groups tab. For more information about security groups, see the 
Security Model Guide and Reference. 

Assigning Security Groups to ALM Workflows

ALM provides several workflows. The major ones are described in detail in 
this document. Assign security groups to each workflow step in the manner 
that best meets your business needs, whether or not you will be establishing 
any of the integrations of PPM Center with other applications. In the PPM 
Workbench, select Configuration > Workflows, open a workflow, and edit it. 
For more information about configuring security groups in workflows, see the 
HP Demand Management Configuration Guide. 
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Restarting the PPM Server in Normal Mode

After you have completed all installation and configuration procedures, if you 
previously restarted the PPM Server in restricted mode, stop and restart the 
PPM Server in normal mode as follows:

1. Stop the PPM Server.

2. Run the following script: 

sh ./setServerMode.sh NORMAL

3. Start the PPM Server.

For More Information

ALM provides request types, workflows, portlets, and reports that can be 
configured to fit your business needs. For detailed information, see Chapter 3, 
Using ALM Entities, on page 31.

You can use the ALM entities whether or not you establish any of the 
supported integrations of PPM Center with other applications. You can 
configure those integrations at any time after you have installed and configured 
ALM as described in this chapter. For more information, see Optional PPM 
Center Integrations on page 17 and the integration-related chapters to which 
that section refers.

For more information about the steps in this procedure, see the Installation and 
Administration Guide. 
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3 Using ALM Entities
Overview of ALM Entities

This chapter describes the request types, workflows, portlets, reports, and 
special commands (the “entities”) provided in ALM to facilitate 
implementation of ITIL processes. Some of these entities are used by the 
integrations with other HP products.

The ALM entities provided for change management are described first, then 
the entities for release management are described, and then the special 
commands.

Several ALM entities that are used only for integrations of PPM Center with 
HP Quality Center are described in Chapter 6, Integrating PPM Center with 
HP Quality Center, Using ALM, on page 149.
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For More Information

The request types, workflows, portlets, reports, and special commands 
provided with ALM can be configured to fit your business needs. Table 3-1 
lists the types of entities and the associated PPM Center guides to which you 
should refer for configuration information. 

ALM - Request for Change (RFC) Request Type

In its implementation of the ITIL Change Management process, ALM uses the 
ALM - Request for Change (RFC) request type and sends an RFC request 
along the ALM - Request For Change workflow (see ALM - Request For 
Change Workflow on page 41).

Figure 3-1 and Figure 3-2 show the top and bottom of the Create New 
ALM - Request for Change (RFC) page that appears when you create a request 
and select the ALM - Request for Change (RFC) request type. Table 3-2 
on page 35 describes the fields in the ALM - Request for Change (RFC) 
request, including some fields that do not appear until the request is created or 
until other conditions are met.

Table 3-1. PPM Center entities and associated configuration guides

Entity Configuration Guide

Request type HP Demand Management Configuration Guide 

Workflow HP Demand Management Configuration Guide 

Portlet Creating Portlets and Modules 

Report Reports Guide and Reference 

Special command Commands, Tokens, and Validations Guide and Reference 
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Figure 3-1. Top of ALM - Request for Change (RFC) request
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Figure 3-2. Bottom of ALM - Request for Change (RFC) request
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Table 3-2. ALM - Request for Change (RFC) request fields (page 1 of 5)

Field Name (*Required) Description

RFC Summary section

RFC ID
(Read-only. Added after the RFC is created.) Number of 
the RFC, linked to the RFC.

Created By (Read-only) User who created the RFC.

Created On
(Read-only. Added after the RFC is created.) Date the 
RFC was created.

RFC Status (Read-only) Status of the RFC.

Contact Name Name of the person proposing the change.

Contact Phone
(Read-only) Telephone number of the person proposing 
the change.

RFC Priority
(Read-only) Priority of the change request. Determined 
by a combination of the Urgency and Impact fields.

Contact Email (Read-only) Email address of the RFC contact person.

Contact Location
(Read-only) Location of the person proposing the 
change.

RFC Summary Summary description of the RFC request.

Expected Start Date Expected start date for work on the RFC.

Expected Finish Date Expected end date for work on the RFC.

Assigned Developer Developer assigned to work on the RFC.

Release ID Number of the release if the change was released.

RFC Details section

*RFC Source
Source of the RFC request (for example, from a problem 
or incident).

*Urgency
Urgency of the change request (for example, from 
problem urgency).

*Impact
Business impact of doing or not doing the change (for 
example, from problem impact).
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*Reason For Change Reason for the change.

Category

(Required only after the 
request is created) 

Category of the change, based on the scope of the 
change. 

RFC Type Type of change being requested.

Service IT service that needs the change.

Change Item

(Looks like a separate section in the interface)

Expand to display a table of change items.

If the RFC has been created, click the Modify Table 
button to add a change item. The table consolidates 
existing change items (CIs), each having an 
automatically assigned sequence number (Seq), a CI 
Type (Software, Hardware, or Network), a CI Name, 
and a CI Description. 

Note: These CIs are not the same as the configuration 
items (CIs) that are retrieved when integration with 
HP Universal CMDB is established.

*Effect of no change Effect of not implementing the change.

RFC Description Description of the change request.

Authorized By
(Added after the RFC is created and assigned to a 
developer) Person who authorized the change.

Authorization Date
(Added after the RFC is created and assigned to a 
developer) Date the developer was assigned.

SOX Information section 

*System System that is impacted by the change.

SOX - In Scope System

(Read-only) SOX requirement: SOX oversight is 
required for any application that directly or indirectly 
affects financial reporting. 

This field is automatically populated with a value of Yes 
or No before the RFC is created, based on the option 
chosen for the System field.

Table 3-2. ALM - Request for Change (RFC) request fields (page 2 of 5)

Field Name (*Required) Description
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SOX Risk

SOX requirement: Risk is determined as part of SOX 
oversight.

Note: A change to a non-SOX system could be high-risk 
based on possible infrastructure/network impact.

System Owner

(Read-only. Added after the RFC is created.) Owner of 
the system.

This field is automatically populated, based on the 
option chosen for the System field.

Implementation Details section

Actual Start Date Actual start date for creation of the change.

Actual Finish Date Actual finish date for creation of the change.

Actual Duration Actual duration for creation of the change.

Actual Effort Actual effort expended during creation of the change.

Assigned Change 
Builder

Details of the change builder/implementer.

Actual Cost Actual cost of the change.

Functional 
Specifications

Allows you to add and view the functional specification 
document directly on the RFC.

Design Specifications
Allows you to add and view the design specification 
document directly on the RFC.

Impact & Resource Assessment section

Impact Severity

Specify after evaluating the Impact Analysis Report. 
This field becomes required by the ALM - Impact & 
Resource Assessment Sub WF subworkflow after CIs 
are selected in the Impacted Configuration Items 
section. 

Impact Analysis Report
Allows you to add and view an Impact Analysis Report 
generated by Universal CMDB directly on the request.

Table 3-2. ALM - Request for Change (RFC) request fields (page 3 of 5)

Field Name (*Required) Description
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Impact Assessment 
Summary

Risk assessment of the impact of the change on related 
components in the configuration management database 
(CMDB).

Impact Assessment 
Report

Allows you to add and view a manually generated 
impact assessment report based on the Impact Analysis 
Report directly on the RFC.

Expected Duration Expected duration for creation of the change.

Expected Effort Expected effort for creation of the change.

Expected Cost Expected cost of the change.

Backout Plan
Allows you to add and view the backout plan document 
directly on the RFC.

CAB Recommendations CAB recommendations, where appropriate.

Users Impacted Users expected to be impacted by the change.

Impacted Configuration Items section a 

Select Configuration 
Items button

Button to launch the Configuration Items (CIs) selector 
applet provided by Universal CMDB.

Impacted Configuration 
Items list

List of CIs added to the request, both manually and by 
using the CI selector applet from Universal CMDB.

QA Details section

Assigned Tester Person assigned to test the change.

Test Plan
Allows you to add and view the test plan directly on the 
RFC.

Detailed Test Results 
(SOX)

Allows you to add and view the detailed test results 
directly on the RFC.

Quality Center Info section b

Quality Center Instance
URL of the Quality Center instance with the project used 
for the integration. 

Quality Center Domain Domain of the project in Quality Center. 

Table 3-2. ALM - Request for Change (RFC) request fields (page 4 of 5)

Field Name (*Required) Description
38 Chapter 3



Quality Center Project
Quality Center project that is integrated with this request 
type.

Quality Center Assigned 
To User

Obsolete field that is not used by ALM. Do not use.

Quality Center 
Requirement No.

(Read-only) Requirement number in Quality Center.

Quality Center Status (Read-only) Status of the requirement in Quality Center.

Quality Center Message
(Read-only) Quality Center status message indicating 
success or error in the most recent operation. 

Quality Center 
Attachments

(Read-only) URL of the list of attachments to the Quality 
Center requirement.

Service Desk System Info section c

System Name
(Read-only) Name of the service desk application—
Service Manager.

Ticket Id (Read-only) Ticket ID in Service Manager.

Ticket Creation Date (Read-only) Ticket creation date in Service Manager.

Ticket Info (Read-only) Ticket info from Service Manager.

Ticket Priority (Read-only) Ticket priority in Service Manager.

Ticket Last Update
(Read-only) Date the ticket was last updated in Service 
Manager.

Review Summary section

Review Date Review date for the change.

Review Summary Summary of the review for the change.

a. The Impacted Configuration Items section is visible only if the Universal CMDB Impact Analysis 
field group is enabled in the request type. Data is presented for the Impacted Configuration Items 
list in this section only if PPM Center is integrated with Universal CMDB.

b. Fields in the Quality Center Info section remain visible by default but are not used if PPM Center is 
not integrated with Quality Center.

c. Fields in the Service Desk System Info section remain visible by default but are not used if PPM 
Center is not integrated with Service Manager. However, when this request type (or any other 
request type) is used for Service Manager, these fields are required.

Table 3-2. ALM - Request for Change (RFC) request fields (page 5 of 5)

Field Name (*Required) Description
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To submit an ALM - Request for Change (RFC) request:

1. Log on to PPM Center.

2. From the menu bar, select Create > Request. 

The Create New Request page appears.

3. On the Create New Request page, in the Request Type field, select 
ALM - Request for Change (RFC) and click Create. 

The Create New ALM - Request for Change (RFC) page appears, 
displaying the appropriate RFC fields.

Required fields have a red asterisk. All other fields are optional, but are 
often helpful when others are reviewing an open request. For information 
concerning a specific field, click the Help icon next to the field (if 
available). 

4. Complete the fields in all sections as appropriate.

The Notes section contains fields where notes and information concerning 
the RFC can be entered and stored. Typically, when you create an RFC, 
you do not need to add a note to it. However, add a note if you want to 
convey additional information to the reviewers and processors of the RFC.

In the References section of the RFC, you can add useful references such 
as a Web-accessible file or a document or file attached from a local 
machine. Additionally, other entities such as packages, releases, or other 
related requests may be automatically referenced based on the workflow 
steps that have been executed. For more information about adding 
references, see the HP Demand Management User’s Guide. 

The administrator can remove the Impacted Configuration Items section or the 
Quality Center Info section from the request type by removing the Universal CMDB 
Impact Analysis field group or the Quality Center Info field group, respectively, from 
the ALM - Request for Change (RFC) Header request header type. 

See the HP Demand Management Configuration Guide for details about request 
header types and field groups.
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5. On the Create New Request page, click Submit. 

The RFC is submitted. The Request Creation Confirmed page appears.

After submitting the request, on the Request Creation Confirmed page you 
can click the link for the particular request number in the Request # field to 
view the detail page of the newly generated RFC. 

When the RFC is submitted, it is assigned an initial status, such as New. 
The RFC is then routed along the ALM - Request For Change workflow 
(see ALM - Request For Change Workflow).

ALM - Request For Change Workflow

The ALM - Request For Change workflow is the sequence of approvals, 
decisions, or actions by which the RFC is processed. The RFC starts at the 
beginning of the workflow. When the RFC reaches the end of the workflow, its 
lifecycle is complete. 

Upon creation, an ALM - Request For Change (RFC) request is automatically 
set to use the ALM - Request For Change workflow.

PPM Center can be configured to allow you to save the request before you submit 
it. To have this feature enabled, see your application administrator.
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Figure 3-3 shows the workflow. Table 3-3 lists the important steps in the 
workflow and the user roles associated with those steps.

Figure 3-3. ALM - Request For Change workflow
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Table 3-3. ALM - Request For Change workflow steps (page 1 of 3)

Step User Security Description

1. Filter Request
ALM - Change 
Manager

Perform initial review and classification of 
the change request, and determine if this 
RFC is acceptable based on company 
policy.

4. SOX - In 
Scope System?

Fully automated 
step

SOX requires identification of key systems 
related to accurate financial reporting, 
directly or indirectly. This field is 
automatically determined based on the 
system selected.

3. SOX - Impact 
Assessment

ALM - SOX - 
System Owner

SOX requires additional impact assessment 
for any change that could affect financial 
reporting. The impact of not doing the 
change must be considered as well.

6. Allocate 
Priority

ALM - Change 
Manager

Validate RFC priority and determine if this is 
an Urgent Change request.

5. Urgent/
Emergency 
Changes

(None)

Call a subworkflow designed to handle 
urgent or emergency changes, described in 
ALM - RFC - Urgent Change Management 
Sub WF Subworkflow on page 47.

9. Change 
Review and 
Approval Sub WF

ALM - Change 
Manager

Call a subworkflow to manage the review 
and approval process for the RFC, 
described in ALM - Change Review and 
Approval Sub WF Subworkflow on page 48. 
(This subworkflow can, in turn, call the 
ALM - Impact & Resource Assessment 
Sub WF subworkflow.) 

7. Authorize & 
Schedule 
Change

ALM - Change 
Manager

Authorize the change request and schedule 
change for implementation.

11. Application 
Change ?

ALM - Change 
Manager

Determine if this is an application change.
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13. Infrastructure 
Changes Sub WF

(None)

Call a subworkflow to handle 
non-application changes, described in 
ALM - Infrastructure Changes Sub WF 
Subworkflow on page 51. 

12. Detailed 
Design

ALM - 
Application 
Developer

Create functional and design specification 
documents.

14. Build 
Application 
Change

ALM - 
Application 
Developer

Build application code for the change.

15. Create 
Package

ALM - 
Application 
Developer

Create a package with the code changes.

This step automatically creates a package 
and adds the package as a reference to the 
RFC request. Figure 3-4 on page 46 
illustrates a typical RFC package.

17. Plan Tests 
Sub WF

(None)

Call a subworkflow to manage the test 
planning process for the RFC, described in 
ALM - Plan Tests Sub WF Subworkflow 
on page 52.

20. Build
ALM - Change 
Builder

Build the change, in preparation for 
implementation. For an application change, 
add code components to the referenced 
package in the PPM Workbench (see the 
Create Package step).

21. Release 
Decision

ALM- Change 
Builder

Select the option to implement this 
application change as part of a release or 
independently.

22. Deploy and 
Test Changes 
Sub WF

(None)

Call a subworkflow for deploying and testing 
changes, described in ALM - Deploy and 
Test Changes Sub WF Subworkflow 
on page 54.

23. Non Release 
Sub WF

(None)

Call a subworkflow for change deployment 
not involving a release, described in 
ALM - Non Release Sub WF Subworkflow 
on page 56.

Table 3-3. ALM - Request For Change workflow steps (page 2 of 3)

Step User Security Description
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24. Release 
Sub WF

(None)

Call a subworkflow for change deployment 
involving a release, described in 
ALM - Release Sub WF Subworkflow 
on page 58.

25. Change 
Working?

ALM - Change 
Manager

Review whether the change was 
successfully implemented with no adverse 
impact.

26. Implement 
Backout Plans

ALM - 
Operations 
Manager

If the change is not working, implement 
backout plans to back out the change from 
the LIVE environment.

27. Requestor 
Sign-Off

ALM - Change 
Manager

Get sign-off from the requestor of the 
change to acknowledge that the change 
was implemented.

28. Post 
Implementation 
Review

ALM - Change 
Manager

Review the change after implementation to 
determine whether the change process was 
followed correctly.

29. Close 
(Immediate 
Success) - 100%

(None) Update status to Closed. 

Table 3-3. ALM - Request For Change workflow steps (page 3 of 3)

Step User Security Description
Using ALM Entities 45



Step 15 in the ALM - Request for Change workflow creates a package to 
deploy and test changes, and the step adds the package as a reference to the 
RFC request. This package requires specifying a workflow, and the default is 
the ALM - Change Migration workflow, as shown in the example in 
Figure 3-4. Step 22 in the ALM - Request for Change workflow calls the 
ALM - Deploy and Test Changes Sub WF subworkflow to deploy and test the 
package.

Figure 3-4. Package created for ALM - Request For Change workflow
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ALM - RFC - Urgent Change Management Sub WF Subworkflow
ALM provides an “Urgent Change” process. If a change is categorized as 
Urgent, the RFC is routed along the Urgent Change process. The 
ALM - RFC - Urgent Change Management Sub WF subworkflow is designed 
to efficiently handle impact assessment, prioritization, and creation of the 
change. Figure 3-5 shows the subworkflow.

Figure 3-5. ALM - RFC - Urgent Change Management Sub WF subworkflow
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ALM - Change Review and Approval Sub WF Subworkflow

The ALM - Change Review and Approval Sub WF subworkflow provides a 
modular review and approval process for the RFC. Figure 3-6 shows the 
subworkflow. Table 3-4 lists the important steps in the subworkflow and the 
user roles associated with those steps.

Figure 3-6. ALM - Change Review and Approval Sub WF subworkflow
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Table 3-4. ALM - Change Review and Approval Sub WF subworkflow steps

Step User Security Description

1. Categorize 
Change

ALM - Change 
Manager

Categorize the change to determine the next 
step in the workflow.

2. Create 
Project 
Proposal

ALM - CAB group 
(Change 
Advisory Board)

If the change is classified as “Major,” create a 
project proposal that includes impact.

3. IT 
Executive 
Board

ALM - IT 
Executive Board

If the change is classified as “Major,” an IT 
Executive Board is responsible for approving 
the change.

4. Impact & 
Resource 
Assessment 
Sub WF

(None)

If the change is classified as “Significant,” call a 
subworkflow to determine the impact on 
dependent infrastructure components and 
estimate the time and cost of resources, as 
described in ALM - Impact & Resource 
Assessment Sub WF Subworkflow on page 50.

5. CAB 
approval

ALM - CAB group 
(Change 
Advisory Board)

Iterative review by CAB members, resulting in 
an authorization go/no go decision (includes 
change priority, schedule, impact, and cost). 

6. Standard 
Sub WF

(None) Call a subworkflow to track standard changes.
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ALM - Impact & Resource Assessment Sub WF Subworkflow

The ALM - Impact & Resource Assessment Sub WF subworkflow provides a 
modular process for assessing change impact and planning resource usage. 
Figure 3-7 shows the ALM - Impact & Resource Assessment Sub WF 
subworkflow. Table 3-5 lists the important steps in the subworkflow and the 
user roles associated with those steps.

Figure 3-7. ALM - Impact & Resource Assessment Sub WF subworkflow
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ALM - Infrastructure Changes Sub WF Subworkflow

If an authorized request for change is not an application change, the 
ALM - Request for Change workflow calls the ALM - Infrastructure Changes 
Sub WF subworkflow to manage the approval and deployment of changes to 
TEST and LIVE environments. Figure 3-8 shows this subworkflow. 

Figure 3-8. ALM - Infrastructure Changes Sub WF subworkflow

Table 3-5. ALM - Impact & Resource Assessment Sub WF subworkflow steps

Step User Security Description

1. Resource 
Assessment

ALM - Change 
Manager

User estimates time and cost of resources.

2. Select CIs
ALM - Change 
Manager

User manually selects an initial set of 
configuration items (CIs) for the change.

3. Impact 
Assessment

ALM - Change 
Manager

User approves having Universal CMDB 
generate the Impact Analysis report, which 
adds CIs to the CI list based on predefined 
rules in Universal CMDB. 

User then evaluates the Impact Analysis 
report and creates an impact assessment 
report with recommendations.

4. Review 
Impact 
Analysis

ALM - Change 
Manager

User reviews the request, the list of selected 
CIs, and the Impact Analysis and impact 
assessment reports. The user can approve 
the change based on the impact reports, or 
return to the Select CIs step to select a 
different initial set of CIs.
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ALM - Plan Tests Sub WF Subworkflow

The ALM - Plan Tests Sub WF subworkflow provides a modular process for 
planning tests that can communicate automatically with Quality Center. If no 
integration exists, a manual process is also provided. Figure 3-9 shows the 
subworkflow. Table 3-6 lists the important steps in the subworkflow and the 
user roles associated with those steps.

Figure 3-9. ALM - Plan Tests Sub WF subworkflow
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Table 3-6. ALM - Plan Tests Sub WF subworkflow steps

Step Name User Security Description

1. Quality 
Process Mode

ALM - QA 
Manager

Determine the method of test planning, either 
automatic through Quality Center, or manual.

4. Quality 
Process Entry

ALM - QA 
Manager

The quality process entry needs to be 
approved for integration of PPM Center with 
Quality Center.

5. Generate 
Requirement in 
Quality Center

ALM - QA 
Manager

Automated step that generates a requirement 
in Quality Center.

7. Quality Center 
Requirements 
Setup

ALM - QA 
Manager

QA to complete requirement setup in Quality 
Center.

8. Quality Center 
Test Plan Setup

ALM - QA 
Manager

QA to complete test plan setup in Quality 
Center.

9. Quality Center 
Test Lab Setup

ALM - 
Independent 
Tester

QA to complete test lab setup in Quality 
Center.

2. QC 
Requirements

ALM - QA 
Manager

Create test requirements in Quality Center.

3. Create Tests
ALM - QA 
Manager

Create test plans in Quality Center.
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ALM - Deploy and Test Changes Sub WF Subworkflow

The ALM - Deploy and Test Changes Sub WF subworkflow provides a 
modular process for deploying and testing changes. The process can 
communicate automatically with Quality Center. If no integration exists, a 
manual process is also provided. Figure 3-10 shows the subworkflow. 
Table 3-7 lists the important steps in the subworkflow and the user roles 
associated with those steps.

Figure 3-10. ALM - Deploy and Test Changes Sub WF subworkflow
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Table 3-7. ALM - Deploy and Test Changes Sub WF subworkflow steps

Step Name User Security Description

1. Approve 
changes to TEST

ALM - 
Change 
Manager

Approve deployment of changes to the TEST 
environment.

2. Deploy 
Changes to TEST

ALM - 
Change 
Manager

Deploy changes to the TEST environment.

3. Quality 
Process Mode

ALM - QA 
Manager

Determine the method of testing, either 
automatic through Quality Center or manual.

5. Quality Center 
Test Execution

ALM - 
Independent 
Tester

Quality Center tests the changes in a TEST 
environment.

7. Evaluate 
Quality

ALM - QA 
Manager

After test execution (manual or using Quality 
Center), evaluate quality.

8. Impact & 
Resource 
Assessment 
Sub WF

(None)

Call a subworkflow to determine the impact of 
the changes that will be deployed, as 
described in ALM - Impact & Resource 
Assessment Sub WF Subworkflow 
on page 50.

9. Approve 
changes to LIVE

ALM - 
Change 
Manager

Approve deployment of changes to the LIVE 
environment.

10. Deploy 
Changes to LIVE

ALM - 
Change 
Manager

Deploy changes to the LIVE environment.

11. Quality 
Process Mode

ALM - QA 
Manager

Initiate sanity tests in Quality Center.

12. Running 
Sanity Tests in 
Quality Center

ALM - QA 
Manager

Run sanity tests in Quality Center.
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ALM - Non Release Sub WF Subworkflow

The ALM - Non Release Sub WF subworkflow provides a modular process for 
change deployment that can communicate automatically with Quality Center. 
If no integration exists, a manual process is also provided. Figure 3-11 shows 
the subworkflow. Table 3-8 lists the important steps in the subworkflow and 
the user roles associated with those steps.

Figure 3-11. ALM - Non Release Sub WF subworkflow
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Table 3-8. ALM - Non Release Sub WF subworkflow steps

Step Name User Security Description

1. Approve 
Deployment to 
TEST

ALM - 
Change 
Manager

Coordinate the change implementation to the 
test environment.

4. Quality 
Process Mode

ALM - QA 
Manager

Determine the quality process mode, either 
automatic through Quality Center or manual.

5. Run Tests
ALM - 
Independent 
Tester

If manual mode is chosen in the Quality 
Process Mode step, the changes need to be 
manually tested based on test plans.

6. Quality Center 
Test Execution

ALM - 
Independent 
Tester

If Quality Center mode is chosen in the Quality 
Process Mode step, once QA signals through 
Quality Center that Test execution is complete, 
this step moves the workflow ahead.

8. Evaluate 
Quality

ALM - QA 
Manager

Approve/reject the quality of the change 
deployed to the test environment.

9. Impact & 
Resource 
Assessment 
Sub WF

(None)

Call a subworkflow to determine the impact on 
dependent infrastructure components and 
estimate the time and cost of resources, as 
described in ALM - Impact & Resource 
Assessment Sub WF Subworkflow 
on page 50.

15. Rework 
Change

ALM - 
Applications 
Development 
Manager

If the quality of the change deployed to the test 
environment is rejected, the change must be 
fixed.

10. Approve 
Deployment to 
LIVE

ALM - 
Change 
Manager

Coordinate the change implementation to the 
production environment. 

14. Running 
Sanity Tests in 
Quality Center

ALM - 
Independent 
Tester

Run sanity tests in Quality Center.
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ALM - Release Sub WF Subworkflow

The ALM - Release Sub WF subworkflow is called in order to add a change 
into an existing release. The subworkflow can be called multiple times, once 
for each change to be added to the release. Once a release is specified as 
Completed, no new changes can be added to that release. Figure 3-12 shows 
the subworkflow. (For information about creating a new release, see 
ALM - Release Management Request Type on page 68.)

Figure 3-12. ALM - Release Sub WF subworkflow

ALM - Defect Template with Quality Center Integration Request 
Type and Workflow

The ALM - Defect Template with Quality Center Integration request type and 
the associated ALM - Defect Template with Quality Center Integration 
workflow are the only ALM entities that can be used only when a particular 
integration (with Quality Center, in this case) is established. These ALM 
entities are described in Chapter 6, Integrating PPM Center with HP Quality 
Center, Using ALM, on page 149.
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ALM - Change Migration Workflow

The ALM - Change Migration workflow is used to migrate changes from the 
DEV environment to the TEST environment and from the TEST environment 
to the LIVE environment. Figure 3-13 shows the workflow. The 
ALM - Change Migration workflow is the default workflow used in step 15 
of the ALM - Request For Change workflow to create a package. See 
ALM - Request For Change Workflow on page 41.

Figure 3-13. ALM - Change Migration workflow
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Change Management Portlets to Display KPIs

ALM provides several portlets that can be added to your PPM Dashboard to 
provide real-time views into several key performance indicators (KPIs). 

For information about adding portlets to your PPM Dashboard, see the Getting 
Started guide.

ALM - My RFCs Portlet

The ALM - My RFCs portlet is provided to users with the role of Change 
Manager. The portlet lists RFCs that have been created by or assigned to the 
logged-on user. 

Table 3-9 describes the filter fields for the portlet.

Figure 3-14 shows an example ALM - My RFCs portlet. 

Figure 3-14. ALM - My RFCs portlet

Table 3-9. ALM - My RFCs portlet filter fields

Field Name Description

Request Type Request type to filter on

Category Category of the RFC
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ALM - Open RFCs Portlet

The ALM - Open RFCs portlet is provided to users with the role of Change 
Manager. The portlet lists RFCs that are currently being worked on. 

Table 3-10 describes the filter fields for the portlet.

Figure 3-15 shows an example ALM - Open RFCs portlet. 

Figure 3-15. ALM - Open RFCs portlet

Table 3-10. ALM - Open RFCs portlet filter fields

Field Name Description

Request Type Request type to filter on

Assigned To User to whom the RFC is assigned

Category Category of the RFC
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ALM - RFCs By Category Portlet

The ALM - RFCs By Category portlet is provided to users with the role of 
Change Manager. The portlet displays a pie chart showing the percentage of 
RFCs in each category. 

The only filter field for the portlet, Request Type, is the request type to filter 
on. 

Figure 3-16 shows the ALM - RFCs By Category portlet.

Clicking the pie chart drills down to a list portlet.

Figure 3-16. ALM - RFCs By Category portlet
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ALM - RFCs By Reason for Change Portlet

The ALM - RFCs By Reason for Change portlet is provided to users with the 
role of Change Manager. This portlet displays a pie chart showing the 
percentage of RFCs by each type of change being considered (for example, 
new feature, enhancement, or defect fix). 

Table 3-11 describes the filter fields for the portlet.

Figure 3-17 shows an example ALM - RFCs By Reason for Change portlet. 

Clicking the pie chart drills down to a list portlet.

Figure 3-17. ALM - RFCs By Reason for Change portlet

Table 3-11. ALM - RFCs By Reason for Change portlet filter fields

Field Name Description

Request Type Request type to filter on

Status Status of the RFC
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ALM - RFCs By Status Portlet

The ALM - RFCs By Status portlet displays a pie chart showing the percentage 
of RFCs of each status. 

The only filter field for the portlet, Request Type, is the request type to filter 
on. 

Figure 3-18 shows an example ALM - RFCs By Status portlet.

Clicking the pie chart drills down to the ALM - RFCs By Status - List portlet.

Figure 3-18. ALM - RFCs By Status portlet
64 Chapter 3



Change Management Reports

ALM provides several reports that can be run to provide summary data and 
scheduling information about RFCs in the system, as well as to process 
participant data for SOX auditing. To run an ALM report:

1. Log on to PPM Center.

2. From the menu bar, select Open > Reports > Create Report. 

3. On the Submit New Report page, in the Report Category field, select 
Demand Management. 

4. Click the link for the desired report, and complete all required and any 
optional filter fields. 

5. Click Submit. 

For more information about reports, see the Reports Guide and Reference. 

ALM - Change Summary Report

The ALM - Change Summary Report provides a list of RFCs that have been 
implemented, grouped by change category. 

Table 3-12 describes the filter fields for the report. 

Table 3-12. ALM - Change Summary Report filter fields

Field Name Description

Request Type Request type to filter on

Change Status Status of the change request

Change Priority Priority of the change request

Time Period From Earliest date the RFCs were created

Time Period To Latest date the RFCs were created
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Figure 3-19 shows sample output for the ALM - Change Summary Report.

Figure 3-19. ALM - Change Summary Report output

ALM - Forward Schedule of Changes for RFC Report

The ALM - Forward Schedule of Changes for RFC report is a key report used 
in the change management process. The output of this report is a list of all the 
RFCs that are scheduled to be implemented. 
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Table 3-13 describes the filter fields for the report.

Figure 3-20 shows sample output for the ALM - Forward Schedule of Changes 
for RFC report. 

Figure 3-20. ALM - Forward Schedule of Changes for RFC report output

Table 3-13. ALM - Forward Schedule of Changes for RFC report filter fields

Field Name Description

Report Title
Title of the report. Type any alphanumeric string (up to 200 
characters in length)

Start FSC Period Earliest start date of the scheduled RFCs

End FSC Period Latest start date of the scheduled RFCs

Request Type Request type to filter on
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ALM - Release Management Request Type

The ITIL Release Management process as modeled by ALM sends a release 
request of the ALM - Release Management request type along the 
ALM - Release Request workflow (see ALM - Release Request Workflow 
on page 74) to be examined and resolved. 

Figure 3-21 shows the Create New ALM - Release Management page that 
appears when you create a request and select the ALM - Release Management 
request type. Table 3-14 describes the fields in the ALM - Release 
Management request, including some fields that do not appear until the request 
is created or until other conditions are met.
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Figure 3-21. ALM - Release Management request
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Table 3-14. ALM - Release Management request fields (page 1 of 4)

Field Name (*Required) Description

Summary section

Request Status
(Read-only) Status of the release request. Preset to 
Logged before the request is created.

Request No.
(Read-only. Added after the request is created.) 
Number of the request.

*Release Category
Release category, based on the scope of the 
release (number of changes in a release).

*Release Type Type of release.

*Release Summary Summary description of the release.

*Release ID

(Required only after the 
request is created) 

ID for the release.

Work Item Fields section a

Release Planning section

*Release Definition Summary Summary of the definition of this release.

Release Definition
Allows you to add and view the release definition 
document directly on the release request.

*Release Policy Summary

(Required only after the 
request is created)

Summary of the policy that governs this release.

Release Policy
Allows you to add and view the release policy 
document directly on the release request.

Release Plans Summary Summary of rollout plans for this release.

Release Plans

Allows you to add and view the rollout plans for this 
release (for example: a timetable of events, a 
resource plan, and who will do what and when) 
directly on the release request.
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QA Information section

Release Test Plan Summary Summary of the test plan for this release.

Release Test Plan

Allows you to add and view the release test plan 
(the plan that describes tests to be performed on 
this release in the TEST environment) directly on 
the release request.

Release Acceptance Criteria 
Summary

Summary of the release acceptance criteria for this 
release.

Release Acceptance Criteria

Allows you to add and view the release acceptance 
criteria document (which details criteria that qualify 
the acceptance of this release before deployment 
to the LIVE environment) directly on the release 
request.

Test Results
Allows you to add and view the test results directly 
on the release request.

Known Defects Summary
Summary of known defects that will be carried 
forward into the LIVE environment.

Known Defects
Used to specify RFCs relating to known defects 
that will be carried forward into the LIVE 
environment.

Quality Center Info section b

Quality Center Instance
URL of the Quality Center instance with the project 
used for the integration. 

Quality Center Domain Domain of the project in Quality Center. 

Quality Center Project
Quality Center project that is integrated with this 
request type.

Quality Center Assigned To 
User

Obsolete field that is not used by ALM. Do not use.

Quality Center Requirement 
No.

(Read-only) Requirement number in Quality 
Center.

Table 3-14. ALM - Release Management request fields (page 2 of 4)

Field Name (*Required) Description
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Quality Center Status
(Read-only) Status of the requirement in Quality 
Center.

Quality Center Message
(Read-only) Quality Center status message 
indicating success or error in the most recent 
operation. 

Quality Center Attachments
(Read-only) URL of the list of attachments to the 
Quality Center requirement.

Release Preparation section

Communication Plan 
Summary

Summary of the communication plan for this 
release.

Communication Plan

Allows you to add and view the communication plan 
(the plan that describes the various notifications 
that need to be sent out prior to release deployment 
into the LIVE environment) directly on the release 
request.

Training Plan Summary Summary of the training plan for this release.

Training Plan

Allows you to add and view the training plan (the 
plan that describes the training that needs to be 
provided prior to release deployment into the LIVE 
environment) directly on the release request.

Release Backout Plans 
Summary

Summary of the backout plans for this release.

Release Backout Plans

Allows you to add and view the backout plan (the 
release plan that describes procedures to back out 
the release to its original state) directly on the 
release request.

License Agreements
Allows you to add and view any license agreement 
documents for software licensed in this release 
directly on the release request.

Support Agreements
Allows you to add and view any support agreement 
documents for support policies of software licensed 
in this release directly on the release request.

Table 3-14. ALM - Release Management request fields (page 3 of 4)

Field Name (*Required) Description
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To submit an ALM - Release Management request:

1. Log on to PPM Center.

2. From the menu bar, select Create > Request. 

The Create New Request page appears.

3. On the Create New Request page, in the Request Type field, select 
ALM - Release Management and click Create. 

The Create New ALM - Release Management page appears, displaying the 
appropriate release request fields.

Required fields have a red asterisk. All other fields are optional, but are 
often helpful when others are reviewing an open request. For information 
concerning a specific field, click the Help icon next to the field (if 
available). 

Service Level Agreements
Allows you to add and view any SLAs for ordering 
new equipment or software directly on the release 
request.

Leasing Agreements
Allows you to add and view any leasing agreement 
documents for software leased in this release 
directly on the release request.

a. Fields in the Work Item Fields section are useful if you want to include Release Management 
requests as work items to be tracked using HP Resource Management. For more information, see 
the HP Resource Management User’s Guide. 

b. Fields in the Quality Center Info section remain visible by default but are not used if PPM Center is 
not integrated with Quality Center.

Table 3-14. ALM - Release Management request fields (page 4 of 4)

Field Name (*Required) Description

The administrator can remove the Quality Center Info section from the request type 
by removing the Quality Center Info field group from the ALM - Release Request 
Header request header type. See the HP Demand Management Configuration Guide 
for details about request header types and field groups.
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4. Complete the fields in all sections as appropriate.

The Notes section contains fields where notes and information concerning 
the release can be entered and stored. Typically, when you create a release 
request, you do not need to add a note to it. However, add a note if you 
want to convey additional information to the reviewers and processors of 
the release request.

In the References section, you can add useful references such as a 
Web-accessible file or a document or file attached from a local machine. 
For more information about adding references, see the HP Demand 
Management User’s Guide. 

5. On the Create New Request page, click Submit. 

The release request is submitted. The Request Creation Confirmed page 
appears.

After submitting the request, on the Request Creation Confirmed page you 
can click the link for the particular request number in the Request # field to 
view the detail page of the newly generated release request. 

When the release request is submitted, it is assigned an initial status, such 
as New. The request is then routed along the ALM - Release Request 
workflow (see ALM - Release Request Workflow).

ALM - Release Request Workflow

The ALM - Release Request workflow is the sequence of approvals, decisions, 
or actions that the release request follows. The release request starts at the 
beginning of the ALM - Release Request workflow. When the release request 
reaches the end of the workflow, its lifecycle is complete. After the release 
request has been through initial planning, the release is created, and the 
packages for the RFCs can be aggregated into the release. The deployment 
steps in the release request workflow coordinate with the actual release to 
automate the deployment of all packages in the release into the TEST and 
LIVE environments.

PPM Center can be configured to allow you to save the request before you submit 
it. To have this feature enabled, see your application administrator.
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Upon creation, an ALM - Release Management request is automatically set to 
use the ALM - Release Request workflow.

Figure 3-22 shows the ALM - Release Request workflow. Table 3-15 lists the 
important steps in the workflow and the user roles associated with those steps.

Figure 3-22. ALM - Release Request workflow
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Table 3-15. ALM - Release Request workflow steps (page 1 of 2)

Step Name User Security Description

1. Release Policy
ALM - Release 
Manager

Define the release policy for this 
release (including release number and 
rules for accepting changes into the 
release).

2. Release 
Planning

ALM - Release 
Manager

Review and approval of the release 
policy and other planning documents 
(such as release acceptance criteria).

3. Integrate with 
Quality Center?

ALM - QA Manager

Determine whether the user wants to 
use Quality Center integration, if 
enabled. See Integration of PPM 
Center with Quality Center, Using ALM 
on page 20.

4. Quality Process 
Entry

ALM - QA Manager
Secure approval for release entry into 
Quality Center-integrated process.

5. Create Release 
Requirement in 
Quality Center

ALM - QA Manager
Create a test requirement in Quality 
Center for the release if integration has 
been enabled.

7. Accept Changes 
into Release

ALM - Release 
Manager

Add RFC-related changes to the 
release. This can be done from the 
RFC workflow directly (for changes that 
qualify for this release).

8. Build and Deploy 
Release to TEST

ALM - Release 
Manager

Deploy the entire release into QA or 
staging environment and prepare for 
integration testing.

This step automatically migrates the 
release and related packages to the 
TEST environment.

10. Fit-for-Purpose 
Testing

ALM - Release 
Manager

Fit-for-purpose testing of this release.

11. Evaluate 
Quality

ALM - Release 
Manager

Testing of this release, including testing 
of backout plan.
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12. Release 
Acceptance

ALM - Release 
Manager

Based on test results and known 
defects, determine if this release is 
acceptable for LIVE deployment.

13. Rollout 
Planning

ALM - Release 
Manager

Plan the rollout into LIVE environment. 
The key document is the release plan 
(who does what and when).

14. Communication 
Preparation and 
Training

ALM - Release 
Manager

Prepare for LIVE rollout, and determine 
logistics, training, and communication.

15. Deploy 
Release to LIVE

ALM - Release 
Manager

Distribute and install this release to the 
LIVE environment.

This step automatically migrates the 
release and related packages to the 
LIVE environment.

SOX Segregation of Duties prohibits 
developers and testers from being 
involved in deployment of code into 
production. It is important that users 
with either of these roles not be 
involved in this step.

16. Working?
ALM - Release 
Manager

Determine if the release is working 
based on sanity check and testing.

17. Update All 
RFCs Status

ALM - Release 
Manager

Update the status of RFCs related to 
this release.

18. Close 
(Immediate 
success) - 100%

(None) Update status to Closed.

19. Implement 
Backout Plans

ALM - Release 
Manager

If the release is not working, implement 
the backout plan.

20. Update All 
RFCs Status

ALM - Release 
Manager

Update the status of RFCs related to 
this release.

Table 3-15. ALM - Release Request workflow steps (page 2 of 2)

Step Name User Security Description
Using ALM Entities 77



ALM - Release Distribution Workflow and Subworkflow

The ALM - Release Distribution workflow, along with the ALM - Release 
Distribution Sub WF subworkflow that it calls to migrate the release to TEST 
and then to LIVE environments, are used to control distribution among 
environments of a release that consolidates multiple changes.

Figure 3-23 shows the ALM - Release Distribution workflow.

Figure 3-23. ALM - Release Distribution workflow
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Release Management Portlets to Display KPIs

ALM provides several portlets that can be added to your PPM Dashboard to 
provide real-time views into several key performance indicators (KPIs).

For information about adding portlets to your PPM Dashboard, see the Getting 
Started guide.

ALM - Deployed Releases Portlet

The ALM - Deployed Releases portlet is provided to users with the role of 
Release Manager. The portlet displays a list of recently deployed releases. 

Table 3-16 describes the filter fields for the portlet.

Figure 3-24 shows an example ALM - Deployed Releases portlet.

Figure 3-24. ALM - Deployed Releases portlet

Table 3-16. ALM - Deployed Releases portlet filter fields

Field Name Description

Child RFC 
Request Type

Request types, at least one of which must be in the releases 
that are to be listed

Status Status of the release

Category Category of the release (Emergency, Major, or Minor)

Type Type of release (Full, Delta, or Package Release)

Request Type Request types to filter on

In order for the portlet to display data, RFCs need to be added as child or related 
references to the release request.
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ALM - My Releases Portlet

The ALM - My Releases portlet is provided to users with the role of Release 
Manager and other roles involved in the release management process. The 
portlet lists release requests that have been created by or assigned to the 
logged-on user. 

Table 3-17 describes the filter fields for the portlet.

Figure 3-25 shows an example ALM - My Releases portlet. 

Figure 3-25. ALM - My Releases portlet

Table 3-17. ALM - My Releases portlet filter fields

Field Name Description

Request Type Request type to filter on

Category Category of the release (Emergency, Major, or Minor)
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ALM - Open Releases Portlet

The ALM - Open Releases portlet is provided to users with the role of Release 
Manager. The portlet lists releases that do not have the status of Closed. 

Table 3-18 describes the filter fields for the portlet.

Figure 3-26 shows an example ALM - Open Releases portlet. 

Figure 3-26. ALM - Open Releases portlet

Table 3-18. ALM - Open Releases portlet filter fields

Field Name Description

Request Type Request type to filter on

Assigned to User assigned to the release

Category Category of the release (Emergency, Major, or Minor)
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ALM - Releases Portlet

The ALM - Releases portlet displays a list of release requests. If PPM Center is 
integrated with HP Release Control, the portlet provides a Click to View link 
in the View Impact column for each request to log in to Release Control, where 
various tabs provide information about the request. 

Table 3-19 describes the filter fields for the portlet.

Figure 3-27 shows an example ALM - Releases portlet.

Figure 3-27. ALM - Releases portlet

For more information about tabs in Release Control, see Using the Integration 
of PPM Center with Release Control on page 249.

Table 3-19. ALM - Releases portlet filter fields

Field Name Description

Request Type Request type to filter on

Status Status of the releases
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ALM - Releases By Category Portlet

The ALM - Releases By Category portlet is provided to users with the role of 
Release Manager. The portlet displays a pie chart showing the percentage of 
releases in each category. 

The only filter field for the portlet, Request Type, is the request type to filter 
on.

Figure 3-28 shows an example ALM - Releases By Category portlet.

Figure 3-28. ALM - Releases By Category portlet

Clicking the pie chart drills down to the ALM - Releases By List portlet.
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ALM - Releases By Type Portlet

The ALM - Releases By Type portlet is provided to users with the role of 
Release Manager. The portlet displays a pie chart showing the percentage of 
releases of each type. 

The only filter field for the portlet, Request Type, is the request type to filter 
on.

Figure 3-29 shows an example ALM - Releases By Type portlet.

Figure 3-29. ALM - Releases By Type portlet

Clicking the pie chart drills down to the ALM - Releases By List portlet.
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ALM - RFCs per Release Portlet

The ALM - RFCs per Release portlet is provided to users with the role of 
Release Manager. The portlet displays a list of RFCs that constitute a release. 

Table 3-20 describes the filter fields for the portlet.

Figure 3-30 shows an example ALM - RFCs per Release portlet.

Figure 3-30. ALM - RFCs per Release portlet

Table 3-20. ALM - RFCs per Release portlet filter fields

Field Name Description

Release Request Number of the release request

Request Type Request types to filter on

Status Status of the release

Priority Priority of the release
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Release Management Reports

ALM provides several reports that can be run to provide summary data and 
scheduling information about releases in the system.

To generate a report, from the PPM Center menu bar:

1. Select Open > Reports > Create Report. 

2. On the Submit New Report page, in the Report Category field, select 
Demand Management. 

3. Click the link for the desired report, and complete all required and any 
optional filter fields, 

4. Click Submit. 

For more information about reports, see the Reports Guide and Reference. 
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ALM - Forward Schedule of Releases Report

The ALM - Forward Schedule of Releases report is a key report used in the 
release management process. The output of this report is a list of all releases 
that are scheduled to be implemented into the LIVE environment. 

Table 3-21 describes the filter fields for the report.

Figure 3-31 shows sample output for the ALM - Forward Schedule of Releases 
report. 

Figure 3-31. ALM - Forward Schedule of Releases report output

Table 3-21. ALM - Forward Schedule of Releases report filter fields

Field Name Description

Report Title
Title of the report. Type any alphanumeric string (up to 200 
characters in length).

Start FSC Period Searches for releases created after the specified FSC date.

End FSC Period Searches for releases created before the specified FSC date.

Request Type Request type to filter on.
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ALM - Release Content Report

The ALM - Release Content Report provides a list of RFCs that have been 
incorporated into a release. 

Table 3-22 describes the filter fields for the report.

Figure 3-32 shows sample output for the ALM - Release Content Report. 

Figure 3-32. ALM - Release Content Report output

Table 3-22. ALM - Release Content Report filter fields

Field Name (*Required) Description

Report Title
Title of the report. Type any alphanumeric string (up to 
200 characters in length).

Request Type Request type to filter on.

*Release ID Specify the release whose contents you want to list.
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ALM - Release Summary Report

The ALM - Release Summary Report provides a list of releases that have been 
implemented. 

Table 3-23 describes the filter fields for the report.

Table 3-23. ALM - Release Summary Report filter fields

Field Name Description

Request Type Request type to filter on.

Release Status Searches for releases with the specified statuses.

Release Type Searches for releases of a specific type.

Time Period From Searches for releases created after the specified date.

Time Period To Searches for releases created before the specified date.
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Figure 3-33 shows sample output for the ALM - Release Summary Report 
report. 

Figure 3-33. ALM - Release Summary Report output

Special Commands

Table 3-24 describes the special commands provided by ALM to support 
integration of PPM Center with Quality Center.

Table 3-24. Special commands for integration of PPM Center with Quality 
Center

Special Command Description

ksc_create_defect_in_QC
Creates an execution step that will create a 
defect in Quality Center

ksc_create_requirement_in_QC
Creates an execution step that will create a 
requirement in Quality Center
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4 Integrating PPM Center Requests with HP 
Service Manager Changes, Using ALM
Introduction to Integrating PPM Center Requests with Service 
Manager Changes, Using ALM

For an overview of the integration of PPM Center with Service Manager, see 
Integration of PPM Center Requests with Service Manager Changes, Using 
ALM on page 18. 

The integration is enabled by a configurable Service Manager adapter file in 
PPM Center along with the request types and workflows provided by ALM, so 
that PPM Center acts as a single repository for application-related requests for 
change (RFCs). The adapter converts changes (tickets) in Service Manager to 
requests for change (RFCs), and then imports those RFCs into PPM Center for 
processing. 

Conversely, using a configurable PPM Center adapter file that also resides in 
PPM Center, the integration can optionally update Service Manager changes 
based on subsequent changes made in PPM Center to the RFCs. 

If the Service Manager adapter file and the associated PPM Center adapter file 
are both configured, such that data can be sent in both directions between 
Service Manager and PPM Center, the integration is said to be “bidirectional.” 

A separate adapter file is required for each mapping between a Service 
Manager change and a PPM Center request type.

ALM provides two default adapter files—a Service Manager adapter file and 
an associated default PPM Center adapter file.
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The integration runs as a service in the PPM Server. As described later, the 
configuration of an adapter file controls various aspects of its import process. 

This chapter describes how to configure the adapters in PPM Center and the 
Service Manager application for integration. This chapter is intended for 
Service Manager administrators or for PPM Center system administrators who 
are also familiar with Service Manager. 

For information about the supported versions of Service Manager, see the 
System Requirements and Compatibility Matrix. 

For information about the ALM - Request for Change (RFC) request type in 
PPM Center that is used to establish integration of PPM Center with Service 
Manager, see ALM - Request for Change (RFC) Request Type on page 32.

For more information about Service Manager, see its product documentation at 
the Web site described in Optional PPM Center Integrations on page 17.

To integrate PPM Center requests with changes in Service Manager version 9.20, you 
must modify the ChangeManagement WSDL in Service Manager as described in this 
chapter. These WSDL modifications may interfere with the operation of Service 
Manager integrations with other products. Before integrating PPM Center with Service 
Manager version 9.20, review the WSDL modifications described in the following 
steps to determine whether they could affect Service Manager integrations with other 
products, and proceed accordingly: 

 step d on page 97

 step 2 on page 98

 step d on page 100

The integration of PPM Center tasks with changes in Service Manager version 9.20, 
as described in Chapter 8, Integrating PPM Center Tasks with HP Service Manager 
RFCs, on page 251, does not require changing the Service Manager WSDL.

No software needs to be installed on the Service Manager server for integration with 
PPM Center. However, see the System Requirements and Compatibility Matrix. 
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Converting Service Manager Changes to PPM Center RFCs

Figure 4-1 depicts the flow for converting a change in Service Manager to an 
ALM request for change (RFC), and importing the RFC into PPM Center.

Figure 4-1. Using the Service Manager adapter to import changes from  
Service Manager into PPM Center

The Service Manager adapter consists of the following three components:

 Connector. Collects changes from the Service Manager system.

 Converter. Uses field mapping to convert the changes from the Service 
Manager data model in which the changes were created to RFCs for the 
PPM Center data model.

The converter also contains two optional filters to control which changes 
are imported into PPM Center. The preFilter filters out categories of 
changes you specify in the Service Manager data model before those 
changes are converted. After the Service Manager changes are converted to 
RFCs, the postFilter filters out categories of requests you specify before 
those requests are presented to the sender.

 Sender. Using the RFC data from the converter, creates the RFCs in PPM 
Center.
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Converting PPM Center RFCs to Service Manager Change Updates

Similar to the Service Manager adapter, the PPM Center adapter consists of 
connector, converter, and sender components. In this case, these components 
allow Service Manager to import updates from PPM Center. 

Figure 4-2 depicts the flow for converting an ALM RFC (request for change) 
in PPM Center to an update to a change in Service Manager, and importing the 
update into Service Manager. 

Figure 4-2. Using the PPM Center adapter to import change updates  
from PPM Center into Service Manager
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Overview of Configuring the Service Manager Integration

Before configuring the integration, you must identify the Service Manager data 
attributes that will be integrated with PPM Center, including which of the 
attributes of Service Manager changes to send to PPM Center, and, for 
bidirectional integration, which of the attributes to receive back from PPM 
Center.

Before you can begin importing changes from Service Manager into PPM 
Center, you must configure Service Manager and configure the Service 
Manager adapter in PPM Center to enable integration. The procedures are 
summarized as follows:

 Configure Service Manager in the particular ways required for integration 
of PPM Center with Service Manager.

 Generate Service Manager Web service stubs for Service Manager. PPM 
Center needs the Service Manager Web service stubs to connect to Service 
Manager. 

 Configure the Service Manager adapter configuration file on the PPM 
Server, to support converting a change in Service Manager to an ALM 
request for change (RFC) and then importing the RFC into PPM Center. 
ALM provides an Service Manager default adapter configuration file.

 If you want the integration to be bidirectional, that is, to also send updates 
that are made in PPM Center RFCs back to Service Manager as change 
updates, configure the PPM Center adapter configuration file on the PPM 
Server. ALM provides a default PPM Center adapter configuration file 
associated with Service Manager.

 Configure the required server.conf parameter in PPM Center.

 Restart the PPM Server in normal mode and verify that the ALM Startup 
service has started.

 Configure logging of errors and events.
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Configuring Service Manager for Integration with PPM Center

Before starting these configuration procedures, make sure that the Service 
Manager server, Service Manager client, and Service Manager Webtier are 
installed and running.

Integration of Service Manager with PPM Center requires specific 
configuration of Service Manager, as described in the following sections.

Before starting this procedure, make sure you review the warning in the section 
Introduction to Integrating PPM Center Requests with Service Manager 
Changes, Using ALM on page 91.

Configuring the Change Management Module

To configure the Change Management module in Service Manager, do the 
following:

1. To enable Service Manager to provide PPM Center with the changes sorted 
by their last update times, as required by this integration:

a. Navigate to System Definition > Tables > cm3r > Keys and on that 
screen, click New. 

b. Add a new key constraint to the database table. The constraint should 
be of the type “Not Null” and should contain the sysmodtime field. If 
the Service Manager system uses another field to contain the last 
modified date/time of the record, use that field instead.

c. Add a new key constraint to the database table. The constraint should 
be of the type “Not Null” and should contain the orig.date.entered field, 
for use in the initial load mode (for more information, see the 
initial-load-state adapter attribute in Table 4-1 on page 108).

PPM Center can be integrated with multiple instances of Service Manager, if those 
instances are at the same version. (See the System Requirements and Compatibility 
Matrix.) However, the procedures in the following sections must be performed 
identically on the multiple Service Manager instances.
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d. To make sure that the required fields are exposed through the Change 
Management Web Services:

i. For version 7.01, select 
Menu Navigation > Tailoring > WSDL Configuration. 

For version 7.10 or version 9.20, select 
Menu Navigation > Tailoring > Web Services > WSDL Configuration. 

ii. Type cm3r in the Name field and click Search. 

For version 7.01, the search finds only the Change object and opens 
it immediately. Perform step iii.

For version 7.10 or version 9.20, the search finds the Change and 
ChangeIIA objects. Open each object and perform step iii for each 
object.

iii. Click the Fields tab and add fields with captions and types to the 
table as follows:

iv. For version 9.20, change existing WSDL captions as follows:

2. Import the unload file provided with PPM Center to set up the Change 
Management Web service for the integration with PPM Center. The unload 
file is located at:

<PPM_Home>\conf\sdi\serviceManagerFiles\sm_operations

where <PPM_Home> represents the path where the PPM Center instance is 
installed. For example: xyzserver/E/PPMServer. 

New Field New Caption Type

sysmodtime sysmodtime DateTimeType

orig.date.entered orig.date.entered DateTimeType

Field Original Caption New Caption

header,number ChangeID changeNumber

header,brief.description Title briefDescription
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Configuring the Change Management Service Manager Web Service

To configure the Change Management Service Manager Web service:

1. To associate a display action to the new processes:

a. To navigate to the Objects menu, select 
Menu Navigation > Tailoring > Document Engine > Objects. 

b. Type cm3r in the File name field and click Enter. 

c. Specify the default state. 

d. Add a new Display action associated with the process—associate the 
checkretract action with ccm.check.retract. 

e. Add a new Display action associated with the process—associate the 
checkapproval action with ccm.check.approval. 

f. Close the cm3r object.

g. Repeat step a through step f for the cm3t object.

2. To configure the ChangeManagement WSDL:

a. For version 7.01, select 
Menu Navigation > Tailoring > WSDL Configuration.

For version 7.10 or version 9.20, select 
Menu Navigation > Tailoring > Web Services > WSDL Configuration. 

b. In the Service Name field, type ChangeManagement and click Search. 

c. Add the following actions for table cm3r:

d. Repeat step c for table cm3t.

Allowed Action Action Name

checkapproval CanApprove

checkretract CanRetract
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(Optional) Configuring Browsing of Service Manager Changes from a URL

This optional procedure enables RFCs in PPM Center to be updated with URL 
links to the corresponding changes in Service Manager, so that PPM Center 
users can easily jump directly to those changes. To enable this capability, 
configure Service Manager as follows (otherwise go to Configuring for 
Bidirectional Integration on page 102):

1. To configure the Web server URL in the Service Manager server:

a. To open the System Information Definition, select 
Menu Navigation > System Administration > Base System Configuration 

> Miscellaneous > System Information Record. 

b. In the form, select the Active Integrations tab.

c. In the WebServer URL field in the WebServer Information pane, type 
the URL of the Service Manager Web server configured for Web 
access. For example:

http://<Host>:<Port>/sm/index.do

d. Click OK to save the System Information Definition and exit.

2. To create and configure the record.url field in the cm3r table:

a. Create the record.url field in the cm3r table, using the following 
Service Manager Help topic:

“How do I add a field to a table?”

b. Configure the record.url field as follows:

c. In the SQL mapping section, do the following:

i. Type RECORD_URL in the SQL field name field. 

ii. Type VARCHAR in the SQL data type field. 

iii. Type 400 in the SQL data length field. 

Section Name Field Name Value

General Properties Type Character

General Properties Caption Change URL
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d. To add record.url to the Change Management Web service: 

i. For version 7.01, select 
Menu Navigation > Tailoring > WSDL Configuration. 

For version 7.10 or version 9.20, select 
Menu Navigation > Tailoring > Web Services > WSDL Configuration. 

ii. Type cm3r in the Name field and click Search. 

For version 7.01, the search finds only the Change object and opens 
it immediately. Perform step iii.

For version 7.10 or version 9.20, the search finds the Change and 
ChangeIIA objects. Open each object and perform step iii for each 
object.

iii. Click the Fields tab and add to the table a field named record.url 
with the caption record.url and the type DateTimeType. 

e. The record.url field is populated in the cm3r.pre.add trigger. To 
configure this trigger:

i. Navigate to System Definition > Tables > cm3r. 

ii. Open the list of triggers.

iii. Open the cm3r.pre.add trigger.

iv. Copy the following JavaScript into the trigger:

_rec_number = record.number;
var _filename = "cm3r";
var _query = "number=\"" + _rec_number+ "\"";
var _title = "Change number " + _rec_number;
var _link=system.library.urlCreator.getURLFromQuery

(_filename, _query, _title);
record.record_url =_link;

v. Click Save to save the script.
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vi. Click Compile to check for any errors and compile. No errors 
should occur. 

Now, any new record will have the record.url field populated. 
However, as described in the following steps, you will need to 
perform the Mass Update procedure to populate the record.url field 
for existing records.

f. To prepare to perform the Mass Update procedure:

i. Navigate to Menu Navigation. 

ii. Click Change Management > Changes > Search Changes. 

iii. Use Search to display a list of change records.

iv. Select the records you want to update.

g. To perform the Mass Update procedure:

i. Click Mass Update in the toolbar to start updating the listed records.

Database Manager displays the initial form again, but with different 
options (buttons).

ii. Do not specify values in any field. Click Complex Update. 

Database Manager displays the Mass Add/Update Instruction 
screen.

iii. Specify the following assignment statement in the Instructions for 

action on EACH RECORD input field:

record.url in $file = 
jscall("urlCreator.getURLFromQuery","cm3r",

"number=\"" + number in $file + "\"",
"Change number " + number in $file)

For each record updated, this step sets the record.url field based on 
the Web server URL entered in System Information Record. Then 
this step returns terminal control to you and displays the following 
message: 

<n> records updated in the cm3r file.

where <n> is the number of records updated.
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h. To browse directly from the Web server using a URL that includes a 
ticket ID, disable the querySecurity parameter by using the 
instructions in the following Service Manager Help topic:

“Web parameter: sc.querySecurity”

i. Add the following line to the conversion script file in PPM Center for 
converting Service Manager changes to PPM Center requests:

ppmRFC.addURLReference(serviceManagerRFC.get
("record.url"), <display text for URL reference>);

where <display text for URL reference> represents the text to be 
displayed for the link to the URL.

For information about copying the sample conversion file provided 
with ALM and revising the copy, see Configuring the Service Manager 
Adapter Converter Property (Script) on page 112.

For information about the addURLReference function, see ppmRFC 
Object on page 115.

Configuring for Bidirectional Integration

Perform this procedure only if you plan to configure the integration to be 
bidirectional.

To be able to verify later that bidirectional integration works, configure the 
fields that are required to map a PPM Center request to an Service Manager 
change. For example:

 Create a structure called ppmFields in the cm3r table. See the following 
Help topic:

“How do I add a structure to the Database Dictionary?”

 Create fields in the ppmFields structure. If you want to use the conversion 
script file provided with ALM as is, for Service Manager enter the 
following fields:

o ppmURL with a Caption of ppmURL and select a Type of StringType. 

o requestModifiedDate with a Caption of reqModDate and select a 
Type of DateTimeType. 
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For details of a similar procedure for Service Manager, see step d 
on page 97.

If you want to use a custom mapping, you may need to create additional fields 
and create entries for those fields using the WSDL configuration tool.

Generating Web Service Stubs 

In Service Manager, you can modify which fields are available through Web 
services. Each time you modify these settings, a new Web Services 
Description Language (WSDL) descriptor is created. In the PPM Server, you 
must regenerate the Web service stubs from the new descriptor.

To generate the stubs:

1. Navigate to the <PPM_Home>/bin/sdi directory on the PPM Server.

where <PPM_Home> represents the path where the PPM Center instance is 
installed. For example: xyzserver/E/PPMServer. 

2. Run the following script:

./kGenerateServiceCenterStub.sh <wsdl-url> <PPM_Server_Name>

where

Perform this procedure for new installations of ALM and after any upgrade of PPM 
Center.

<wsdl-url> 
represents the Service Manager WSDL URL for 
Change Management.

<PPM_Server_Name> 

represents the subdirectory of <PPM_Home>/server 
specified during installation as the value for the 
KINTANA_SERVER_NAME parameter in the 
server.conf file. (This value is not necessarily the 
actual host name of the server.) When generated, the 
stubs will be placed in this subdirectory. 
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The specific script is in the following format:

./kGenerateServiceCenterStub.sh http://<Host>:<Port>/
sc62server/PWS/ChangeManagement?wsdl <PPM_Server_Name>

For example:

./kGenerateServiceCenterStub.sh http://ServManager:13080/
sc62server/PWS/ChangeManagement?wsdl kintana

3. Verify that the stubs are now in the following directory:

<PPM_Home>/server/<PPM_Server_Name>/deploy/itg.war/WEB-INF/
classes/

Configuring the Service Manager Adapter Configuration File

The Service Manager adapter configuration file is an XML file in PPM Center 
that enables integration of Service Manager with PPM Center and converts 
Service Manager changes to PPM Center requests. The configuration file 
consists of the following components, each with its own attributes or properties 
(see Figure 4-1 on page 93):

 General settings for the adapter itself, such as its name and the name of the 
Service Manager application in which the changes are created.

 Connector between Service Manager and the adapter.

 Converter of changes in the Service Manager data model to generic 
requests in the PPM Center data model. The converter calls the scripts that 
define the field mapping and filter functions.

 PPM Center sender, which sends the converted and filtered requests to 
PPM Center. 

The stub generation might fail if the host is not resolvable by name. To resolve the 
host by name, make an entry in the hosts file for the machine you want to connect. 
See the documentation for your operating system for the location of the hosts file.

If PPM Center is operating in a clustered server configuration, share or copy the 
<PPM_Home>/sdi-persistency directory and the <PPM_Home>/conf/sdi 
directory among all the servers in the cluster.
104 Chapter 4



The following sections describe how to configure the Service Manager adapter 
configuration file and the scripts called by its converter, and how to modify 
copies of the provided files while preserving the originals. 

Location, Naming, and Structure of Service Manager Adapter Configuration 
Files

Each Service Manager adapter configuration file must follow specific 
conventions for its location, naming, and structure, as described in the 
following sections.

Location and Naming of the Service Manager Adapter Configuration File

The adapter configuration files are located in the <PPM_Home>/conf/sdi 
directory of the PPM Server. This directory contains the following:

 Configuration file for the adapter (or one for each adapter if there are 
multiple adapters). 

In this configuration file, you define a name for the adapter. The 
configuration file must have a .settings file extension.

 Subdirectory (or one for each adapter configuration file if there are 
multiple files). 

The subdirectory contains the conversion scripts, which are called by the 
converter to map the fields between and to filter the changes and requests. 
The name of the subdirectory must be the same as the <adapter name> 
(for a description, see Structure of the Service Manager Adapter 
Configuration File on page 106 and Table 4-1 on page 108) followed by 
.ext. 

For example, if the adapter name is serviceManager-adapter, the  
<PPM_Home>/conf/sdi directory must contain a subdirectory named 
serviceManager-adapter.ext to hold all the conversion script files for 
the adapter.
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Structure of the Service Manager Adapter Configuration File

ALM provides, as a template, a default Service Manager adapter configuration 
file named serviceManager-adapter.settings1. The adapter file you 
configure and use must have a .settings file extension. 

Copy the default adapter file (to preserve the original), and rename the copy 
with a .settings file extension and, if desired, a different file name.

As detailed in subsequent sections, the adapter file has the following basic 
structure, including adapter attributes, and properties for its connector, 
converter, and sender:

<?xml version="1.0" encoding="UTF-8"?>
<settings>

<adapter adapter-name="<adapter name>">
<service-desk-application><SD application>

</service-desk-application>
<number-of-tickets><number of tickets>

</number-of-tickets>
<polling-schedules><schedule></polling-schedules>
<polling-frequency><frequency></polling-frequency>
<initial-load-state><date></initial-load-state>

<request-types>
<request-type level="1">
<polling-operation>

<connector>
<connector-type>serviceManagerChange</connector-type>

<properties>
idProperty=
userQuery=
lastUpdatedPropertyForQuery=
creationDatePropertyForQuery=
lastUpdatedPropertyForResult=
creationDatePropertyForResult=
keyMethodName=
timeZone=
wsDateFormatPattern=
queryDateFormatPattern=
userName=
password=
serviceUrl=

</properties>
</connector>
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<converter>
<converter-type>scriptConverter</converter-type>

<properties>
scripts=<convert1>.js,<convert2>.js,... 

</properties>
</converter>

</polling-operation>
</request-type>
</request-types>

<sender>
<sender-type>PPMSender</sender-type>

<properties>
userName=
password=
requestType=
updateRequest=
ticketIdFieldName=
sdSystemFieldName=
staticFieldNames=

</properties>
</sender>

</adapter>

</settings>

The following sections describe how to configure the adapter attributes, the 
connector properties, the converter property (scripts), and the sender 
properties.

Do not delete or change the values provided for <connector-type>, 
<converter-type>, or <sender-type>. 
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Configuring the Service Manager Adapter Attributes

Specify the adapter attributes of the Service Manager adapter configuration 
file, such as the adapter name and the service desk application, as described in 
Table 4-1.

Table 4-1. Service Manager adapter attributes (page 1 of 2)

Attribute Name 
(*Required) Description Default Value

*adapter-name

Logical name that represents the 
adapter name on the client 
machine. For example:

serviceManager-adapter

This name is also used for the 
scripts (.ext) directory. (See 
Location and Naming of the Service 
Manager Adapter Configuration File 
on page 105.)

(None)

*service-desk-application

Unique logical name for the service 
desk system you are using. 

For example:

Service Manager 

(None)

number-of-tickets
Number of changes that the adapter 
processes at a time.

50

polling-schedules

Times of day that the adapter polls 
Service Manager for changes, 
formatted as a list of cron 
expressions separated by the new 
line character. 

For example: 

30 * * * * <new line> 0 * * * *

(None)
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polling-frequency
Frequency (in seconds) that the 
adapter polls Service Manager for 
changes.

If 
polling-schedules 
and 
polling-frequency 
are unspecified, 
then the default 
polling-frequency 
is 30 seconds, 
starting when 
you restart the 
PPM Server.

initial-load-state

Earliest creation date and time of 
changes the adapter retrieves from 
Service Manager, in the following 
format: 

MM/dd/yy HH:mm:ss z

For example:

10/19/08 21:30:00 EST

After completion, the adapter does 
not retrieve any new or updated 
changes (per the polling-schedules 
and polling-frequency attributes) 
until this attribute is commented out.

(None)

Table 4-1. Service Manager adapter attributes (page 2 of 2)

Attribute Name 
(*Required) Description Default Value
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Configuring the Service Manager Adapter Connector Properties

Specify the properties for the connector section of the Service Manager adapter 
configuration file as described in Table 4-2. 

Table 4-2. Service Manager adapter connector properties (page 1 of 3)

Property Name
(*Required) Description Default 

Value

*idProperty
Property name of the ID field in the 
instance returned from the Service 
Manager Web service.

(None)

userQuery

Service Manager query on the 
Change Management table (cm3r) 
that would work in the Service 
Manager query engine.

(None)

*lastUpdatedPropertyForQuery

Property name of the last-update field 
used to query the Service Manager 
Web service (the field name used in 
an expert search on the Service 
Manager client machine).

(None)

*creationDatePropertyForQuery
Property name of the creation-date 
field used to query the Service 
Manager Web service.

(None)

*lastUpdatedPropertyForResult

Property name of the last-update field 
in the instance returned from the 
Service Manager Web service (usually 
the field name exposed as API).

(None)

*creationDatePropertyForResult
Property name of the creation-date 
field in the instance returned from the 
Service Manager Web service.

(None)

*keyMethodName
Name of the method for request keys 
(usually the ID field name).

(None)
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*timeZone

Time zone, used for converting the 
last updated time of a request from 
Service Manager. Use the same time 
zone as the Service Manager server. 

The format can be GMT+<X> or 
GMT–<X>, where <X> is the offset in 
hh:mm format from GMT. For 
example, GMT–07:00.

However, to handle Daylight Saving 
Time, use an area time zone instead 
of specifying a time relative to GMT.

(None)

*wsDateFormatPattern

Date format used in the Service 
Manager Web service answer. 

For available formats, see the 
following URL:

http://java.sun.com/j2se/1.4.2/docs/
api/java/text/SimpleDateFormat.html

(None)

*queryDateFormatPattern

Date format used for querying the 
Service Manager system (as used in 
the UI expert search). 

Make sure this value is consistent with 
the Service Manager server date 
pattern. For available formats, see the 
following URL:

http://java.sun.com/j2se/1.4.2/docs/
api/java/text/SimpleDateFormat.html

(None)

Table 4-2. Service Manager adapter connector properties (page 2 of 3)

Property Name
(*Required) Description Default 

Value
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Configuring the Service Manager Adapter Converter Property (Script)

The converter section of the Service Manager adapter configuration file 
contains the scripts property. The script file is written in the JavaScript 
language, and it maps the fields from the Service Manager data model to the 
PPM Center data model and filters the requests.

The scripts property is a script file name in the following format:

scripts=<convert1>.js 

This file must reside in the same directory as the adapter, as follows:

<PPM_Home>/conf/sdi/<adapter name>.ext

where <adapter name> is as defined in Table 4-1 on page 108.

*userName

User name in the Service Manager 
system that PPM Center uses to 
connect to Service Manager.

This user name must include only 
single-byte characters.

This user must have full access to the 
Change Management module in 
Service Manager.

(None)

*password
Password in the Service Manager 
system that PPM Center uses to 
connect to Service Manager. 

(None)

*serviceUrl

Web service URL of Service Manager. 
The format is as follows:

http://<Service_Manager_
Host>:<Port>/sc62server/PWS/

where <Service_Manager_Host> 
represents the host machine where 
Service Manager is running.

(None)

Table 4-2. Service Manager adapter connector properties (page 3 of 3)

Property Name
(*Required) Description Default 

Value
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The conversion script is responsible for field mapping during the conversion of 
changes in the Service Manager data model to requests in the PPM Center data 
model, and for filtering the changes and requests. 

The script must contain the convert function and can contain the optional 
preFilter and postFilter functions, as follows: 

 preFilter. The following function filters the changes before they are 
converted to the PPM Center data model, so that no unnecessary requests 
are converted:

preFilter(smChange)

For example, the following preFilter function specifies that Service 
Manager changes with a Low priority will not be converted and that all 
other requests will be converted:

function preFilter(smChange){
if (smChange.get("Request Urgency")==SM_PRIORITY_LOW)

return false;
else

return true;
}

 convert. After identifying the PPM Center request attributes that are 
required for Service Manager changes, use the convert function of the 
conversion script to map fields of Service Manager changes to fields of 
PPM Center requests.

The following convert function uses the mapping you specify to convert 
the fields of the change in Service Manager to the fields of the request in 
PPM Center:

convert(smChange, ppmRFC)

Make sure that no line in a script exceeds 256 characters.

Multiple scripts are supported, using a comma-separated list, in the following format:

scripts=<convert1>.js,<convert2>.js,...

The adapter searches for these conversion script files in the adapter directory.
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 postFilter. The following function filters the converted requests, so that 
only the desired requests will be imported into PPM Center:

postFilter(ppmRFC)

For example, the following postFilter function specifies that only PPM 
Center requests with a status of Approved will be sent to the PPM Server:

function postFilter(ppmRFC){
ppmStatus=ppmRFC.getField("status");
if (ppmStatus==STATUS_APPROVED)

return true;
else

return false;
}

ALM provides a sample conversion script file named 
ConvertSMToPPM.js.sample in the  
<PPM_Home>/conf/sdi/serviceManager-adapter.ext directory.

Copy the sample file, delete the .sample extension in the copy, and revise the 
copied conversion script as needed. Use the syntax described in the following 
sections for the conversion script APIs. 

smChange Object

The smChange object represents the Service Manager change. For the 
preFilter and convert script functions, use one of the following functions to 
retrieve fields from the Service Manager change:

 value=SMRFC.get(String fieldName); 

 SMRFC.get("Request Urgency")=SM_PRIORITY_LOW; 
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ppmRFC Object

The ppmRFC object represents the PPM Center request. For the convert and 
postFilter script functions, use the following functions to modify the PPM 
Center request fields:

 Reference ID

You must use the following function to track the Service Manager change 
ID in the PPM Center request:

setRefId(String referenceId);

 Time Stamp

You must use the following function to set the last update time in the PPM 
Center request:

/**
* Set the time stamp in long format—that is, the number of
* milliseconds since January 1, 1970, 00:00:00 GMT
**/
setUpdatedTimeStamp(long updatedTimeStamp);
/**
* Set the time stamp in the Java simple date format, which is
* described at the following location: 
* http://java.sun.com/j2se/1.4.2/docs/api/java/text/

SimpleDateFormat.html
**/
setUpdatedTimeStamp(String updatedTimeStamp, String format);

 Status

Use the following function to change the status of the PPM Center request 
and allow the workflow of the request to advance:

setStatus(String newStatus)

To view or change the set of statuses provided with PPM Center, open the 
request type in the PPM Workbench, select the Request Status tab, and 
click Request Status. For more information, see the HP Demand 
Management Configuration Guide. 
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 General Field

Use the following function to set the value of a general field in the PPM 
Center request:

setField (String fieldName, String value);

 Date

Use the following function to set the value of a date field in the PPM 
Center request:

/**
* Set the date in long format—that is, the number of
* milliseconds since January 1, 1970, 00:00:00 GMT
**/
setDateValue(String fieldName, long date);
/**
* Set the date in the Java simple date format which is
* described in the following location:
* http://java.sun.com/j2se/1.4.2/docs/api/java/text/

SimpleDateFormat.html
**/
setDateValue(String fieldName, String date, String format);

 Notes to be added upon creation of a PPM Center request

Use the following function to add a note upon creation of a PPM Center 
request:

addUserNoteOnCreate(String content, String addedBy,
long time;

 Notes to be added upon update of a PPM Center request

Use the following function to add a note upon update of a PPM Center 
request:

addUserNoteOnUpdate(String content, String addedBy,
long time;

 URL reference creation

If you have configured Service Manager to expose the ticket URL as the 
record.url attribute (see (Optional) Configuring Browsing of Service 
Manager Changes from a URL on page 99), you can use the following 
function to create a URL reference to an Service Manager change:

addURLReference(String attachmentURL, String attachments);
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Configuring the Service Manager Adapter Sender Properties

Specify the properties for the sender section of the Service Manager adapter 
configuration file as described in Table 4-3. The sender controls creating RFCs 
in PPM Center with the converted data.

Table 4-3. Service Manager adapter sender properties (page 1 of 2)

Property Name 
(*Required) Description Default 

Value

*userName

User name in PPM Center by whose credentials 
requests are created.

This user name must include only single-byte 
characters.

(None)

*password

Password of the userName. You must encrypt 
this password by using the kEncrypt.sh 
script, which is located in the bin directory of 
the PPM Server. Encrypted passwords must be 
created in a CDATA section.

(None)

*requestType

PPM Center request type that should be 
created for the converted changes.

For example:

ALM - Request for Change (RFC)

(None)

updateRequest

If set to true, enables updates made to 
Service Manager changes to be automatically 
sent to existing PPM Center requests.

HP recommends retaining the default value of 
false because usually, after Service Manager 
changes are converted to PPM Center 
requests, processing takes place entirely in 
PPM Center.

false

*ticketIdFieldName a

Field in PPM Center containing the Service 
Manager ticket ID. This field is presented in the 
PPM Center request as the Ticket Id field in the 
Service Desk Info section.

(None)
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The sender is the last section of the adapter configuration file. Make sure the 
file ends with the following lines: 

</adapter>
</settings>

This completes the configuration of the Service Manager adapter configuration 
file.

If you want to establish bidirectional integration, proceed to Configuring the 
PPM Center Adapter Configuration File. Otherwise, go to Configuring the 
server.conf Parameter in PPM Center on page 131.

*sdSystemFieldName a

Field in PPM Center containing the Service 
Manager system name. This field is presented 
in the PPM Center request as the System 
Name field in the Service Desk Info section.

(None)

*staticFieldNames

(Applicable and 
required only for 
bidirectional 
integration)

List of PPM Center request fields (separated by 
semicolons) that are not to be updated when 
changes are made to their mapped Service 
Manager change fields. 

This list is used to prevent inappropriate update 
of Service Manager tickets for bidirectional 
integration. For example, to prevent a ticket 
from being updated when the last update time in 
PPM Center changes, specify the following:

REQD-SD_LAST_UPDATE

(None)

a. If PPM Center is integrated with multiple Service Manager servers, the combination of values in the 
ticketIdFieldName and sdSystemFieldName properties ensures that all the tickets from all the 
Service Manager servers are uniquely identified in PPM Center.

Table 4-3. Service Manager adapter sender properties (page 2 of 2)

Property Name 
(*Required) Description Default 

Value

If PPM Center is operating in a clustered server configuration, share or copy the 
<PPM_Home>/sdi-persistency directory and the <PPM_Home>/conf/sdi 
directory among all the servers in the cluster.
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Configuring the PPM Center Adapter Configuration File

The PPM Center adapter configuration file is an XML file in PPM Center that 
enables integration of PPM Center with Service Manager and then converts 
PPM Center RFCs to Service Manager change updates. The configuration file 
consists of the following components, each with its own attributes or properties 
(see Figure 4-2 on page 94):

 General settings for the adapter itself, such as its name.

 Connector between PPM Center and the adapter.

 Converter of RFCs in the PPM Center data model to change updates in the 
Service Manager data model. The converter calls the scripts that define the 
field mapping and filter functions.

 Sender, which sends the converted and filtered requests to Service 
Manager. 

The following sections describe how to configure the PPM Center adapter 
configuration file and the scripts called by its converter, and how to modify 
copies of the provided files while preserving the originals. 

This procedure is optional. It establishes bidirectional integration. (See Introduction to 
Integrating PPM Center Requests with Service Manager Changes, Using ALM 
on page 91.) If you do not want to establish bidirectional integration at this time, 
proceed to Configuring the server.conf Parameter in PPM Center on page 131.

If PPM Center is operating in a clustered server configuration, share or copy the 
<PPM_Home>/sdi-persistency directory and the <PPM_Home>/conf/sdi 
directory among all the servers in the cluster.
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Location, Naming, and Structure of PPM Center Adapter Configuration Files

Each PPM Center adapter configuration file must follow specific conventions 
for its location, naming, and structure, as described in the following sections.

Location and Naming of the PPM Center Adapter Configuration File

The adapter configuration files are located in the <PPM_Home>/conf/sdi 
directory of the PPM Server. This directory contains the following:

 Configuration file for the adapter (or one for each adapter if there are 
multiple adapters). 

In this configuration file, you define a name for the adapter. The 
configuration file must have a .settings file extension.

 Subdirectory (or one for each adapter configuration file if there are 
multiple files). 

The subdirectory contains the conversion scripts, which are called by the 
converter to map the fields between and to filter the tickets and requests. 
The name of the subdirectory must be the same as the <adapter name> 
(for a description, see Structure of the PPM Center Adapter Configuration 
File on page 121 and Table 4-4 on page 123) followed by .ext. 

For example, if the adapter name is ppm-adapter, the  
<PPM_Home>/conf/sdi directory must contain a subdirectory named 
ppm-adapter.ext to hold all the conversion script files for the adapter.
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Structure of the PPM Center Adapter Configuration File

ALM provides, as a template, a default PPM Center adapter configuration file 
named ppm-sm-adapter.settings1. The adapter file you configure and use 
must have a .settings file extension. 

Copy the default adapter file (to preserve the original), and rename the copy 
with a .settings file extension and, if desired, a different file name.

As detailed in subsequent sections, the adapter file has the following basic 
structure, including adapter attributes, and properties for its connector, 
converter, and sender:

<?xml version="1.0" encoding="UTF-8"?>
<settings>

<adapter adapter-name="<adapter name>">
<service-desk-application><SD application>

</service-desk-application>
<number-of-tickets><number of tickets></number-of-tickets>
<polling-schedules><schedule></polling-schedules>
<polling-frequency><frequency></polling-frequency>

<request-types>
<request-type level="1">
<polling-operation>

<connector>
<connector-type>PPMRequest</connector-type>

<properties>
sdSystemName=
requestType=
datePattern=
userName=
password=
sdSystemFieldName=
idProperty=
updateTimeField=
createTimeField=
requestStatusNames=

</properties>
</connector>

<converter>
<converter-type>scriptConverter</converter-type>

<properties>
scripts=<convert1>.js,<convert2>.js,...

</properties>
</converter>
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</polling-operation>
</request-type>
</request-types>

<sender>
<sender-type>serviceManagerSender</sender-type>

<properties>
userName=
password=
queryDateFormatPattern=
timeZone=
keyMethodName=
serviceUrl=
staticFieldNames=
idProperty=

</properties>
</sender>

</adapter>

</settings>

The following sections describe how to configure the adapter attributes, the 
connector properties, the converter property (scripts), and the sender 
properties.

Configuring the PPM Center Adapter Attributes

Specify the adapter attributes of the PPM Center adapter configuration file, 
such as the adapter name and the service desk application, as described in 
Table 4-4.

Do not delete or change the values provided for <connector-type>, 
<converter-type>, or <sender-type>. 
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Table 4-4. PPM Center adapter attributes

Attribute Name 
(*Required) Description Default Value

*adapter-name

Logical name that represents the 
adapter name on the client 
machine. For example:

ppm-adapter

This name is also used for the 
scripts (.ext) directory. (See 
Location and Naming of the PPM 
Center Adapter Configuration File 
on page 120.)

(None)

*service-desk-application

Unique, logical name for the PPM 
Center system you are using. 

For example:

PPM 

(None)

number-of-tickets
Number of tickets that the adapter 
processes at a time.

50

polling-schedules

Times of day that the adapter polls 
PPM Center for changes, formatted 
as a list of cron expressions 
separated by the new line 
character. 

For example: 

30 * * * * <new line> 0 * * * *

(None)

polling-frequency
Frequency (in seconds) that the 
adapter polls PPM Center for 
changes.

If 
polling-schedules 
and 
polling-frequency 
are unspecified, 
then the default 
polling-frequency 
is 30 seconds, 
starting when 
you restart the 
PPM Server.
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Configuring the PPM Center Adapter Connector Properties

Specify the properties for the connector section of the PPM Center adapter 
configuration file as described in Table 4-5. 

Table 4-5. PPM Center adapter connector properties (page 1 of 2)

Property Name
(*Required) Description Default Value

*sdSystemName

Name of the adapter from which changes 
are imported into PPM Center as requests. 
Must be the same value as specified for 
the service-desk-application property in 
the Service Manager adapter (see 
Table 4-1 on page 108).

For example:

Service Manager 

(None)

*requestType

PPM Center request type that should be 
created for the converted changes.

For example:

ALM - Request for Change (RFC)

(None)

datePattern

Date format for the date field. Use the 
Java™ simple date format. See the 
following URL:

http://java.sun.com/j2se/1.4.2/docs/api/
java/text/SimpleDateFormat.html

yyyy-MM-dd

HH:mm:ss

*userName

User name in PPM Center by whose 
credentials requests are created.

This user name must include only 
single-byte characters.

(None)

*password

Password of the userName.

This password should be encrypted using 
the PPM Center script kEncrypt.sh, 
which is located in the bin directory of the 
PPM Server. Encrypted passwords must 
be created in a CDATA section.

(None)
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*sdSystemFieldName

Field in PPM Center containing the 
Service Manager system name. This field 
is presented in the PPM Center request as 
the System Name field in the Service 
Desk Info section.

(None)

*idProperty
Property name of the ID field in the 
instance returned from the Service 
Manager Web service.

(None)

*updateTimeField
Field in PPM Center that represents the 
time the request was updated in PPM 
Center.

(None)

*createTimeField
Field in PPM Center that represents the 
time the request was created in PPM 
Center.

(None)

requestStatusNames

List of PPM Center request statuses, 
separated by semicolons (;). Only 
requests with the statuses you specify are 
retrieved from PPM Center for processing. 
However, if you do not specify any 
statuses, all requests are retrieved.

(None)

Table 4-5. PPM Center adapter connector properties (page 2 of 2)

Property Name
(*Required) Description Default Value
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Configuring the PPM Center Adapter Converter Property (Script)

The converter section of the PPM Center adapter configuration file contains 
the scripts property. The script file is written in the JavaScript language. The 
script maps the fields from the PPM Center data model to the Service Manager 
data model, and filters the requests.

The scripts property is a script file name in the following format:

scripts=<convert1>.js

This file must reside in the same directory as the adapter, as follows:

<PPM_Home>/conf/sdi/<adapter name>.ext

where <adapter name> is as defined in Table 4-4 on page 123.

The conversion script is responsible for field mapping during the conversion of 
requests in the PPM Center data model to change updates in the Service 
Manager data model, and for filtering the requests and change updates. 

The script must contain the convert function and can contain the preFilter 
and postFilter functions, as follows: 

 preFilter. The following function filters the changes before they are 
converted to the Service Manager data model, so that no unnecessary 
requests are converted:

preFilter(ppmRFC)

Make sure that no line in a script exceeds 256 characters.

Multiple scripts are supported, using a comma-separated list, in the following format:

scripts=<convert1>.js,<convert2>.js,...

The adapter searches for these conversion script files in the adapter directory.
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 convert. After identifying the Service Manager change attributes that need 
to be updated from the PPM Center requests, use the convert function of 
the conversion script to map fields of PPM Center requests to fields of 
Service Manager changes.

The following convert function uses the mapping you specify to convert 
the fields of the request in PPM Center to the fields of the change in 
Service Manager:

convert(ppmRFC, smChange)

 postFilter. The following function filters the converted change updates, so 
that only the desired updates will be applied to the corresponding change in 
Service Manager:

postFilter(smChange)

ALM provides a sample conversion script file named 
ConvertPPMToSM.js.sample in the  
<PPM_Home>/conf/sdi/serviceManager-adapter.ext directory.

Copy the sample file, delete the .sample extension in the copy, and revise the 
copied conversion script as needed. Use the syntax described in the following 
sections for the conversion script APIs. 

ppmRFC Object

The ppmRFC object represents the PPM Center request. For the preFilter 
and convert script functions, use the following function to retrieve request 
fields from PPM Center:

get(String fieldName);

smChange Object

The smChange object represents the Service Manager ticket. For the convert 
and postFilter script functions, use the following functions to modify the 
ticket fields:
Integrating PPM Center Requests with HP Service Manager Changes, Using ALM 127



 Reference ID

You must use the following function to track the Service Manager change 
ID in the PPM Center request:

setRefId(String referenceId);

 Time Stamp

You must use the following function to set the last update time in the PPM 
Center request:

/**
* Set the time stamp in long format—that is, the number of 
* milliseconds since January 1, 1970, 00:00:00 GMT
**/
setUpdatedTimeStamp(long updatedTimeStamp);
/**
* Set the time stamp in the Java simple date format, which is 
* described at the following location: 
* http://java.sun.com/j2se/1.4.2/docs/api/java/text/

SimpleDateFormat.html
**/
setUpdatedTimeStamp(String updatedTimeStamp, String format);

 General Field

Use the following function to set a value of a general field in the PPM 
Center request:

setField (String fieldName, String value);

 Date

Use the following function to set a value of a date field in the PPM Center 
request:

/**
* Set the date in long format—that is, the number of 
* milliseconds since January 1, 1970, 00:00:00 GMT
**/
setDateValue(String fieldName, long date);
/**
* Set the date in the Java simple date format which is
* described in the following location:
* http://java.sun.com/j2se/1.4.2/docs/api/java/text/

SimpleDateFormat.html
**/
setDateValue(String fieldName, String date, String format);
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Configuring the PPM Center Adapter Sender Properties

Specify the properties for the sender section of the PPM Center adapter 
configuration file as described in Table 4-6. The sender controls updating 
changes in Service Manager with the converted data.

Table 4-6. PPM Center adapter sender properties (page 1 of 2)

Property Name 
(*Required) Description Default 

Value

*userName

User name in the Service Manager system 
that PPM Center uses to connect to Service 
Manager.

This user name must include only single-byte 
characters.

This user must have full access to the 
Change Management module in Service 
Manager.

(None)

*password
Password in the Service Manager system 
that PPM Center uses to connect to Service 
Manager. 

(None)

*queryDateFormatPattern

Date format used for querying the Service 
Manager system (as used in the UI expert 
search). 

Make sure this value is consistent with the 
Service Manager server date pattern. For 
available formats, see the following URL:

http://java.sun.com/j2se/1.4.2/docs/api/java/
text/SimpleDateFormat.html

(None)

*timeZone

Time zone, used for converting the last 
updated time of a request from Service 
Manager. Use the same time zone as the 
Service Manager server. 

The format can be GMT+<X> or GMT–<X>, 
where <X> is the offset in hh:mm format from 
GMT. For example, GMT–07:00.

However, to handle Daylight Saving Time, 
use an area time zone instead of specifying a 
time relative to GMT.

(None)
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The sender is the last section of the adapter configuration file. Make sure the 
file ends with the following: 

</adapter>
</settings>

This completes the configuration of the PPM Center adapter file.

*keyMethodName
Name of the method for request keys (usually 
the ID field name).

(None)

*serviceUrl

Web service URL of Service Manager. The 
format is as follows:

http://<Service_Manager_Host>:<Port>/
sc62server/PWS/

where <Service_Manager_Host> represents 
the host machine where Service Manager is 
running.

(None)

*staticFieldNames

(Applicable and required 
only for bidirectional 
integration)

List of Service Manager change fields 
(separated by semicolons) that are not to be 
updated when changes are made to their 
mapped PPM Center request fields. 

This list is used to prevent inappropriate 
update of PPM Center requests for 
bidirectional integration. For example, to 
prevent a request from being updated when 
the last update time in Service Manager 
changes, specify the following:

sysmodtime

(None)

idProperty
Property name of the ID field in the instance 
returned from the Service Manager Web 
service.

(None)

Table 4-6. PPM Center adapter sender properties (page 2 of 2)

Property Name 
(*Required) Description Default 

Value

If PPM Center is operating in a clustered server configuration, share or copy the 
<PPM_Home>/sdi-persistency directory and the <PPM_Home>/conf/sdi 
directory among all the servers in the cluster.
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Configuring the server.conf Parameter in PPM Center

Add (if not present) and specify the parameter related to Service Manager 
integration to the PPM Center server.conf configuration file, as follows: 

1. Stop the PPM Server.

2. Run the following script: 

sh ./kConfig.sh 

Set the parameter and value as shown in the following table. (All parameter 
names begin with com.kintana.core.server. but that is not shown in 
the table.)

3. Restart the PPM Server.

For more information about the steps in this procedure, see the Installation and 
Administration Guide. 

Parameter Value

MAC_LOG_SEVERITY

Specify the level of logging to be used. When set to 0 
(the default), only integration exceptions (errors) and 
a summary are logged. When set to 1, non-error 
events related to the processing of changes are also 
logged. See Error and Non-Error Logging 
on page 133.
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Enabling the ALM Startup Service 

To enable the ALM Startup service:

1. Log on to PPM Center. 

2. From the menu bar, select Open > Administration > Schedule Services. 

The Schedule Services page opens.

3. In the Service Name column, select the ALM Startup service.

4. In the Status column for the service, select Enabled. 

5. Specify one hour for the interval in the Schedule column. This interval has 
no effect on the polling of Service Manager for tickets.

6. Click Save. 

7. If a date was specified in the initial-load-state Service Manager 
adapter attribute in order to retrieve existing Service Manager changes 
from that date forward, those changes will be retrieved, converted, and sent 
to PPM Center, but then no new Service Manager changes will be 
retrieved. In this case, to retrieve Service Manager changes on an ongoing 
basis, do the following: 

a. Stop the PPM Server. 

b. Comment out the initial-load-state Service Manager adapter 
attribute.

c. Restart the PPM Server in normal mode.

d. Repeat step 1 through step 6 to verify that the ALM Startup service is 
running. 

For more information about the steps in this procedure, see the Installation and 
Administration Guide. 
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Error and Non-Error Logging

As described in the following sections, logging is essential for ensuring correct 
operation of the integration. You can specify the following two types of 
logging for Service Manager integration: 

 System-level logging using a summary logs table and a log details table. 
See System-Level Logging.

 Configurable logging for conversion scripts. See Configurable Logging for 
Conversion Scripts on page 136.

System-Level Logging

System-level logging is the only way to administer the integration on an 
ongoing basis. HP recommends creating a portlet or a report to regularly query 
and display the logging tables and help you identify potential problems.

You can configure ALM to log only errors for integration exceptions and a 
summary, or to also log entries for non-error events related to the processing of 
changes. For information about setting the server.conf parameter that 
controls the level of logging (MAC_LOG_SEVERITY), see Configuring the 
server.conf Parameter in PPM Center on page 131. 

Setting the MAC_LOG_SEVERITY parameter to 0 causes the summary logs table 
(SDI_SUMMARY_LOGS) to include only a summary of errors. Setting this 
parameter to 1 causes the summary logs table to also include information about 
tickets as they are being processed. 

The summary logs table maintains only one row for each unique combination 
of the TICKET_ID and ADAPTER_NAME columns. See Summary Logs Table 
on page 134. Each row is updated on an ongoing basis as status changes.

The log details table (SDI_LOG_DETAILS) includes details about the errors that 
have a value of Y in the MESSAGES column of the summary logs table. See 
Log Details Table on page 135. (The setting of the MAC_LOG_SEVERITY 
parameter in the server.conf file does not affect the contents of the log 
details table.) 
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Summary Logs Table

The columns in the summary logs table (SDI_SUMMARY_LOGS) that contain 
useful information are described in Table 4-7. 

Table 4-7. Summary logs table (SDI_SUMMARY_LOGS) (page 1 of 2)

Column Description

LOG_ID Primary key for this table.

TICKET_ID
Ticket ID imported using the connector. In some cases 
such as connection errors or authentication failures, the 
value is SUMMARY. 

STATUS

Current state of the ticket. Possible values are as follows:

 Retrieved/Not processed. The ticket was retrieved 
and has not been processed. 

 preFilter Passed. The ticket passed the preFilter 
function and was sent to the convert function.

 Rejected in preFilter. The ticket did not pass 
preFilter criteria. 

 Ticket converted. The ticket passed the convert 
function and was sent to the postFilter function. 

 postFilter Passed. The ticket passed the 
postFilter function and was sent to the sender 
function. 

 Rejected in postFilter. The ticket did not pass the 
postFilter function. 

 Error occurred in JavaScript. An exception occurred 
in the preFilter, convert, or postFilter 
function when processing the JavaScript conversion 
file. 

 Ticket processed. The ticket was created in the target 
system. 

 Errors occurred when sending the ticket. An 
exception occurred and the ticket could not be sent to 
the sender. 

LAST_UPDATE_DATE Last time the ticket was updated in PPM Center.

COMPONENT
Component that logged the message—the connector, 
converter, or sender. 
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Log Details Table

The log details table (SDI_LOG_DETAILS) includes the details described in 
Table 4-8 for the errors that have a value of Y in the MESSAGES column of the 
summary logs table. 

ADAPTER_NAME Service desk name in the adapter settings file.

MESSAGES 
If the value is Y, further details for this log entry are 
provided in the log details table (SDI_LOG_DETAILS). If 
the value is N, no further details are provided.

IN_PROCESS
If the value is Y, processing of this ticket is complete. If 
the value is N, processing of this ticket is not yet 
complete.

Table 4-7. Summary logs table (SDI_SUMMARY_LOGS) (page 2 of 2)

Column Description

Table 4-8. Log details table (SDI_LOG_DETAILS)

Column Description

LOG_DETAIL_ID Primary key for this table

LOG_ID Foreign key to the entry in the SDI_SUMMARY_LOGS table

DETAILS Detailed error message captured when the error occurred
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Configurable Logging for Conversion Scripts

Configurable logging is useful for debugging your integration mapping. 
During testing, you can specify log messages that appear at key points in the 
conversion script to indicate correct or incorrect conversion. Before deploying 
the integration to production, you would typically want to comment out the 
messages for correct operation so they do not quickly accumulate in the logs.

If you want to view log messages describing the activity that occurs during the 
request conversion process, you can include logging objects in your conversion 
scripts. During the conversion process, you can view the log messages in the 
conversion script log files, located in the <PPM_Home>/script-logs directory. 
Each adapter logs messages in a separate log file. The names of the log files are 
based on the names of the adapters for which the files log errors.

Within any of the script functions, a logging object with the following syntax 
should be included:

logger.<type of message>("<log message>");

The following message types can be used:

 info. Records all processing activity that is performed.

 warn. Records warning messages.

 error. Records error messages.

For example, you can include a logging object such as the following:

logger.info("Processing ticket " +
serviceManagerRFC.get("header.changeNumber"));

If you want the conversion script log files to display a list of all Service 
Manager fields, you can include the following logging object in your 
conversion script:

logger.info(BeanUtils.describe(ticket));

If you use this logging object, make sure the following line is included at the 
beginning of the conversion script:

importPackage(Packages.org.apache.commons.beanutils);

Logging is also controlled by the severity specified in the PPM Center 
logging.conf file.
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5 Integrating PPM Center with HP Universal 
CMDB, Using ALM
Introduction to Integrating PPM Center with Universal CMDB, 
Using ALM

Universal CMDB consists of a business-service-oriented data model with 
built-in discovery of the following:

 Configuration items (CIs) and their dependencies

 Visualization and mapping of business services

 Tracking of configuration changes

When you integrate PPM Center with Universal CMDB, you can select CIs 
and run impact analysis reports from change requests in PPM Center, to 
determine which components of a system will be affected by a software 
change, and to what extent. The integration assists IT managers and Change 
Advisory Boards in deciding whether a change request should be approved for 
development or deployment. 

For example, your software change might involve upgrading a database server. 
Before you can perform the upgrade, you need to stop the server. In some cases 
this could prevent users from accessing crucial services, or even cause a crash 
of your production system. Impact analysis determines the effect on the entire 
system of stopping the server, and gives you a report showing the components 
that will be impacted. This enables you to plan the change with minimal 
disturbance to your operations.

For more information about the benefits of this integration, see Integration of 
PPM Center with Universal CMDB for Impact Analysis of Requests, Using 
ALM on page 19.
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For information about the versions supported for integration, see the System 
Requirements and Compatibility Matrix. 

For more information about Universal CMDB, see its product documentation 
at the Web site described in Optional PPM Center Integrations on page 17.

Using Impact Analysis in a Change Request Lifecycle

Since a software change might be developed and deployed over a lengthy 
period of time, you might want to generate an Impact Analysis Report at the 
following stages in the lifecycle of the change request:

 Before you approve or develop the change. Before you approve or 
develop the change, it is useful to forecast the effect that introducing the 
change will have on your production system. You describe the intended 
change, specify the components that you think will be affected, and run 
impact analysis to forecast the effect of the change. 

The resulting report gives you an indication of how your system will cope 
with the change after the change has been developed and deployed, and 
helps you decide whether to approve the change for development.

 After the change is approved for deployment to a production system, 
but before you deploy the change. While the software change is being 
developed and then evaluated for quality, modifications may occur in your 
system infrastructure. For example, servers might be added or removed, or 
applications might be changed. As a result, the original impact analysis 
may no longer give an accurate indication of what will happen when you 
introduce the change. So after the change has been developed, evaluated, 
and approved for deployment, you perform another impact analysis to give 
you an up-to-date picture. 

No software needs to be installed on the Universal CMDB server to integrate PPM 
Center and Universal CMDB. However, see the System Requirements and 
Compatibility Matrix. 
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Configuring Universal CMDB for the Integration

To configure Universal CMDB for the integration, configure views in 
Universal CMDB and create a PPM Center user and password in Universal 
CMDB. See the Universal CMDB documentation.

Configuring PPM Center for the Integration

Perform the procedures in this section to configure PPM Center for the 
integration.

Configuring server.conf Parameters in PPM Center

Add (if not present) and specify the parameters related to Universal CMDB 
integration to the PPM Center server.conf configuration file, as follows:

1. Stop the PPM Server.

2. Run the following script: 

sh ./kConfig.sh 

Set the parameters and values as shown in the following table. (All 
parameter names begin with com.kintana.core.server. but that is not 
shown in the table.)

For more information about the steps in this procedure, see the Installation and 
Administration Guide. 
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Parameter Value

UCMDB_GATEWAY_URL

URL of the Probe Gateway component of the 
Discovery and Dependency Mapping (DDM) 
Probe. The Probe Gateway provides 
communication (HTTP or HTTPS) between the 
Probe Manager and the Universal CMDB user 
for processes such as downloading tasks and 
returning task results. 

The value for <UCMDB_Host>:<port> is 
usually the same as for the  
UCMDB_SERVER_URL parameter.

http://<UCMDB_Host>:<port>/mam/
gateway? 

UCMDB_MAX_CI_NUMBER

Maximum number of CIs a request is allowed 
to have. Valid values are from 1 to 100. If a 
value greater than 100 is specified, the PPM 
Server will not restart and displays an error 
message. The default is 20.

UCMDB_PASSWORD

Password for Universal CMDB user specified 
in UCMDB_USER.

This password must be encrypted as 
described in Encrypting the Password 
Specified as a server.conf Parameter.

UCMDB_SERVER_URL

URL of the Universal CMDB server:

http://<UCMDB_Host>:<port>/ucmdb/ 

or

https://<UCMDB_Host>:<port>/ucmdb

where <UCMDB_Host> represents the host 
machine on which Universal CMDB is running.

Note: If the Universal CMDB server is 
configured to support HTTPS, make sure you 
configure the  
UCMDB_SSL_KEYSTORE_PATH parameter. 
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3. Restart the PPM Server.

Encrypting the Password Specified as a server.conf Parameter

The password that you assigned to the UCMDB_PASSWORD parameter must be 
encrypted, as follows:

1. Navigate to the <PPM_Home>/bin/ucmdb directory.

2. Run the kEncryptUcmdbPassword.sh utility.

3. Specify the password you want to encrypt.

The utility encrypts the password and displays the encrypted text.

4. Copy the text in the Encrypted text section on the screen and paste the 
text as the value for UCMDB_PASSWORD in the server.conf file, making 
sure that you do not copy any carriage returns into the file. 

UCMDB_SERVER_VERSION Do not use.

UCMDB_SSL_KEYSTORE_
PATH

Universal CMDB keystore path, used only if 
the UCMDB_SERVER_URL parameter uses 
HTTPS.

UCMDB_USER

Universal CMDB user name, for example, 
admin.

This user name must include only single-byte 
characters.

Parameter Value
Integrating PPM Center with HP Universal CMDB, Using ALM 141



Configuring a Request Type

The integration requires a request type with the Universal CMDB Impact 
Analysis field group. The ALM - Request for Change (RFC) request type 
provided with ALM includes this field group, which is enabled by default. 

If necessary, you can add the Universal CMDB Impact Analysis field group to 
a different request type, as follows:

1. Log on to PPM Center.

2. From the menu bar, select Open > Administration > Open Workbench.

The PPM Workbench opens.

3. From the shortcut bar, select Demand Mgmt > Request Types. 

The Request Types Workbench opens.

4. Select the request type to which you will add the Universal CMDB Impact 
Analysis field group.

5. Open the request type and its request header type.

6. Click Field Groups. 

7. In the Field Groups window, scroll down and select the check box to 
enable the Universal CMDB Impact Analysis field group.

8. Click OK to add the Universal CMDB Impact Analysis field group to the 
request header type.

9. Expand Universal CMDB Impact Analysis in the Prompt column on the 
Fields tab in the request header type.

10. Select the CI List field, and click Edit. 

11. On the Attributes tab, select No for the Display Only option and select Yes 
for the Display option. 

12. Select the Security tab and edit field-level security for the CI List field as 
needed.

13. Click OK to save and close the Edit window and click OK to save and close 
the Request Header Type window.
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14. Return to the request type, which now has the Universal CMDB Impact 
Analysis section, including the CI List field, based on the changes you 
made to the request header type.

15. Use the Layout tab to reposition the Impacted Configuration Items section 
on the request type, as desired.

Using the Integration 

The Configuration Management Database (CMDB) in Universal CMDB 
contains information about all your CIs (servers, applications, hosts, and so on) 
and their relationships. CIs can vary widely in complexity, size, and type, from 
an entire system (including all hardware, software, and documentation) to a 
single module or minor hardware component.

For example, the CMDB contains information about which CIs are affected 
when other CIs stop functioning or have operational problems.

You generally perform impact analysis as follows:

 Select the CIs that you suspect might be affected by the planned software 
change.

 Run impact analysis on the selected CIs. Impact analysis analyzes the 
relationships among the selected CIs in the CMDB, and generates a report 
showing the CIs that will be affected by the planned change.

 Run impact analysis at additional points. Examples:

o Before approving a change, to forecast the effect that the change will 
have on your system.

o After the change has been created, in case your system infrastructure 
has changed since the previous impact analysis was performed.

On the Status Dependencies tab for the CI List field, leave the Required, 
Reconfirm, and Clear options set to No. 

You can change the Visible and Editable options as desired.

HP recommends using CI names in Universal CMDB that will be meaningful to 
you in PPM Center.
Integrating PPM Center with HP Universal CMDB, Using ALM 143



Selecting CIs in Universal CMDB and Adding the CIs to a Request

To select the desired CIs in Universal CMDB to add to the request:

1. Log on to PPM Center.

2. From the menu bar, select Create > Request. 

3. Create a request using a request type that includes the Universal CMDB 
Impact Analysis field group.

4. In the Impacted Configuration Items section of the new request, click Select 

Configuration Items. 

The CI selector applet from Universal CMDB launches, with Browse and 
Search tabs.

5. Use the tabs to select the desired CIs for the request.

 To use the Browse tab, select a view such as Network Topology from 
the View list.

Expand the view as desired. You can select multiple items in the tree by 
using Ctrl + click or Shift + click. 
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 To use the Search tab, complete the Search for field to limit the search 
results, and select a CI Type. Click the search icon for the CI Name field 
and select items as needed. You can select multiple items by using 
Ctrl + click or Shift + click. 

6. Click OK to add the selected CIs to the request, under the Impacted 

Configuration Items heading in the Universal CMDB Impact Analysis 
section. The added CIs are shaded in color. Duplicate CIs are not added. 

For each CI, data appears in the CI Name and CI ID columns. If you selected 
CIs using the Browse tab in the Universal CMDB applet, data also appears 
for the View Name, View Type, View Tree Name, and View TQL Name 
columns. Data does not appear for these columns if you selected CIs using 
the Search tab, because the same CI can exist in multiple views.

If adding the CIs to the request would exceed the maximum number 
allowed by the UCMDB_MAX_CI_NUMBER parameter in the server.conf file, 
none of the selected CIs are added.

When you select and add CIs in Universal CMDB to the PPM Center 
request, the CIs are never changed or deleted in Universal CMDB.
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7. As necessary, click the Delete icon to the left of any CI you want to delete.

The Delete icon becomes an undo icon to allow you to undo the pending 
deletion.

8. After the desired CIs are listed in the request, click Submit (or Save for an 
existing request) to add the list of CIs to the request.

If a request with a list of CIs is copied, the list of CIs is not copied to the new request.
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Generating Impact Analysis Reports

To generate an Impact Analysis Report for the CIs that have been added to a 
request:

1. Click the Launch HP Universal CMDB Impact Analysis button in the 
Impacted Configuration Items section of the request. Log in to Universal 
CMDB if prompted to do so. 

An Impact Analysis Report is generated in Universal CMDB.

2. Add the Impact Analysis Report to the request, using the Impact Analysis 

Report field in the Impact & Resource Assessment section of the request.

3. Based on the impact analysis report, make your recommendations in an 
Impact Assessment Report. Add your report to the request using the Impact 

Assessment Report field in the Impact & Resource Assessment section of 
the request.

The Launch HP Release Control button appears if PPM Center is also 
integrated with HP Release Control, as described in Chapter 7, Integrating 
PPM Center with HP Release Control, Using ALM, on page 245.

The CIs in a request are available as part of standard Web services for a request. The 
token is REQ_VP_KNTA_UCMDB_CI_LIST. The value of the field represented by this 
token is a comma-separated list of CI IDs.
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6 Integrating PPM Center with HP Quality 
Center, Using ALM
Introduction to Integrating PPM Center with Quality Center, 
Using ALM

Integrating PPM Center with Quality Center enables you to create Quality 
Center requirements and defects while using PPM Center. This allows users of 
both applications to participate in the processing of defects, change requests, 
and release requests. 

In PPM Center, a request type is a template, and when you create a request, 
you must select a request type. With the PPM Center–Quality Center 
integration, creating the request in PPM Center automatically creates a defect 
or requirement in the integrated Quality Center project. For example, 
depending on the integration configuration, creating a PPM Center request of 
type PPM_Defect could create a defect in Quality Center project A or 
project B, and creating a PPM Center request of type PPM_Requirement could 
create a requirement in Quality Center project A or project B. 

In addition, for integration with Quality Center version 11.00, when a Quality 
Center defect is created, an associated PPM Center request can be created 
automatically.

When an IT manager or business liaison enters a change request or creates a 
release comprising a group of change requests in PPM Center, PPM 
Center–Quality Center integration causes a requirement to be created in 
Quality Center. This informs QA personnel that they should begin the QA 
process.
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PPM Center–Quality Center integration allows ongoing synchronization 
between fields such as status fields that have been mapped between a request 
type in PPM Center and an associated defect or requirement in a Quality 
Center project.

Upon completion of the QA process, the IT manager or business liaison is 
notified on the PPM Dashboard and can complete the deployment process.

Using Quality Center version 10.00, multiple PPM Center request types can be 
integrated with the same Quality Center entity (either a defect or a 
requirement) in a project. Using Quality Center version 11.00, each integration 
must include a one-to-one, unique mapping between a PPM Center request 
type and a Quality Center entity (defect or requirement). 

In any case, different PPM Center request types can be integrated with 
different entities of the same project or different projects in Quality Center. If 
the request types are integrated with entities of different projects, the projects 
can be on the same or different Quality Center servers, and each Quality Center 
server can be at version 10.00 or version 11.00. 

For more information about the benefits of this integration, see Integration of 
PPM Center with Quality Center, Using ALM on page 20 and Benefits and 
Functionality of the Integration.

For information about the Quality Center versions supported for integration 
and, for integration with Quality Center version 10.00, the required version of 
.NET Framework for the machine on which the integration tool is run, see the 
System Requirements and Compatibility Matrix. 

PPM Center version 9.10 can be integrated with Quality Center versions 10.00 and 
11.00, but the integration configuration procedures are significantly different.

 For integration with Quality Center version 10.00, PPM Center provides the PPM 
Center-Quality Center Integration Tool, which you can install on any computer. You 
use a software wizard to help create the required mapping files, which you then 
deploy to PPM Center and to Quality Center.

 For integration with Quality Center version 11.00, you use a menu option in PPM 
Center to create the mapping files in a central PPM Center location rather than 
creating them elsewhere and deploying them to PPM Center or Quality Center.

Be sure to follow the appropriate integration procedures in this chapter, based on the 
installed version of Quality Center. Do not attempt to use the PPM Center-Quality 
Center Integration Tool to configure integration with Quality Center version 11.00.
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For more information about Quality Center, see its product documentation at 
the Web site described in Optional PPM Center Integrations on page 17.

Benefits and Functionality of the Integration

Integrating PPM Center and Quality Center provides the following benefits to 
users of each application:

 Data sharing. The integration allows data sharing between PPM Center 
and Quality Center. Business managers and IT personnel using PPM 
Center gain visibility into how a project is affected by both the quality 
control process and the parameters that are collected in Quality Center. 
They can use Quality Center capabilities when creating requests for 
changes.

 Inclusion of Quality Center data in the workflow. The PPM Center 
workflow is a well-defined process that allows IT managers to plan, track, 
and deploy software enhancements. Integration allows you to build your 
own workflows and steps in PPM Center while using fields and data from 
Quality Center. The Quality Center defect resolution capabilities become 
part of the workflow. This makes the quality process an integral and formal 
part of the IT processes.

 QA-dependent workflow progression (for integration with Quality 
Center version 10.00 only). Progress from one step in the PPM Center 
workflow to the next can be made dependent on progress by the QA team. 
In PPM Center, the IT manager can view how a project is affected by the 
quality defects that are collected in Quality Center and can decide whether 
a defect has been resolved or an enhancement can be deployed. 

 Direct activation of processes, and creation of Quality Center 
requirements and defects from PPM Center. Processes can be activated 
by PPM Center—creating a PPM Center request of a type that is integrated 
with Quality Center creates a defect or requirement in Quality Center when 
the relevant step in the PPM Center workflow is activated. 

No software needs to be installed on the Quality Center server to integrate PPM 
Center and Quality Center. However, see the System Requirements and 
Compatibility Matrix. 
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 Synchronization of mapped field values between PPM Center and 
Quality Center. When fields are mapped between a PPM Center request 
type and a Quality Center defect or requirement, changing the value of a 
mapped field in one application can automatically change the value of the 
associated field in the other application. For example, when you change the 
status of a request related to defects to Fixed in PPM Center, the status of 
the associated Quality Center project defect changes to Fixed. 

Users can specify that one of the following occurs for any pair of mapped 
fields:

o Changing the value of the field in the Quality Center defect or 
requirement automatically updates the value of the mapped field in the 
PPM Center request accordingly, that is, Quality Center is dominant for 
(controls) the pair of mapped fields.

o Changing the value of the field in PPM Center request automatically 
updates the value of the mapped field in the Quality Center defect or 
requirement accordingly, that is, PPM Center is dominant for (controls) 
the pair of mapped fields.

o Changing the value of the field in either application automatically 
updates the value of the mapped field in the other application 
accordingly, that is, the field mapping is bidirectional.

Synchronization of defects enables the following:

o Developers can use PPM Center to manage the defect-fixing process, 
while QA personnel continue to use Quality Center.

o Project managers and IT managers can view all the defects in the 
system, whether the defects originated in PPM Center or in Quality 
Center. This helps the managers to decide on content for the next 
release or new requirements and enhancements.

o QA personnel can use Quality Center to manage defects created 
through PPM Center.

 Request hierarchy synchronization. The hierarchical structure of 
requirements in Quality Center can be synchronized with the structure of 
the associated requests in PPM Center. That is, you can force the Quality 
Center requirement hierarchy to match the PPM Center request hierarchy 
automatically. 
152 Chapter 6



 Synchronization with PPM Center notes. The integration allows you to 
synchronize a notes-related field in Quality Center with notes in the 
associated PPM Center request. When you update the content of the notes 
in a PPM Center request, the associated notes field in Quality Center is 
updated. 

Added Functionality of Integration with Quality Center Version 11.00

Integration with Quality Center version 11.00 provides the following added 
capabilities compared to integration with Quality Center version 10.00:

 Creating a defect in Quality Center version 11.00 can create a request in 
PPM Center.

 Configuration uses the PPM Center standard interface, not a separate 
integration tool that must be installed on a Windows machine.

 Configuration no longer requires explicit deployment of the field mapping 
file to Quality Center or to PPM Center.

 The integration with Quality Center version 11.00 has an event and error 
log you can view.

 Email notification options are enhanced—you can optionally have 
notifications sent as follows:

o When the integration creates or updates Quality Center defects as well 
as other entities. 

o When integration errors occur. 

o In a daily consolidation of notifications, as an alternative to individual 
notifications.

The information in the notifications matches the information in the event 
and error log.

 The integration supports HTTPS.

 When a PPM Center request is created, the integration automatically 
populates the request fields related to Quality Center—the Quality Center 
server instance (URL), domain, and project—with the values PPM Center 
retains from initial configuration of the integration.
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ALM Entities Used by the Integration

The ALM entities that are used by the integration with Quality Center are 
described in the following sections.

ALM - Defect Template with Quality Center Integration Request Type

The PPM Center request type that ALM provides for integration with Quality 
Center project defects is the ALM - Defect Template with Quality Center 
Integration request type. This request type uses only the ALM - Defect 
Template with Quality Center Integration workflow. To prevent you from 
inadvertently using a workflow that is not enabled for this integration, you 
cannot choose a different workflow. This request type includes the Quality 
Center Defect Information field group. 

Figure 6-1 shows the Create New ALM - Defect Template with Quality Center 
Integration page that appears when you create a request and select the 
ALM - Defect Template with Quality Center Integration request type. 
Table 6-1 describes the fields in the request, including some fields that do not 
appear until the request is submitted for creation or until other conditions are 
met.

The fields in the Quality Center Defect Information section of the request are 
defined by the Quality Center Defect Information field group in the request 
header type for the request. For more information about these fields, see 
Quality Center Defect Information Field Group on page 160.

Although you can create new request types from scratch, HP recommends that you 
use the provided ALM request type as a template to create new request types. In the 
PPM Workbench, you can copy the provided request type and modify the copy. If you 
create your own request types to integrate PPM Center and Quality Center, make 
sure you use workflows that are enabled for integration.

You can also create a new request type with a customized request header type.
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Figure 6-1. ALM - Defect Template with Quality Center Integration request
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Table 6-1. ALM - Defect Template with Quality Center Integration request fields 
(page 1 of 2)

Field Name (*Required) Description

Summary section

Request No.
(Added after the request is created) Number of the 
request

Created On
(Added after the request is created) Date the 
request was created

*Summary Summary description of the request

Department Department to which the user belongs

Created By User who created the request

*Severity Severity of the defect

Assigned To Developer assigned to work on the defect

Detected in Version
Version of the application in which the defect was 
detected

Assigned Group Group responsible for addressing the defect

Defect Priority Priority of the defect

Application Application in which the defect was discovered

Reproducible
Option to indicate whether the defect is 
reproducible

Request Status Status of the request

Quality Center Defect Information section a

*Quality Center Instance
URL of the Quality Center instance with the project 
used for the integration 

*Quality Center Domain Domain of the project in Quality Center 

*Quality Center Project
Quality Center project that is integrated with this 
request type

Detected in Quality Center by User in Quality Center who detected the defect
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Defect Number
(Added after the defect is created in Quality Center) 
Defect number in Quality Center

Quality Center Defect Status
(Added after the defect is created in Quality Center) 
Status of the defect in Quality Center

Quality Center Message

(Read-only. Added after the defect is created in 
Quality Center.) Quality Center status message 
indicating success or error in the most recent 
operation 

Quality Center Attachments
URL of the list of attachments to the Quality Center 
requirement or defect

Planned vs. Actual section

Planned Closing Version
Version of the application targeted to have the 
defect fix

Closed in Version Version of the application that has the defect fix

Estimated Fix Time (days)
Original estimate of the number of days it would 
take to fix the defect

Actual Fix Time (days) Actual number of days it took to fix the defect

Closed on Date the defect was closed in Quality Center

Defect Information section

Detailed Description Detailed description of the defect

Developer Comments Developer comments regarding the defect

a. Fields in the Quality Center Defect Information section remain visible by default but are not used if 
PPM Center is not integrated with Quality Center.

Table 6-1. ALM - Defect Template with Quality Center Integration request fields 
(page 2 of 2)

Field Name (*Required) Description

The administrator can remove the Quality Center Defect Information section from 
the request type by removing the Quality Center Defect Information field group from 
the ALM - Defect Template with Quality Center Integration request header type. 

See the HP Demand Management Configuration Guide for details about request 
header types and field groups.
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To submit an ALM - Defect Template with Quality Center Integration request:

1. Log on to PPM Center.

2. From the menu bar, select Create > Request. 

The Create New Request page appears.

3. On the Create New Request page, in the Request Type field, select 
ALM - Defect Template with Quality Center Integration and click Create. 

The Create New ALM - Defect Template with Quality Center Integration 
page appears, displaying the appropriate request fields.

Required fields have a red asterisk. All other fields are optional, but are 
often helpful when others are reviewing an open request. For information 
concerning a specific field, click the Help icon next to the field (if 
available). 

4. Complete the fields in all sections as appropriate.

The Notes section contains fields where notes and information concerning 
the request can be entered and stored. Typically, when you create a request, 
you do not need to add a note to it. However, add a note if you want to 
convey additional information to the reviewers and processors of the 
request.

In the References section of the request, you can add useful references such 
as a Web-accessible file or a document or file attached from a local 
machine. For more information about adding references, see the  
HP Demand Management User’s Guide. 

5. On the Create New Request page, click Submit. 

The request is submitted. The Request Creation Confirmed page appears.

After submitting the request, on the Request Creation Confirmed page you 
can click the link for the particular request number in the Request # field to 
view the detail page of the newly generated request. 

PPM Center can be configured to allow you to save the request before you submit 
it. To have this feature enabled, see your PPM Center administrator.
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When the request is submitted, it is assigned an initial status, such as New. The 
request is then routed along the ALM - Defect Template with Quality Center 
Integration workflow (see ALM - Defect Template with Quality Center 
Integration Workflow on page 161).

Request Header Types

By default, when you create a new request type from a provided one, the new 
request type uses the same request header type as the provided request type 
uses.

When creating a new request type, you can do the following:

 Use the supplied request header type as is.

 Copy the request header type, customize the copy, and use the customized 
copy in the new request type.

 Create a completely new request header type.

If you create a new request header type, add the required integration-related 
fields by selecting the appropriate field group, as follows:

1. Log on to PPM Center.

2. From the menu bar, select Open > Administration > Open Workbench. 

The PPM Workbench opens.

3. From the shortcut bar, select Demand Mgmt > Request Header Types. 

The Request Header Type Workbench opens. 

4. In the Request Header Type Workbench, click New Request Header Type. 

The Request Header Type window opens.

5. Click Field Groups. 

The Field Groups window lists the available field groups.

Your request header type must include the Quality Center fields that appear in the 
provided request header type. If you customize a request header type, make sure you 
do not delete the Quality Center fields.
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6. Select the appropriate field group:

 For a defect, select the Quality Center Defect Information field group.

 For a requirement, select the Quality Center Info field group.

Quality Center Defect Information Field Group

The fields in the Quality Center Defect Information section of the ALM - Defect 
Template with Quality Center Integration request type (see Table 6-1 
on page 156) are defined by the Quality Center Defect Information field group. 
These fields support integration with Quality Center defects and should not be 
modified (except for their Field Prompts, as desired). Table 6-2 provides more 
information about these fields. 

Table 6-2. Fields in Quality Center Defect Information field group

Field Name Field Database ID Field Type

Quality Center Instance KNTA_QC_DEFECT_INSTANCE
Autocomplete 
List 

Quality Center Domain KNTA_QC_DEFECT_DOMAIN
Autocomplete 
List 

Quality Center Project KNTA_QC_DEFECT_PROJECT
Autocomplete 
List 

Detected in Quality Center by QC_DETECTED BY Text (40)

Defect Number KNTA_QC_DEFECT_NO
Numeric Text 
(10 digits)

Quality Center Defect Status KNTA_QC_DEFECT_STATUS Text (300)

Quality Center Message KNTA_QC_DEFECT_INT_MSG Text (300)

Quality Center Attachments KNTA_QC_DEFECT_ATT_URL URL
160 Chapter 6



ALM - Defect Template with Quality Center Integration Workflow

The PPM Center workflow that ALM provides for integration with Quality 
Center project defects is the ALM - Defect Template with Quality Center 
Integration workflow, which includes execution steps to create a defect or 
requirement in Quality Center. You can use this workflow as a template for 
creating your own workflows.

Although you can create new workflows from scratch, HP recommends that 
you create them from this template. To create a new workflow, use the PPM 
Workbench to create a copy of a provided workflow, and then modify the copy 
(add, delete, or change its steps) to suit your needs.

The integration also uses the ALM - Release Request workflow to create a 
release entity that includes several requests for change. This workflow can be 
used for ITIL purposes whether or not PPM Center is integrated with other 
applications. For more information, see ALM - Release Request Workflow 
on page 74.

The ALM - Defect Template with Quality Center Integration workflow is used 
to create a defect and to track how the defect is resolved. See Figure 6-2 and 
workflow step 5, Defect Verification.
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Figure 6-2. ALM - Defect Template with Quality Center Integration workflow

When a request of type ALM - Defect Template with Quality Center 
Integration is created in PPM Center, the first step in the workflow creates a 
defect in Quality Center. Subsequent steps cause the defect status in Quality 
Center to change to Open, Reopen, Fixed or Closed, depending on the stage in 
the PPM Center workflow.

Types of Workflow Steps

As with any PPM Center workflow, the ALM - Defect Template with Quality 
Center Integration workflow can contain the following types of steps:

 Decision steps. Steps that require action from the user in order to proceed. 
When the user reaches the decision step, the user sees a set of choices. 
Each choice causes the workflow to proceed in a different manner. For 
example, at one decision step in a workflow, a project manager might be 
offered the choice of either deploying a package or sending it back to QA 
for more testing.
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 Condition steps. Steps that determine the direction that the workflow 
takes.

 Execution steps. Steps that are automated through PPM Center. For 
example, an execution step might create a requirement or defect in Quality 
Center, execute a script, or run a build.

ALM provides two execution steps that can be used in PPM Center to build a 
workflow for integration of PPM Center with Quality Center. The execution 
steps create a defect or a requirement in Quality Center.

ALM Request Types Used for Integration with Quality Center Requirements

Integration with Quality Center project requirements can use the following 
request types and workflows:

 ALM - Request for Change (RFC) request type for requests for change, 
which are used in multiple HP products (see ALM - Request for Change 
(RFC) Request Type on page 32). 

This request type is used in conjunction with the ALM - Request for 
Change workflow (see ALM - Request For Change Workflow on page 41). 

 ALM - Release Management request type for requirements (see 
ALM - Release Management Request Type on page 68). 

This request type is used in conjunction with the ALM - Release Request 
workflow (see ALM - Release Request Workflow on page 74).

These request types include the Quality Center Info field group (see Quality 
Center Info Field Group), and their associated workflows can generate 
requirements in Quality Center. 

Although you can create new request types from scratch, HP recommends that you 
use the provided ALM request type as a template to create new request types. In the 
PPM Workbench, you can copy the provided request type and modify the copy. If you 
create your own request types to integrate PPM Center and Quality Center, make 
sure you use workflows that are enabled for integration.

You can also create a new request type with a customized request header type.
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Quality Center Info Field Group

The fields in the Quality Center Info section of the ALM - Request for Change 
(RFC) request type or the ALM - Release Management request type are 
defined by the Quality Center Info field group. These fields support integration 
with Quality Center requirements and should not be modified (except for their 
Field Prompts, as desired). Table 6-3 provides more information about these 
fields. 

Table 6-3. Fields in Quality Center Info field group

PPM Center 
Field Name

PPM Center Field 
Database ID

PPM Center 
Field Type Description

Quality Center Instance KNTA_QC_INSTANCE
Autocomplete 
List 

URL of the Quality Center 
instance with the project 
that will integrate with the 
PPM Center request.

Quality Center Domain KNTA_QC_DOMAIN
Autocomplete 
List 

Domain of the working 
Quality Center project.

Quality Center Project KNTA_QC_PROJECT
Autocomplete 
List 

Quality Center project that 
is integrated with this 
request type.

Quality Center Assigned 
To User

KNTA_QC_ASSIGNED_TO Not applicable
Obsolete field that is not 
used by ALM. Do not use.

Quality Center 
Requirement No.

KNTA_QC_REQUIREMENT_
NO

Numeric Text 
(10 digits)

Requirement number in 
Quality Center.

Quality Center Status
KNTA_QC_REQUIREMENT_
STATUS

Text (300)
Status of the requirement in 
Quality Center.

Quality Center Message
KNTA_QC_REQUIREMENT_
INT_MSG

Text (300)

Quality Center status 
message indicating 
success or error in the most 
recent operation.

Quality Center 
Attachments

KNTA_QC_REQUIREMENT_
ATT_URL

URL
URL of the list of 
attachments to the Quality 
Center requirement. 
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Selecting the Appropriate Integration Procedure

If multiple Quality Center servers (instances) are integrated with PPM Center, 
some of the Quality Center instances can be at version 10.00 and others can be 
at version 11.00.

The procedure to configure integration of PPM Center with Quality Center 
version 11.00 is significantly different from the procedure to configure 
integration with Quality Center version 10.00. You must use only the 
appropriate procedure, as follows:

 For integration with Quality Center version 10.00, go to Configuring 
Integration with Quality Center Version 10.00 on page 166.

 For integration with Quality Center version 11.00, go to Configuring 
Integration with Quality Center Version 11.00 on page 210.

The PPM Center-Quality Center Integration Tool must be used only for integration 
with Quality Center version 10.00. It cannot detect integrations that were previously 
established with Quality Center version 11.00 instances, and any existing integration 
with a version 11.00 instance prevails if you try to use the integration tool for that 
integration.

If PPM Center is at version 9.10 and you upgrade a Quality Center instance from 
version 10.00 to version 11.00, existing integrations of PPM Center requests and 
Quality Center entities (defects or requirements) on that instance will not be upgraded. 
If the integrations are reestablished, they will operate as new integrations. 

In configuring a Quality Center version 11.00 integration, make sure you establish a 
one-to-one, unique mapping between each integrated PPM Center request type and 
its associated Quality Center entity (defect or requirement). 
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Configuring Integration with Quality Center Version 10.00

The procedures in this section apply to integrating PPM Center with Quality 
Center version 10.00 only. If you are integrating PPM Center with Quality 
Center version 11.00, go to Selecting the Appropriate Integration Procedure 
on page 165. 

Integration with Quality Center version 10.00 requires installing the PPM 
Center-Quality Center Integration Tool on any Windows machine that can 
open HTTP connections to the PPM Server and to the Quality Center server. 
This tool enables Quality Center projects for integration and maps PPM Center 
fields to Quality Center fields.

Before proceeding, verify that Quality Center version 10.00 is installed and 
running on the Quality Center server to be integrated.

Overview of Installation and Configuration Process

The procedures for configuring integration of PPM Center and Quality Center 
version 10.00 are described in detail in the following sections, and are 
summarized as follows:

 If an earlier version of the PPM Center-Quality Center Integration Tool 
was installed, uninstall it.

 Install the latest version of the PPM Center-Quality Center Integration 
Tool (see the System Requirements and Compatibility Matrix). This tool 
enables a Quality Center project for integration and maps PPM Center 
fields to Quality Center fields in an XML mapping file.

 Using the PPM Center-Quality Center Integration Tool, configure 
integration with a Quality Center project as follows:

o Enable a Quality Center project for integration.

The PPM Center-Quality Center Integration Tool is used only for integration with 
Quality Center version 10.00. Do not attempt to use the procedures in this section to 
configure integration with Quality Center version 11.00.
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o If you are integrating a PPM Center request type with a Quality Center 
requirement, specify the following:

 Whether email notifications are to be sent when requirements are 
created and/or updated

 Whether the requirement hierarchy is to be synchronized with 
(driven by) the request hierarchy

o Create a mapping between PPM Center fields and Quality Center 
fields, including their value lists.

o Map the Notes field in PPM Center to an existing Quality Center 
project.

o Deploy the mapping file to PPM Center and Quality Center. 

 Configure PPM Center for the integration, including specifying 
server.conf parameters.

Changes to Quality Center Value Lists and Workflows Made by the Integration Tool

When the user enables a Quality Center project for integration using the PPM 
Center-Quality Center Integration Tool, the tool performs one of the following 
actions:

 If the project is new, the tool creates Quality Center value lists and adds 
Quality Center workflow scripts to the user’s existing scripts.

 If the project already exists, the tool updates some of the Quality Center 
value lists so that those lists contain the same values as they would for a 
new project.

The lists and Quality Center scripts create a Quality Center project that can 
work as is with the provided ALM request types and workflows.

If you want to integrate PPM Center requests with both existing and new defects 
in a Quality Center project, create a new Quality Center project with integration 
enabled and copy the existing defects (or the desired subset) from the existing 
project to the new project.
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As described in the following sections, the integration tool changes the value 
lists and workflow enforcement in a Quality Center project to enable the 
project for integration.

Changes to Value Lists

As part of enabling a Quality Center project for integration and establishing a 
field mapping, the integration tool adds two new value lists and adds a new 
value to an existing default value list in Quality Center, as follows:

 New Requirement Status value list, with the following values: 

o New

o Cancelled

o Closed

o 1-Requirements Setup Completed

o 2-Test Plan Setup Completed

o 3-Test Lab Setup Completed

o 4-Running Tests in Quality Center

o 5-Test Execution Completed

o 6-Running Sanity Tests in Quality Center

o 7-Sanity Testing Completed

 New Test Level value list, with the following values:

o Functional

o Integration

o Regression

o Sanity

 New default value of Deleted for the existing Bug Status value list
168 Chapter 6



Workflow Enforcement

As part of enabling a Quality Center project for integration and establishing a 
field mapping, the integration tool updates the Quality Center project 
workflow to enforce the following constraints on Quality Center entities:

 Defect. The user can make only the following status changes:

o Fixed to Closed

o Rejected to Closed

o Fixed to Reopen

 Requirement. The user can make only the following status changes: 

o New to 1-Requirements Setup Completed

o 1-Requirements Setup Completed to 2-Test Plan Setup Completed

o 2-Test Plan Setup Completed to 3-Test Lab Setup Completed

o 4-Running Tests in Quality Center to 5-Test Execution Completed

o 6-Running Sanity Tests in Quality Center to 7-Sanity Testing 
Completed

Installing the PPM Center-Quality Center Integration Tool

Integration requires installing the PPM Center-Quality Center Integration Tool 
on a Windows machine that can open HTTP connections to the PPM Server 
and to the Quality Center server.

To install this tool:

1. If an earlier version of the PPM Center-Quality Center Integration Tool 
was installed, uninstall it. See Uninstalling the Integration Tool.

2. Copy the PPM Center-Quality Center Integration Tool setup.exe file to a 
Windows machine that can open HTTP connections to the PPM Server and 
to the Quality Center server. This file is located in the PPM Server at: 

<PPM_Home>/integration/mac/ppmqcintegrationtool

where <PPM_Home> represents the path where your PPM Center instance is 
installed. For example: xyzserver/E/PPMServer. 
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3. Double-click the setup.exe file to launch the InstallShield wizard.

By default, the tool gets installed in the C:/Program Files/
Hewlett-Packard/PPM Center-Quality Center Integration Tool 
directory.

4. Follow the instructions in the wizard. When the installation completes, do 
not launch the PPM Center-Quality Center Integration Tool yet.

Proceed to Configuring a Quality Center Project for the Integration 
on page 171.

Uninstalling the Integration Tool

If you want to uninstall the PPM Center-Quality Center Integration Tool (for 
example, to be able to run the tool from another Windows machine only), 
select Start > Settings > Control Panel > Add/Remove Programs and follow the 
instructions on the screen.

You use the tool to create an initial mapping between PPM Center fields and 
Quality Center fields (or to revise an existing mapping). Unless you need to 
install a later version of the tool, before you uninstall the tool, remember to use 
it to deploy the mapping to both PPM Center and Quality Center 
simultaneously. 

Enabling Web Services

Verify that Web services in PPM Center are enabled, as follows: 

1. Stop the PPM Server.

2. Run the following script:

sh ./kConfig.sh 

3. Verify that the ENABLE_WEB_SERVICES parameter in the PPM Center 
server.conf configuration file is set to true. 

For more information about the steps in this procedure, see the Installation and 
Administration Guide. 
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4. Restart the PPM Server.

Configuring a Quality Center Project for the Integration

As documented in the following sections, you establish integration of PPM 
Center with Quality Center independently for each Quality Center project as 
needed, using wizards in the PPM Center-Quality Center Integration Tool to 
do the following: 

 Enable a Quality Center project for integration

 Create the XML mapping file between PPM Center and Quality Center 
fields

 Deploy this mapping file to PPM Center and Quality Center

You might also need to manually map the Notes field in a PPM Center request 
to the Quality Center project.

Enabling a Quality Center Project for the Integration

Use the PPM Center-Quality Center Integration Tool to enable a Quality 
Center project for the integration as described in this section.

If PPM Center uses a cluster configuration, repeat this procedure to enable Web 
services on all nodes of the cluster.

HP strongly recommends that you enable a project only once, otherwise problems 
might occur in the integration. There is no reason to enable a project twice. You can 
use the integration tool to change the integration of a project at any time.
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To enable a Quality Center project for integration:

1. From the Windows Start menu, select All Programs > Hewlett-Packard > 

PPM Center-Quality Center Integration Tool. 

The main PPM Center-Quality Center Integration Tool window opens.

2. Select File > PPM Center Settings. 

The PPM Center Settings window opens.
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3. In the Host field, type the URL of the PPM Server.

4. In the Administrator User Name and Administrator Password fields, type 
the PPM Center user name and password.

5. Click Test Connection to test the connection with PPM Center.

6. If a message appears stating that connection was successful, click OK to 
close the PPM Center Settings window, otherwise resolve the connection 
issue.

7. In the main PPM Center-Quality Center Integration Tool window, select 
Action > Enable Project. 

The Enable Quality Center Project wizard opens.

8. Click Next to continue.

If the PPM Server is installed in a WAN, use the IP address for the PPM Server, 
for example http://192.60.28.01:8080, rather than its host name, for 
example http://ppmhost:8080. 
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9. In the Host field, type the URL of the Quality Center server.

10. Click Next to continue.

11. In the User Name and Password fields, specify the user name and password 
of the Quality Center project administrator. 
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12. Click Test Connection to test the connection with Quality Center.

13. If a message appears stating that connection was successful, click OK on 
the message, then click Next. Otherwise resolve the connection issue.

14. Select a Quality Center domain and project, and specify whether you want 
to map Quality Center defects, requirements, or both. 

If you are enabling defects but not requirements for integration, skip to 
step 17 on page 176.
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15. Click Next to continue.

If you are enabling requirements for integration, the following window 
appears.

You can use this window to do the following:

 Request notification by email when a PPM Center request creates a 
new Quality Center requirement. 

 Request notification by email when a PPM Center request updates a 
field in an existing Quality Center requirement.

 Synchronize the PPM Center request hierarchy with the Quality Center 
requirement hierarchy. For information about this synchronization, see 
Request Hierarchy Synchronization on page 234.

16. Select the desired check boxes. 

17. Click Next to continue.

To send any notifications, Quality Center must be configured to automatically 
send them, using email addresses established in Quality Center. See 
Optional PPM Center Integrations on page 17 for information about accessing 
the Quality Center documentation.
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The wizard displays user-defined fields related to the PPM Center request 
that the integration tool will enable in the Quality Center project, for 
defects, requirements, or both, as specified in step 14 on page 175.

18. Click Next to continue.

The listed fields are added to the Quality Center project, and the Quality 
Center workflow script is updated to support integration with PPM Center.

Prior to version 7.0, PPM Center was known as Mercury IT Governance Center or 
ITG. Field names in Quality Center version 10.00 and in the integration tool in the 
context of Quality Center still use ITG when referring to PPM Center.

If the Quality Center project already contains one or more fields with the same 
names, a dialog box asks you whether you want to change the names of the 
added fields. If you select Yes, the added fields will be given different names. If 
you select No, the procedure to enable the project for integration is aborted.

If the Quality Center project does not have a workflow script in its repository, a 
dialog box asks you whether you want to create a new one. If you select Yes, a 
new script with support for the integration is added to the Quality Center 
repository. If you select No, the script file is not created. 

If the project is not new and its script files have been previously customized, 
select No and manually merge the customized scripts with the scripts that the 
wizard adds automatically, which are located in the installation directory of the 
PPM Center-Quality Center Integration Tool.
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19. Click Finish to complete enabling the project for integration and close the 
wizard.

Creating the Mapping Between PPM Center and Quality Center Fields

After you enable a Quality Center project for the integration, you use the PPM 
Center-Quality Center Integration Tool to map a particular PPM Center 
request type to a Quality Center defect or requirement and to specify the 
desired mapping between the PPM Center fields and the Quality Center fields.

To create the mapping:

1. In the left pane of the PPM Center-Quality Center Integration Tool, expand 
the tree until the child node at the lowest level (defect, requirement, or 
both) is visible.

For information about the provided default mappings, see Default Field Mappings for 
PPM Center and Quality Center Version 10.00 on page 203.
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2. Click the child node you want to map and select Action > Add Mapping (or 
right-click the node you want to map and click Add Mapping).

The Map Fields wizard opens.
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3. Click Next to continue.

4. In the User Name and Password fields, type the user name and password of 
the Quality Center administrator.

5. Click Next to continue.

The PPM Center Request Type field appears with a drop-down list.

6. Click the arrow of the drop-down list to display a list of all the PPM Center 
request types that can be mapped to a Quality Center defect or requirement 
(depending on which you selected in step 2 on page 179).

For information about the default PPM Center request types that are 
available to map to Quality Center defects and requirements, see Using the 
Integration of PPM Center with Quality Center on page 226.
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7. Select the request type in PPM Center that is to be mapped to the Quality 
Center defect or requirement.

8. Click Next to continue.

From the integration tool, the wizard displays the default mapping between 
the Quality Center fields and PPM Center fields for the request type you 
selected. In this Map Fields window, the fields map either a PPM Center 
request type for defects to a Quality Center defect, or a PPM Center request 
type for changes to a Quality Center requirement.
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The Quality Center Field column displays Quality Center field names, 
followed by their DB field names (the names of the columns in the 
database) in parentheses.

The PPM Center Field column displays the PPM Center request field 
names, followed by their tokens in parentheses.

The Override column specifies which field, if any, is the “dominant” field 
for a pair. The Override column can have one of the following values for 
any pair of mapped fields (row):

 QC. In this case, Quality Center is said to be dominant for the mapped 
pair. When the Quality Center entity is created or modified in any way, 
then the integration updates all the mapped PPM Center fields for 
which Quality Center is dominant. 

When Quality Center is dominant for a mapped pair and the value in 
the PPM Center field is changed, the value in the associated Quality 
Center field is not affected. 

When the integration creates a Quality Center entity, the PPM Center 
request fields have no effect on the fields for which Quality Center is 
dominant.
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 PPM. In this case, PPM Center is said to be dominant for the mapped 
pair. When the PPM Center request is created or modified in any way, 
then the integration updates all the mapped Quality Center fields for 
which PPM Center is dominant. 

When PPM Center is dominant for a mapped pair and the value in the 
Quality Center field is changed, the value in the associated PPM Center 
field is not affected. 

When the integration creates a PPM Center request, the Quality Center 
entity fields have no effect on the fields for which PPM Center is 
dominant.

 BIDIRECTIONAL. In this case, both the PPM Center fields and their 
mapped Quality Center fields operate as though they are dominant—
when either the integrated PPM Center request or Quality Center entity 
is created or modified, the integration updates all the associated fields 
in the Quality Center entity or PPM Center request respectively, as 
specified by the mappings. 

9. If you want to change which field, if any, is dominant for a field mapping, 
click the value in the Override column for the field mapping of interest, and 
select another value from the list that appears.

10. If you want to add a pair of fields to the mapping, do the following:

a. Click Add. 

The Add Field window opens.

b. In Quality Center Field and PPM Center Field, select the fields you want 
to map to each other.
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c. Click OK. 

The pair of fields is added to the mapping and appears in the list.

11. If you want to remove a pair of fields from the mapping, do the following:

a. Click a line to select the pair.

b. Click Remove. 

c. When the application asks whether you want to delete the selected line 
or lines, click Yes. 

12. Click Next to continue.

If the mapped fields in a pair have different sets of valid values, you must resolve 
the differences so that a change to one field can update the other. See Resolving 
Lists of Valid Values on page 186.
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13. Click Finish to save the mapping and close the wizard.

The new mapping is displayed in the PPM Center-Quality Center 
Integration Tool. (In the example, expand the defect list.)

14. By default, a local copy of the mapping file (ITGQCIntegration.xml) is 
saved in the Windows directory in which you installed the PPM 
Center-Quality Center Integration Tool. As discussed later, you will use 
the tool to deploy the mapping file to the PPM Server and the Quality 
Center server. Then the integration can operate without any dependency on 
the local Windows machine on which the integration tool is installed. 

If you want to save the XML mapping file elsewhere, select File > Save To 
and specify the location.

If you want to open an XML mapping file stored in another location, click 
File > Open. 

15. Click File > Exit to close the PPM Center-Quality Center Integration Tool.
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Resolving Lists of Valid Values

This section describes how to resolve differences between the sets of valid 
values for a pair of mapped fields, so that a change to one field correctly 
updates the other.

To open the mapping file and access the Map Value Lists window:

1. Open the mapping file as described in Viewing and Changing a Mapping 
on page 198. 

2. Select the row for the pair of fields of interest and click Map Value Lists. 

The Map Value Lists window opens, displaying the lists of valid values for 
each field in the pair.

Resolve the differences between the sets of valid values based on which of the 
following three cases applies.

Case One

If you created a new user-defined field in Quality Center and mapped the field 
to a PPM Center field that has a list of values, create a new Quality Center list 
of valid values from the PPM Center list, as follows:

1. Select the Create a new list in Quality Center... option in the Map Values 
List window.

2. In the List Name field, specify a name for the list or accept the default.

3. Click OK. 

A new Quality Center value list containing the PPM Center values is 
created and associated with the Quality Center field.

Some field pairs are automatically mapped and their mappings cannot be 
changed.
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Case Two

If the fields in the pair have different sets of values and some records in the 
Quality Center project already use the current list of values, but from now on 
you want to use the values that appear in the PPM Center list, add the PPM 
Center values to the Quality Center list, as follows:

1. Select the Add the PPM Center values to the existing Quality Center list 
option in the Map Values List window.

2. Click OK. 

The Quality Center value list now includes the PPM Center values as well 
as the original Quality Center values.

Case Three

If both fields in the pair already have lists of values that you need to map or 
remap, do the following:

1. Select the Map Values option in the Map Values List window.

2. Select a value in the Quality Center list, select the value in the PPM Center 
list to which you want to map it, and click the right-arrow button. 

The pair of mapped values appears in the right pane of the Map Value Lists 
window. For example, if the value representing lowest impact in the 
Quality Center field is Enhancement and the value representing lowest 
impact in the PPM Center field is 1-Low, map the two values as shown in 
the following figure. 
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Between the QC and PPM columns in the right pane, the mapping displays 
one of the following:

 --> if the Override column for the pair of fields is set to QC 

 <-- if the Override column for the pair of fields is set to PPM 

 <--> if the Override column for the pair of fields is set to 
BIDIRECTIONAL 

3. Repeat step 2 for all the values that require mapping. 

 You must map all the values in the Quality Center list if Quality Center 
is dominant for that field pair, as indicated by QC in the Override 
column in the Map Fields window and by --> between the QC and PPM 
columns in the right pane of the Map Value Lists window. 

 Similarly, you must map all the values in the PPM Center list if PPM 
Center is dominant for that field pair, as indicated by PPM in the 
Override column in the Map Fields window and by <-- between the QC 
and PPM columns in the right pane of the Map Value Lists window. 

 You must map all the values in both lists if neither field of the pair is 
dominant, as indicated by BIDIRECTIONAL in the Override column in 
the Map Fields window and by <--> between the QC and PPM columns 
in the right pane of the Map Value Lists window.

If you map two or more values in one list to one value in the other list, you 
must select a check box in the Default column to indicate which mapping 
prevails. 
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Consider the example in the following figure, where the two value lists are 
of different lengths and the mapping is BIDIRECTIONAL. 

In this example, you must do the following:

a. Map two or more values in one list to a single value in the other list. 
Here, both the values 6-Critical and 5-Urgent for the field in Quality 
Center have been mapped to a value of 5-Urgent for the field in PPM 
Center.

b. Select the appropriate Default check box to eliminate ambiguity as to 
which pair will be used to map the values. In this example, if the field 
in PPM Center changes to a value of 5-Urgent, the value of the field in 
Quality Center becomes 6-Critical, based on the selected Default pair of 
values. If the second check box, for which the PPM Center value is also 
5-Urgent, is chosen as the default instead, then if the field in PPM 
Center changes to a value of 5-Urgent, the value of the field in Quality 
Center becomes 5-Urgent. 

4. Click OK. 

The PPM Center values and Quality Center values for the field become 
mapped as you have specified.
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Mapping the Notes Field in PPM Center to an Existing Project

When you enable a new Quality Center project for integration, the integration 
tool attempts to create new fields in the Quality Center project to correspond to 
the Notes to be added on save field for the PPM Center request. When you 
update the content of this field in a PPM Center request, the associated field is 
updated in Quality Center. 

When you enable a new Quality Center project, the new fields are named as 
follows:

 For a defect, the added field in the Defects table is called BG_USER_<XX>, 
for example BG_USER_25. 

 For a requirement, the added field in the Requirements table is called  
RQ_USER_<XX>, for example RQ_USER_26. 

Since the Quality Center fields are memo fields and there can be no more than 
three user-defined memo fields per table, the attempt to map Notes to memo 
fields may fail. If the attempt fails, you cannot use the integration tool to map 
the Notes to be added on save field. Instead, you must add the memo fields to 
the project manually, and edit the XML mapping file by adding one of the 
following to the appropriate mapping file, using the example:

 For defects:

<param name="BUG_ITG_NOTES">BG_USER_25</param>

 For requirements:

<param name="REQ_ITG_NOTES">RQ_USER_26</param>

If you enable an existing project that already includes some user-defined memo fields, 
the added fields may have different names.
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Deploying the Mapping File to PPM Center and Quality Center

After you have completed the mapping, use the PPM Center-Quality Center 
Integration Tool to deploy the XML mapping file (ITGQCIntegration.xml) 
to PPM Center and to Quality Center.

To deploy the XML mapping file to PPM Center and Quality Center:

1. Verify that the PPM Center server.conf parameters are as specified in 
step 2 on page 194. Set the ENABLE_QUALITY_CENTER_INTEGRATION 
parameter to true. 

2. In the main window of the PPM Center-Quality Center Integration Tool, 
select File > Deploy to Centers. 

The Deploy Configuration File to Centers window opens, listing the URLs 
of the PPM Center and Quality Center servers to which the mapping file 
will be deployed.

3. Click Deploy. 

The tool starts the deployment process. If any errors occur during 
deployment, a message is displayed in the window.

At certain times, you might need to manually edit or back up the XML mapping file. 
When you created the XML mapping file, it was stored either in the directory in which 
you installed the integration tool or in another directory that you specified (see step 14 
on page 185). If you do not know where the file is located, check the Windows 
registry. The path in the registry is HKEY_LOCAL_MACHINE\SOFTWARE\
Hewlett-Packard\PPM Center-Quality Center Integration Tool. 

Remember to redeploy the mapping file to both PPM Center and Quality Center.
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4. When the deployment completes, a message indicating that deployment 
completed successfully is added to the Deploy Configuration File to 
Centers window.

5. Click OK to close the window.

On the PPM Server, the mapping file is deployed to the <PPM_Home>/conf 
directory, where <PPM_Home> represents the path where the PPM Center 
instance is installed. 

On the Quality Center server (or servers), the mapping file is deployed to the 
<QC_Home>/repository/sa/DomsInfo/BTO directory, where <QC_Home> 
represents the path where Quality Center is installed.

For information about changing and otherwise maintaining existing mappings, 
see Managing Existing Mappings on page 195.

This completes creating and deploying the mapping file. To configure PPM 
Center for the integration, proceed to Configuring PPM Center for the 
Integration.

In a clustered PPM Center environment, you must manually deploy the 
ITGQCIntegration.xml mapping file to all nodes that do not use a shared  
<PPM_Home>/conf directory. The integration tool cannot deploy the mapping file to 
multiple nodes. 

As needed, copy the mapping file from the <PPM_Home>/conf directory on the 
computer on which the integration tool is installed to a convenient location or device 
(or select File > Save To in the integration tool and specify the location). Then copy 
the file to the <PPM_Home>/conf directory in the other nodes in the cluster.
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Configuring PPM Center for the Integration

Before beginning to configure the integration as described in the following 
sections, make sure that ALM has been installed and initially configured as 
described in Chapter 2, Installing and Setting Up ALM Software, on page 23.

Connecting PPM Server with Quality Center Servers

Make sure that an HTTP port is open between the PPM Server and each 
Quality Center server having projects that are to be integrated. 

Configuring server.conf Parameters in PPM Center

Add (if not present) and specify the parameters related to Quality Center 
integration to the PPM Center server.conf configuration file, as follows:

1. Stop the PPM Server.

For more information about the steps in this procedure, see the Installation and 
Administration Guide. 
Integrating PPM Center with HP Quality Center, Using ALM 193



2. Run the following script: 

sh ./kConfig.sh 

Set the parameters and values as shown in the following table. (All 
parameter names begin with com.kintana.core.server. but that is not 
shown in the table.)

3. Restart the PPM Server.

For information about using the integration, see Using the Integration of PPM 
Center with Quality Center on page 226.

Parameter Value

ENABLE_QUALITY_
CENTER_INTEGRATION

Set this parameter to false if an XML mapping 
file has not been generated and deployed to 
PPM Center and Quality Center.

Set this parameter to true if an XML mapping 
file has been generated and deployed to PPM 
Center and Quality Center, so that integration 
can be enabled. If a mapping file has not been 
deployed and you set this parameter to true, 
the PPM Server will not restart.

This parameter controls whether PPM Center 
attempts to send information to Quality Center. 
(Even if this parameter is set to false, Quality 
Center sends information to PPM Center.)

BASE_URL

(already present in 
server.conf)

The URL of the PPM Server. By default, 
contains the host name of the PPM Server, for 
example, http://ppmhost:8080. 

However, if the PPM Server is installed in a 
WAN, use the IP address of the PPM Server, for 
example, http://192.60.80.01:8080, 
rather than its host name.

ENABLE_QUALITY_
CENTER_METRICS_SYNC

Always set this parameter to false. It does not 
apply to ALM.
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Managing Existing Mappings

After you have configured PPM Center and Quality Center for integration, you 
can use the integration tool to make changes to the configuration.

You can change the configuration for a request type mapping or for an entire 
Quality Center project. When you change a mapping for a project, the changes 
apply to all the request types mapped to the project. For example, if you delete 
the mapping for a project, the mapping for all of the project’s mapped request 
types is also deleted.

As described in the following sections, you can do the following:

 Delete a mapping

 Disable a mapping

 Re-enable a previously disabled mapping

 View and change a mapping

 Enable and disable request hierarchy synchronization 

 Enable and disable email notification on requirement creation

 Enable and disable email notification on requirement update

Remember to redeploy the mapping file to PPM Center and Quality Center after any 
mapping revision described in the following sections. See Deploying the Mapping File 
to PPM Center and Quality Center on page 191.
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Deleting a Mapping

When you delete a mapping, the connection between the associated fields in 
PPM Center and Quality Center is removed, and updating a field in one 
application no longer causes an update in the other. 

To delete a mapping:

1. Right-click the project or request type of interest and select Delete 

Mapping. 

The tool asks whether you want to delete the mapping.

2. Click Yes. 

If you later want the applications to update each other, you will need to create a new 
mapping.
196 Chapter 6



Disabling and Re-Enabling a Mapping

When you disable a mapping, the mapping is not deleted, but creating a request 
in PPM Center does not create a defect or requirement in the Quality Center 
project. In addition, updating a field in one application does not update the 
field to which it is mapped in the other application.

To disable the mapping between a request type and a defect or requirement:

1. Right-click the project or request type of interest and select Disable 

Mapping. 

The tool asks whether you want to disable the mapping.

2. Click Yes. 

To enable a mapping that was previously disabled, right-click the project or 
request type and select Enable Mapping. 
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Viewing and Changing a Mapping

To view a mapping and make changes to the mapping:

1. Right-click the request type of interest and select Mappings. 

The Map Fields window opens.
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2. If the Mapping tab is not already selected, select it to display the mapping.

3. Use this tab to change the mapping in the same way you created the 
original mapping. See Creating the Mapping Between PPM Center and 
Quality Center Fields on page 178.
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Enabling and Disabling Request Hierarchy Synchronization

You can enable or disable the request hierarchy synchronization between a 
PPM Center request and a Quality Center requirement.

To enable the synchronization:

1. Right-click requirement. 

2. If the Synchronize Request Hierarchy option is not selected (has no check 
mark), click it to select the option. 

To disable the synchronization:

1. Right-click requirement. 

2. If the Synchronize Request Hierarchy option is selected (has a check mark), 
click it to clear the option. 

For information about the effect of request hierarchy synchronization, see 
Request Hierarchy Synchronization on page 234.
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Enabling and Disabling Email Notification on Requirement Creation

You can enable or disable sending an automatic email notification when a 
requirement is created by the integration.

To enable the email notification for requirement creation:

1. Right-click requirement. 

2. If the Notify When Created option is not selected (has no check mark), click 
it to select the option. 

To disable the email notification for requirement creation:

1. Right-click requirement. 

2. If the Notify When Created option is selected (has a check mark), click it to 
clear the option. 

To send any notifications, Quality Center must be configured to automatically send 
them, using email addresses established in Quality Center. See Optional PPM Center 
Integrations on page 17 for information about accessing the Quality Center 
documentation.
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Enabling and Disabling Email Notification on Requirement Update

You can enable or disable sending an automatic email notification when a 
requirement is updated by the integration.

To enable the email notification for requirement update:

1. Right-click requirement. 

2. If the Notify When Update option is not selected (has no check mark), click 
it to select the option. 

To disable the email notification for requirement update:

1. Right-click requirement. 

2. If the Notify When Update option is selected (has a check mark), click it to 
clear the option. 

To send any notifications, Quality Center must be configured to automatically send 
them, using email addresses established in Quality Center. See Optional PPM Center 
Integrations on page 17 for information about accessing the Quality Center 
documentation.
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Default Field Mappings for PPM Center and Quality Center Version 10.00 

The following sections apply to integration with Quality Center version 10.00 
only, and they describe the default field mappings that are available for 
integration with Quality Center defects and requirements.

Default Field Mappings for Quality Center Version 10.00 Defects

Table 6-4 describes the default defect mappings that can be modified for the 
integration between the Defects Module in Quality Center and the 
ALM - Defect Template with Quality Center Integration request type in PPM 
Center. The Override column indicates which field is dominant by default—
PPM Center (if set to PPM), Quality Center (if set to QC), or neither (if set to 
BIDIRECTIONAL). For more information, see step 8 on page 181.

This concludes the sections in this chapter that describe configuring integration with 
Quality Center version 10.00. For information about default mappings between PPM 
Center and Quality Center version 10.00, see Default Field Mappings for PPM Center 
and Quality Center Version 10.00. For information about fields added to Quality 
Center version 10.00 for the integration, see Fields the Integration Enables in Quality 
Center Version 10.00 Entities on page 207. 

For information about using the integration (with Quality Center version 10.00 or 
version 11.00), see Using the Integration of PPM Center with Quality Center 
on page 226.

Table 6-4. Default defect mappings you can modify (page 1 of 3)

Quality Center Field Name,
Database ID,
and Field Type

PPM Center Field Name,
Database ID a, 
and Field Type

Override

Reproducible

BG_REPRODUCIBLE

Y/N

Reproducible

REPRODUCIBLE

Y/N

QC

Project

BG_PROJECT

List

Application

APPLICATION_CODE

List

QC
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Actual Fix Time

BG_ACTUAL_FIX_TIME

Date

Actual Fix Time (days)

ACTUAL_FIX_TIME

Date

QC

Closed in Version

BG_CLOSING_VERSION

List

Closed in Version

CLOSING_VERSION

Text (40)

QC

Severity

BG_SEVERITY

Enumeration

Severity

SEVERITY

Drop-down list

BIDIRECTIONAL

Closing Date

BG_CLOSING_DATE

Date

Closed on

CLOSING_DATE

Date

QC

Detected in Version

BG_DETECTION_VERSION

List

Detected in Version

DETECTION_VERSION

Text (40)

BIDIRECTIONAL

Planned Closing Version

BG_PLANNED_CLOSING_VER

List

Planned Closing Version

PLANNED_CLOSING_VER

List

BIDIRECTIONAL

Estimated Fix Time

BG_ESTIMATED_FIX_TIME

Number

Estimated Fix Time (days)

ESTIMATED_FIX_TIME

Numeric Text (10 digits)

BIDIRECTIONAL

Comments

BG_DEV_COMMENTS

Memo

Developer Comments

DEV_COMMENTS

Text (1800)

PPM

Detected on Date

BG_DETECTION_DATE

Date

Created On

CREATION_DATE

Date

PPM

Table 6-4. Default defect mappings you can modify (page 2 of 3)

Quality Center Field Name,
Database ID,
and Field Type

PPM Center Field Name,
Database ID a, 
and Field Type

Override
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Priority

BG_PRIORITY

Enumeration

Priority

DEFECT_PRIORITY_CODE

Drop-down list

BIDIRECTIONAL

Description

BG_DESCRIPTION

Memo

Detailed Description

DEFECT_DESCRIPTION

Text (1800)

BIDIRECTIONAL

Detected By

BG_DETECTED_BY

Quality Center users list

Detected in Quality Center by

QC_DETECTED_BY

Text (40)

QC

Status b, c

BG_STATUS

Enumeration

Request Status b

STATUS_ID

List

PPM b

Quality Center Defect Status c

KNTA_QC_DEFECT_STATUS

Text (300)

QC c

Summary

BG_SUMMARY

Text (255)

Summary

DESCRIPTION

Text (200)

BIDIRECTIONAL 

a. The listed PPM Center database IDs are the same as in the PPM Workbench. The exact database IDs 
are displayed by the integration tool.

b. When the Request Status field is updated in PPM Center, the new status is sent to Quality Center. If the 
new status matches one of the defect statuses in Quality Center, the Status field in Quality Center is 
updated; if not, the update is ignored by Quality Center. 

c. When the status of a defect is updated in Quality Center, the associated Quality Center Defect Status 
field in PPM Center is updated accordingly if the value sent by Quality Center is a valid workflow step 
transition in PPM Center.

Table 6-4. Default defect mappings you can modify (page 3 of 3)

Quality Center Field Name,
Database ID,
and Field Type

PPM Center Field Name,
Database ID a, 
and Field Type

Override
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Default Field Mappings for Quality Center Version 10.00 Requirements

Table 6-5 describes the default requirement mappings that can be modified for 
the integration between the Requirements Module in Quality Center and the 
ALM - Request for Change (RFC) request type or the ALM - Release 
Management request type in PPM Center. The Override column indicates 
which field is dominant by default—PPM Center (if set to PPM), Quality 
Center (if set to QC), or neither (if set to BIDIRECTIONAL). For more 
information, see step 8 on page 181.

Table 6-5. Default requirement mappings you can modify (page 1 of 2)

Quality Center Field Name,
Database ID, 
and Field Type

PPM Center Field Name,
Database ID a, 
and Field Type

Override

Priority

RQ_REQ_PRIORITY

Enumeration 

RFC Priority

PRIORITY_CODE

Drop-down list 

PPM

Author b

RQ_REQ_AUTHOR

User list 

Created By

CREATED_BY

User list 

PPM

ITG Request Status c, d

RQ_USER_XX e

Enumeration 

RFC Status c

STATUS_ID

List 

PPM c

Quality Center Status d

KNTA_QC_REQUIREMENT_STATUS

Text (300) 

QC d

Name

RQ_REQ_NAME

Text (255) 

RFC Summary

DESCRIPTION

Text (200)

PPM

ITG Request Description

RQ_USER_XX e

Memo

RFC Description

RFC_DESCRIPTION

Text (1800)

PPM
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Fields the Integration Enables in Quality Center Version 10.00 Entities 

The following sections apply to integration with Quality Center version 10.00 
only. They describe the initially disabled fields in Quality Center defects and 
requirements that the PPM Center-Quality Center Integration Tool enables to 
support the integration with PPM Center request types.

The integration automatically populates these Quality Center defect or 
requirement fields from data in PPM Center. These are not mappings you 
establish between fields in PPM Center and Quality Center. The integration 
updates some Quality Center fields on an ongoing basis as indicated.

In addition, the Attachments tab in Quality Center lists URLs for all of the 
attachments to the PPM Center request. Clicking one of the links opens the 
PPM Center request (after login).

Assigned To

RQ_USER_XX e

User list

Quality Center Assigned To User 

KNTA_QC_ASSIGNED_TO
PPM

a. The listed PPM Center database IDs are the same as in the PPM Workbench. The exact database IDs 
are displayed by the integration tool.

b. The Author field in Quality Center displays the name of the user who created the request in PPM Center. 
Quality Center can accept any name, but PPM Center cannot. If you configure this field to be 
bidirectionally updateable and a user selects a user name in Quality Center that does not exist in PPM 
Center, the operation will fail. User name lists must therefore be synchronized. 

c. When the RFC Status field is updated in PPM Center, the new status is sent to Quality Center. If the new 
status matches one of the requirement statuses in Quality Center, the ITG Request Status field in Quality 
Center is updated; if not, the update is ignored by Quality Center. 

d. When the status of a requirement is updated in Quality Center, the associated Quality Center Status field 
in PPM Center is updated accordingly if the value sent by Quality Center is a valid workflow step transition 
in PPM Center.

e. The Quality Center fields with the database ID of RQ_USER_XX are user fields that are added to Quality 
Center when using the integration tool to enable a project. The value of XX is determined when the user 
field is added to Quality Center.

Table 6-5. Default requirement mappings you can modify (page 2 of 2)

Quality Center Field Name,
Database ID, 
and Field Type

PPM Center Field Name,
Database ID a, 
and Field Type

Override
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Fields the Integration Enables in Quality Center Version 10.00 Defects

Table 6-6 describes the fields that the PPM Center-Quality Center Integration 
Tool enables in Quality Center defects when the project is enabled (in step 17 
on page 176), and their PPM Center data source. These fields should not be 
modified (except for their Labels, as desired).

Fields the Integration Enables in Quality Center Version 10.00 Requirements

Table 6-7 describes the fields that the PPM Center-Quality Center Integration 
Tool enables in Quality Center requirements when the project is enabled (in 
step 17 on page 176), to support integration, and their PPM Center data source. 
These fields should not be modified (except for their Labels, as desired).

Table 6-6. Fields the integration enables in Quality Center version 10.00 defects

PPM Center 
Data Source

Quality Center 
Field Name

Quality Center 
Field Database ID

Quality 
Center 
Field Type

Description

PPM Server 
base URL

ITG Server BG_USER_XX a Text (120)
User field containing PPM Center 
URL.

Name of 
integrated 
request type

ITG Request Type BG_USER_XX a Text (40)

User field containing the PPM 
Center request type of the 
associated PPM Center request. 
Used for field mapping.

Notes 
(formatted)

ITG Notes b BG_USER_XX a Memo

Quality Center memo field. 
Stores PPM Center notes. 
Always overridden by PPM 
Center. Added to Quality Center 
if the user chooses to 
synchronize the Notes field.

Request ID ITG Request Id BG_REQUEST_ID Integer
System field containing PPM 
Center request ID.

a. The Quality Center fields with the database ID of BG_USER_XX are user fields that are added to Quality Center when using 
the integration tool to enable a project. The value of XX is determined when the user field is added to Quality Center.

b. Updated on an ongoing basis.
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Table 6-7. Fields the integration enables in Quality Center version 10.00 requirements

PPM Center 
Data Source

Quality Center 
Field Name

Quality Center 
Field Database ID

Quality 
Center 
Field Type

Description

PPM Server 
base URL

ITG Server RQ_USER_XX a Text (120)
User field containing the PPM 
Center URL.

Name of 
integrated 
request type

ITG Request Type RQ_USER_XX a Text (40)

User field containing the PPM 
Center request type of the 
associated PPM Center 
request. Used for field mapping.

Notes 
(formatted)

ITG Notes b RQ_USER_XX a Memo

Quality Center memo field. 
Stores PPM Center notes. 
Always overridden by PPM 
Center. Added to Quality Center 
if the user chooses to 
synchronize the Notes field.

Request ID ITG Request Id RQ_REQUEST_ID Integer
System field containing PPM 
Center request ID.

PPM request 
status

ITG Request 
Status b RQ_USER_XX a Text (40)

Status of the PPM Center 
request.

“Updated by 
PPM at 
<timestamp>” 
(translated as 
needed)

ITG Updates b RQ_USER_XX a Text (120)
User field that shows integration 
message for success or error in 
most recent operation.

PPM Server 
base URL

ITG Request 
Description

RQ_USER_XX a Memo
Description of the PPM Center 
request.

a. The Quality Center fields with the database ID of RQ_USER_XX are user fields that are added to Quality Center when using 
the integration tool to enable a project. The value of XX is determined when the user field is added to Quality Center.

b. Updated on an ongoing basis.

This concludes the sections in this chapter that describe integration with Quality 
Center version 10.00. For information about using the integration (with Quality Center 
version 10.00 or version 11.00), see Using the Integration of PPM Center with Quality 
Center on page 226.
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Configuring Integration with Quality Center Version 11.00

The procedures in this section apply to integrating PPM Center with Quality 
Center version 11.00 only. If you are integrating PPM Center with Quality 
Center version 10.00, go to Selecting the Appropriate Integration Procedure 
on page 165. 

For important information about integrating PPM Center request types with 
defects and requirements on multiple Quality Center servers, where some 
Quality Center servers can be at version 10.00 and others can be at version 
11.00, see Selecting the Appropriate Integration Procedure on page 165.

Before proceeding, verify that Quality Center version 11.00 is installed and 
running on the Quality Center server to be integrated.

Overview of Installation and Configuration Process

The procedures for configuring integration of PPM Center and Quality Center 
version 11.00 require the Configuration license and are performed almost 
entirely by using the PPM Center standard interface. They are described in 
detail in the following sections and are summarized as follows:

 Verify that the PPM Server is running and that each Quality Center server 
to be integrated is running version 11.00. 

 In Quality Center, enable fields related to PPM Center as needed.

The PPM Center-Quality Center Integration Tool must be used only for integration 
with Quality Center version 10.00. It cannot detect integrations that were previously 
established with Quality Center version 11.00 instances, and any existing integration 
with a version 11.00 instance prevails if you try to use the integration tool for that 
integration. If the PPM Center-Quality Center Integration Tool was previously 
installed, do not try to use it to configure integration with Quality Center version 11.00.

If PPM Center is at version 9.10 and you upgrade a Quality Center instance from 
version 10.00 to version 11.00, existing integrations of PPM Center requests and 
Quality Center entities (defects or requirements) on that instance will not be upgraded. 
If the integrations are reestablished, they will operate as new integrations. 

In configuring a Quality Center version 11.00 integration, make sure you establish a 
one-to-one, unique mapping between each integrated PPM Center request type and 
its associated Quality Center entity (defect or requirement). 
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 Modify value lists in Quality Center to support the integration with PPM 
Center requests, as needed.

 Based on the eligible request type you select in PPM Center, configure the 
integration details, including:

o Field mappings between PPM Center fields and Quality Center fields, 
including value mappings

o Email notification options for errors and creation or update of entities.

o Whether creating a PPM Center request creates a Quality Center entity 
(defect or requirement), or creating a Quality Center entity creates a 
PPM Center request 

o If you are integrating a PPM Center request type with a Quality Center 
requirement:

 Default folder in Quality Center for new requirements

 Whether the requirement hierarchy in Quality Center is to be 
synchronized with (driven by) the request hierarchy in PPM Center

Verify the PPM Server and Quality Center Servers Are Running

Verify that the PPM Server is running and that each Quality Center server with 
projects to be integrated is running.

Enable PPM Center-Related Fields in Quality Center

The following sections apply to integration with Quality Center version 11.00 
only. They describe the initially disabled fields in Quality Center defects and 
requirements that you may need to enable to support the integration with PPM 
Center request types. Fields in Quality Center that are related to PPM Center 
are not initially enabled. 

The integration automatically populates these Quality Center defect or 
requirement fields from data in PPM Center. These are not mappings you 
establish between fields in PPM Center and Quality Center. The integration 
updates some Quality Center fields on an ongoing basis as indicated.
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In addition, the Attachments tab in Quality Center lists URLs for all of the 
attachments to the PPM Center request. Clicking one of the links opens the 
PPM Center request (after login).

Fields Associated with the Integration in Quality Center Version 11.00 Defects 

Table 6-8 describes the fields in Quality Center defects that you may need to 
enable for the integration, and their PPM Center data source. These fields 
should not be modified (except for their Labels, as desired).

Table 6-8. Fields you may need to enable in Quality Center version 11.00 defects

PPM Center 
Data Source

Quality Center 
Field Name

Quality Center 
Field Database ID

Quality 
Center 
Field Type

Description

PPM Server 
base URL

PPM Server URL BG_REQUEST_SERVER Text (120) PPM Center URL.

Name of 
integrated 
request type

PPM Request Type BG_REQUEST_TYPE Text (120)

PPM Center request 
type of the associated 
PPM Center request. 
Used for field mapping.

Notes 
(formatted)

PPM Request Note a BG_REQUEST_NOTE Memo

Quality Center memo 
field. Stores PPM 
Center notes. Always 
overridden by PPM 
Center. Added to 
Quality Center if the 
user chooses to 
synchronize the Notes 
field.

Request ID PPM Request Id BG_REQUEST_ID Integer
System field containing 
PPM Center request ID.

a. Updated on an ongoing basis
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Fields Associated with the Integration in Quality Center Version 11.00 Requirements

Table 6-9 describes the fields in Quality Center requirements that you may 
need to enable for the integration, and their PPM Center data source. These 
fields should not be modified (except for their Labels, as desired).

Table 6-9. Fields you may need to enable in Quality Center version 11.00 requirements

PPM Center 
Data Source

Quality Center 
Field Name 

Quality Center Field 
Database ID

Quality 
Center 
Field Type

Description

PPM Server 
base URL

PPM Server URL RQ_REQUEST_SERVER Text (120) PPM Center URL.

Name of 
integrated 
request type

PPM Request Type RQ_REQUEST_TYPE Text (120)

PPM Center 
request type of the 
associated PPM 
Center request. 
Used for field 
mapping.

Notes 
(formatted)

PPM Request Note a RQ_REQUEST_NOTE Memo

Quality Center 
memo field. Stores 
PPM Center notes. 
Always overridden 
by PPM Center. 
Added to Quality 
Center if the user 
chooses to 
synchronize the 
Notes field.

Request ID PPM Request Id RQ_REQUEST_ID Integer
System field 
containing PPM 
Center request ID.

PPM request 
status

PPM Request Status a RQ_REQUEST_STATUS
Lookup 
List

Status of the PPM 
Center request.

“Updated by 
PPM at 
<timestamp>” 
(translated as 
needed)

PPM Synchronization 
Data a RQ_REQUEST_UPDATES Text (120)

Integration 
message for 
success or error in 
most recent 
operation.

a. Updated on an ongoing basis
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Modifying Value Lists in Quality Center

As needed, create or modify the value lists in Quality Center defects and 
requirements to support the integration with PPM Center requests. See 
Optional PPM Center Integrations on page 17 for information about accessing 
the Quality Center documentation.

The following configuration procedures include configuring value mappings 
when both fields in a field mapping are value lists.

Configuring the Integration

To integrate a PPM Center request type with a Quality Center (QC) version 
11.00 entity:

1. Log on to PPM Center.

2. From the menu bar, select 
Open > Administration > Integration > Quality Center. 

The QC Integration screen opens.

The screen lists all the PPM Center request types that are “eligible,” that is, 
the request types that are already integrated or can be integrated with 
Quality Center defects or requirements. A request type is eligible if it 
includes the Quality Center Defect Information field group (for defects) or 
the Quality Center Info field group (for requirements).

For integration with Quality Center version 11.00 (shown as QC 11 in the 
QC Version column), the eligible request types have links you can click to 
configure their integrations. 
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Request types that are integrated with Quality Center version 10.00 (shown 
as QC 10 in the QC Version column) are read only, with no links for 
configuration in the standard interface—those request types must be 
configured using the PPM Center-Quality Center Integration Tool, which 
works only with Quality Center version 10.00 (see Selecting the 
Appropriate Integration Procedure on page 165).

The status for each request type on the QC Integration screen is one of the 
following:

 Deployed. The integration of the request type and Quality Center entity 
(defect or requirement) is enabled and operable.

 Not Deployed. The integration of the request type and Quality Center 
entity has been configured at least partially, but the integration is not 
operable.

 Integration Disabled. The integration of the request type and Quality 
Center entity is disabled.

The Quality Center data displayed for each request type also includes the 
URL of the Quality Center server and the Quality Center version, domain, 
project, and entity type (defect or requirement).
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3. For a Quality Center version 11.00 integration, in the Request Type column 
click the eligible request type you want to configure.

The Configure QC Integration for Request Type page opens. In this 
example, the selected request type has not been configured and the 
Integration Disabled option, the initial default, remains selected.

In this case, the selected request type, PPM_Defect Type 2, includes the 
Quality Center Defect Information field group, so it will be associated with 
a Quality Center defect, as indicated in the Entity Type field. 

If the request type includes the Quality Center Info field group instead, the 
request type is associated with a Quality Center requirement, as indicated 
in the Entity Type field. In this case, the Integration Options are different, as 
described later. 

If the request type includes both the Quality Center Defect Information 
field group and the Quality Center Info field group, you will select whether 
a Quality Center defect or requirement will be the associated Entity Type. 
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4. Select the Integration Enabled option.

5. Complete the fields described in the following table.

At any step in this procedure:

 Click Save to save the configuration established thus far. If the integration for 
the request type was previously deployed, it remains deployed.

 Click Save & Deploy to both save the configuration and make the integration 
active (Deployed) for the request type. 

 If the integration for the request type has been previously deployed, click 
Save & Undeploy to both save the configuration and make the integration 
inactive.

Field Name 
(*Required) Description

Deployment Status
(Read only) Status of the integration of this request 
type.

*QC Server URL

URL of the Quality Center server, in the format:
http://<QC Server Host>:<Port>/qcbin/ 
(HTTPS is supported. Use https in the URL as 
needed.)

*QC Username Username used to access Quality Center.

*Password Password for the QC Username.

*QC Server Time Zone

Time zone of the Quality Center server. Required to 
ensure that the integration correctly manages updates 
between fields mapped as bidirectional between PPM 
Center requests and associated Quality Center 
defects or requirements. Default is the time zone of 
the PPM Server.

*Domain
Domain on the Quality Center server to use for the 
integration. To retrieve the set of domains, click Get 
Domains. 

*Project
Project to use for the integration. (List is populated 
when Domain is selected.)
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*Entity Type

Quality Center entity type to be used for integration—
Defect or Requirement. Available option(s) depend 
on whether the Quality Center Defect Information field 
group (for defects) or the Quality Center Info field 
group (for requirements) or both field groups are 
configured in the request header type for the request 
type. If only one of the field groups is configured in the 
request header type, this field is read only.

Field Mapping

Separate lists of unmapped QC Entity Fields and 
PPM Request Fields, followed by a table of the 
previously configured Current Field Mappings. See 
Configuring Field Mappings.

Notification Options

Options for email notification when integration errors 
occur, and when integration creates or updates 
entities. See Configuring Email Notification Options 
on page 223.

Integration Options
Options that change based on whether the request 
type is integrated with a defect or a requirement. See 
Configuring Integration Options on page 223.

Field Name 
(*Required) Description
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Configuring Field Mappings

The Field Mapping section of the Configure QC Integration for Request Type 
page displays a drop-down list of the unmapped QC Entity Fields, a drop-down 
list of the unmapped PPM Request Fields, and the Current Field Mappings table. 
Following is an example of an integration that has some field mappings 
configured.

In the Current Field Mappings table:

 The QC Field column displays Quality Center field names, followed by 
their DB field names (the names of the columns in the database) in 
parentheses.

 The PPM Field column displays the PPM Center request field names that 
are mapped to (that is, associated with) the QC fields, followed by their 
tokens in parentheses.
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 The Control column specifies which field in the mapped field pair controls 
the other, or that a change to either field changes the other. (Quality Center 
version 10.00 refers to the controlling field as the dominant field.) The 
Control column can have one of the following values and meanings for any 
pair of mapped fields (row):

o QC. The Quality Center entity field controls the mapped PPM Center 
request field. When the Quality Center entity is created or modified in 
any way, then the integration updates all the mapped PPM Center 
request fields that are controlled by Quality Center.

When Quality Center controls a mapped pair and the value in the PPM 
Center field is changed, the value in the associated Quality Center field 
is not affected. 

When the integration creates a Quality Center entity, the PPM Center 
request fields have no effect on the fields controlled by Quality Center.

o PPM. The PPM Center request field controls the mapped Quality Center 
entity field. When the PPM Center request is created or modified in any 
way, then the integration updates all the mapped Quality Center entity 
fields that are controlled by PPM Center.

When PPM Center controls a mapped pair and the value in the Quality 
Center field is changed, the value in the associated PPM Center field is 
not affected. 

When the integration creates a PPM Center request, the Quality Center 
entity fields have no effect on the fields controlled by PPM Center.

o Bidirectional. In effect, both the PPM Center fields and their mapped 
Quality Center fields operate as if they are in control—when either the 
integrated PPM Center request or Quality Center entity is created or 
modified, the integration updates all the associated fields in the Quality 
Center entity or PPM Center request respectively, as specified by the 
mappings. 
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To create a new field mapping:

1. From the QC Entity Fields drop-down list, select the QC entity field that 
you want to map to a PPM request field. 

Each QC entity field that you must map to a PPM request field is indicated 
by an asterisk (*) to the right of the field name in the QC Entity Fields list. 

2. From the PPM Request Fields drop-down list, select the PPM request field 
that you want to map to the QC entity field you selected. 

3. Click Map Fields. 

The field pair is added to the Current Field Mappings table.

4. Repeat this procedure for all the QC entity fields that must be mapped and 
for other pairs of fields you want to map.

To configure or modify a field mapping:

 If you want to change which field, if any, controls a current field mapping 
(row), change the value in the Control column for that field mapping. 

 If you want to remove a pair of fields from the mapping, click the Delete 
icon in the row of the field pair you want to delete.

 If both fields in the mapping are lists of values and you want to map the 
values, see Configuring Value Mappings.

Configuring Value Mappings

When both fields in a field mapping are lists of values, the Map Values button 
appears to the right of the row in the Current Field Mappings table. In this case, 
to map the values of one field to the values of the other field:

1. Click Map Values. 

The Map Values window opens. In the example, some QC Values and PPM 

Values have been mapped and others have not.
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2. Select a value from the QC Values column and a value from the PPM Values 
column. Then select an enabled <=, =>, or <=> button between the columns 
to specify the direction of the value mapping.

The integration does not allow you to configure invalid value mappings. 
For example, if the field mapping specified in the Control column is QC or 
PPM, not Bidirectional, then only the corresponding direction for value 
mapping is available.

If the field mapping specified in the Control column is PPM, you can use 
the (All unmapped PPM Values) option to map all the remaining unmapped 
PPM Values to one of the QC Values. Conversely, if the field mapping 
specified in the Control column is QC, you can use the (All unmapped QC 

Values) option to map all the remaining unmapped QC Values to one of the 
PPM Values. 

If the field mapping specified in the Control column is Bidirectional, you 
can map either all the remaining PPM Values to one of the QC Values or all 
the remaining QC Values to one of the PPM Values. 

Make sure that the mapping you specify will not result in invalid values in 
terms of PPM Center or Quality Center processes.

3. Click OK. 
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Configuring Email Notification Options

In Notification Options, you can optionally send emails to addresses you 
specify when integration errors occur, either as they occur or as a daily 
consolidation. 

Separately, you can optionally send emails to addresses you specify when the 
integration creates or updates entities, either as these changes occur or as a 
daily consolidation. 

Event logs provide the same information as email notifications. See Viewing 
Event Logs (Quality Center Version 11.00 Only) on page 225.

Configuring Integration Options

The Integration Options are different for a PPM Center request that is 
integrated with a Quality Center defect than for a request that is integrated with 
a PPM Center requirement, as described in the following sections.

Integration with a Quality Center Defect

For an integrated PPM Center request type and Quality Center defect, in the 
Integration Options, select one of the following options as needed:

 Creating a PPM Center request automatically creates an associated QC 

entity. Selecting this option causes the following:

o Creating or updating a request in PPM Center creates or updates the 
associated entity in Quality Center. Previously configured field 
mappings and value mappings, if controlled by PPM or bidirectional, 
apply to the entity in Quality Center.

o Creating the PPM Center request automatically populates the request 
fields related to Quality Center. 

o If a Quality Center user deletes the entity, the integration re-creates the 
entity in Quality Center.

o If a PPM Center user deletes the request, the association with the entity 
in Quality Center is removed but the entity is not deleted. 
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 Creating a QC entity automatically creates an associated PPM Center 

request. Selecting this option causes the following:

o Creating or updating a defect in Quality Center creates or updates the 
associated request in PPM Center. Previously configured field 
mappings and value mappings, if controlled by QC or bidirectional, 
apply to the request in PPM Center.

o If a PPM Center user deletes the request, the integration re-creates the 
request in PPM Center.

o If a Quality Center user deletes the defect, the association with the 
request in PPM Center is removed but the request is not deleted. 

Integration with a Quality Center Requirement

For integration with a Quality Center requirement, the Integration Options at 
the bottom of the Configure QC Integration for Request Type page are 
different than for integration with a Quality Center defect.

To configure the Integration Options for an integrated PPM Center request type 
and Quality Center requirement: 

1. Complete the Default QC Folder Name field for the Quality Center 
requirements associated with the PPM Center requests.

If request hierarchy synchronization is not enabled for a request type (see 
step 2), all new requirements that the integration creates when users create 
requests will be placed in the Quality Center folder you specify in this 
field. 

2. Specify the Make QC requirement hierarchy match PPM request hierarchy 
option for this request type. This option is also known as request hierarchy 
synchronization.

For information about the effect of request hierarchy synchronization, see 
Request Hierarchy Synchronization on page 234.
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This concludes the configuration procedure for integrating one PPM Center 
request type with one Quality Center defect or requirement. Remember to click 
Save to save the configuration or click Save & Deploy to both save the 
configuration and make the integration active (Deployed) for the request type. 

As needed, configure integration for other eligible request types, starting at 
step 2 on page 214.

Viewing Event Logs (Quality Center Version 11.00 Only)

For integration with Quality Center version 11.00, an event log, including error 
information, is maintained in PPM Center. The QC Integration page in PPM 
Center has a link named View Log for each request type (row) that has a 
deployed integration. If you click one of these links, you can search the log for 
all the events that are logged for that request type or for only their error events, 
over the date range you specify. 

The information provided in the search results includes the following:

 Nature of the event, that is, whether a PPM Center request, Quality Center 
defect, or Quality Center requirement was created or updated

 Date and time of the event

 Whether or not the event was an error

 Other details

Email notifications, when enabled, provide the same information as event logs. 
See Configuring Email Notification Options on page 223.

This concludes the sections in this chapter that describe configuring integration with 
Quality Center version 11.00. For information about using the integration (with Quality 
Center version 10.00 or version 11.00), see Using the Integration of PPM Center with 
Quality Center.
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Using the Integration of PPM Center with Quality Center

As necessary, you use the provided ALM request types and workflows as 
templates to create your own PPM Center request types and workflows 
enabled for integration of PPM Center with Quality Center.

As provided by HP, the only PPM Center request type with a request header 
type that includes the Quality Center Defect Information field group, and thus 
the only request type that is available to map to a Quality Center defect is the 
ALM - Defect Template with Quality Center Integration request type.

As provided by HP, the only PPM Center request types with a request header 
type that includes the Quality Center Info field group, and thus the only request 
types that are available to map to a Quality Center requirement, are the 
following:

 ALM - Release Management

 ALM - Request for Change (RFC)

This section describes how the request types and workflows provided in ALM 
support integration of PPM Center with Quality Center, and this section 
provides guidelines for modifying those request types and workflows.

Steps in PPM Center Workflows that Involve Integration with Quality Center

Several workflows and subworkflows provided in ALM software have steps 
that are related to the integration of PPM Center with Quality Center, as 
follows:

 The ALM - Defect Template with Quality Center Integration workflow 
generates a defect or requirement in Quality Center as soon as a request of 
the associated type is created. See ALM - Defect Template with Quality 
Center Integration Workflow on page 161.
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 The ALM - Request For Change workflow (see ALM - Request For 
Change Workflow on page 41) calls the following subworkflows at the 
indicated steps:

o At step 17, the ALM - Request For Change workflow calls the Plan 
Tests Sub WF (see ALM - Plan Tests Sub WF Subworkflow 
on page 52).

In this subworkflow, step 1, Quality Process Mode, determines whether 
the test planning will be done manually or using integration of PPM 
Center with Quality Center. If integration is to be used, the following 
additional subworkflow steps relate to the integration:

 Step 4, Quality Process Entry

 Step 5, Generate Requirement in Quality Center

 Step 6. Quality Center Failure

 Step 7, Quality Center Requirements Setup

 Step 8, Quality Center Test Plan Setup

 Step 9, Quality Center Test Lab Setup

o At step 22, the ALM - Request For Change workflow calls the Deploy 
and Test Changes Sub WF (see ALM - Deploy and Test Changes 
Sub WF Subworkflow on page 54).

In this subworkflow, step 3, Quality Process Mode, determines whether 
the testing will be done manually or using integration of PPM Center 
with Quality Center. If integration is to be used, the following 
additional subworkflow step relates to the integration:

 Step 5, Quality Center Test Execution

 The ALM - Release Request workflow (see ALM - Release Request 
Workflow on page 74), includes the following steps that relate to 
integration of PPM Center with Quality Center for the release management 
process:

o Step 3, Integrate with Quality Center?

o Step 4, Quality Process Entry

o Step 5, Create Release Requirement in Quality Center

o Step 6, Quality Center Failure
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Configuring Request Types and Workflows for the Integration

This section provides guidelines on how to build request types and workflows 
that support the integration of PPM Center with Quality Center.

To enable integration between PPM Center requests and Quality Center 
projects, you must ensure that the request types and projects have the necessary 
matching fields and that the workflows use steps that support integration. 

ALM provides request types and workflows that use Quality Center 
capabilities, and the workflows include the required steps. You can create 
integration-enabled request types and workflows in any of the following ways:

 By using the PPM Workbench to copy the provided ALM request types 
and workflows, which already contain the request type fields and workflow 
special commands required for integration, and changing the copies as 
needed. This is often the easiest approach.

 By creating new request types and workflows that incorporate the fields 
and special commands required for integration. 

 By customizing your existing PPM Center request types and workflows by 
adding the fields and special commands required for integration. 

After you configure the required request types and workflows, you map the 
PPM Center fields and their valid values to the Quality Center fields and their 
valid values.

For detailed information about configuring request types and workflows, see 
the HP Demand Management Configuration Guide as necessary.

Configuring Request Types

The guidelines to configure a request type for integration are as follows:

 Make sure the request header type for the request type to be associated with 
a Quality Center defect includes the Quality Center Defect Information 
field group. Only request types with this field group can be mapped to 
Quality Center defects. 
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Make sure the request header type for the request type to be associated with 
a Quality Center requirement includes the Quality Center Info field group. 
Only request types with this field group can be mapped to Quality Center 
requirements.

See Request Header Types on page 159.

 Decide which request type to map to each Quality Center project, then 
make sure that the request type and project have the required mapping of 
associated fields.

 Make sure that each pair of mapped fields includes the required valid 
values. For example, if a Quality Center field contains a lookup list, make 
sure that the associated field in the PPM Center request accepts the mapped 
values. If you update a field in one application with a value that does not 
have a valid mapped value in the other application, the field in that other 
application will not be updated. 

For details when integrating with Quality Center version 10.00, see 
Resolving Lists of Valid Values on page 186.

By default, the Quality Center Defect Information field group is included in only the 
ALM - Defect Template with Quality Center Integration request header type.

By default, the Quality Center Info field group is included in only the 
ALM - Request for Change (RFC) request header type and the ALM - Release 
Management request header type.

Quality Center workflows can limit the changes a user can make to a field. For 
example, a script might specify that at a certain point in the Quality Center 
workflow, the user cannot change the status from Open to Closed.

For integration with Quality Center with a valid field mapping, if a PPM Center field 
is updated, the associated Quality Center field is updated even if a Quality Center 
workflow script specifies the update as invalid.
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Configuring Workflows

The guidelines to configure a workflow for integration are as follows (refer to 
the HP Demand Management Configuration Guide for details as necessary):

 Make sure the workflow includes execution steps and decision steps that 
enable the integration of PPM Center with Quality Center. The workflows 
provided by ALM include such steps. 

 If you need to customize a workflow to create a defect or a requirement, 
HP recommends using the execution steps that are included in the 
ALM - Defect Template with Quality Center Integration workflow, instead 
of building the steps yourself. To create defects or requirements in Quality 
Center, your workflow must include one of the following execution steps 
that uses the stated special command:

o To create defects, the ALM - Create QC Defect execution step with the 
ksc_create_defect_in_QC special command

o To create requirements, the ALM - Create QC Requirement execution 
step with the ksc_create_requirement_in_QC special command

In the Properties tab of the workflow execution step, specify a value in the 
Request Status field that is valid for Quality Center, for example, 
1-Requirements Setup Completed when creating a requirement.

Once an execution step has created a requirement or defect in Quality 
Center, then every time the PPM Center request status changes, the Quality 
Center requirement or defect status also changes if the same PPM Center 
status exists for the Quality Center requirement or defect. For example, if 
the PPM Center request status changes to Open, the Quality Center 
requirement or defect status will also change to Open, as long as Open is 
one of the values allowed in the status field of the requirement or defect.

For more information about configuring workflow steps, see the  
HP Demand Management Configuration Guide. 

A PPM Center decision step that depends on Quality Center (that is, a PPM 
Center request that is supposed to be updated by a Quality Center status change) 
can have its status changed in Quality Center only by a user who has 
Administrator rights.
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 When a PPM Center request is integrated with a Quality Center project, 
you can use a change in the Quality Center status to cause the PPM Center 
request to advance through an active decision step to the next step in the 
associated PPM Center workflow. For example, when the QA manager sets 
the status of a Quality Center project to indicate that test planning is 
complete, the associated request in PPM Center can automatically advance 
from the step in the PPM Center workflow that is awaiting that notification.

Conversely, whenever the status of a PPM Center request changes, PPM 
Center notifies Quality Center, and (assuming the new status is valid in 
Quality Center) Quality Center users can take appropriate action such as 
starting tests.

To enable this functionality, you must design the workflow decision steps 
such that the following three items have the same values:

o Quality Center status that will trigger the advancement in the PPM 
Center workflow.

o Transition name (which is specified as the Meaning field of the 
validation value for the workflow step source) for the active decision 
step in the PPM Center workflow.

HP recommends that you give the Meaning field of the transition a 
value that is unique to this transition, that is, a value that does not exist 
anywhere else in the workflow. When this value becomes assigned to 
the ITG Status field in Quality Center version 10.00 or the PPM Status 
field in Quality Center version 11.00, the PPM Center workflow 
advances if the value matches a valid transition in an active workflow 
step. If the workflow has more than one active step and the Meaning is 
not unique, the workflow could advance to an unintended step.

After Quality Center sends an update to PPM Center, Quality Center waits for a 
response, and the Quality Center record remains locked until Quality Center 
receives the response. Meanwhile, if PPM Center advances to the next workflow 
step and attempts, for example, to update (synchronize) Quality Center with a 
new request status, Quality Center rejects the update since the record is locked.

Therefore, a PPM Center workflow should not contain successive steps such that 
the first causes a PPM Center request to advance based on a change in Quality 
Center status, and the second causes PPM Center to attempt to update Quality 
Center. Make sure there is an intervening step between two such steps.
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o Request Status field in the destination step in the PPM Center 
workflow.

If the Quality Center status does not appear in the list of valid request status 
values in PPM Center, PPM Center sends an error message to Quality 
Center, the Quality Center status reverts to its previous value, and the PPM 
Center workflow does not advance.

For example, in the following portion of the ALM - Plan Tests Sub WF 
subworkflow, the transition from step 7 to step 8 is called 1-Requirements 

Setup Completed. 

If you double-click step 8 (the destination step), the Properties tab of the 
Workflow Step window shows that the value in the Request Status field is 
also 1-Requirements Setup Completed. 
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All three items—the Quality Center status, the transition, and the Request 

Status field of the destination step—have the same value. Therefore, if the 
QA team changes the Quality Center status to 1-Requirements Setup 

Completed when step 7 is active, the workflow will advance to step 8. 

If you need to change the value of the Request Status field of the 
destination step, in the Properties tab of the Workflow Step window for 
that step, specify the new value in the Request Status field and click OK. 

If you need to change the Meaning field that defines the transition name, 
right-click the preceding decision step and select Edit Source; in the 
Validation section of the Decision window, click Open; click the validation 
value (row) of interest and click Edit; specify the new value in the Meaning 
field; click OK to close all open windows. For more detailed information, 
see the HP Demand Management Configuration Guide. 
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Request Hierarchy Synchronization

The integration of PPM Center with Quality Center allows you to synchronize 
the hierarchies of requests in PPM Center and requirements in Quality Center, 
that is, to make the Quality Center requirement hierarchy match the PPM 
Center request hierarchy automatically, as in the following example sequence:

1. A PPM Center request named Request A is created.

2. With integration, an associated Requirement A is automatically created in 
Quality Center.

3. A PPM Center request named Request B is created with a reference to 
Request A indicating that Request A is the parent of Request B.

4. An associated Requirement B is automatically created in Quality Center. If 
request hierarchy synchronization is enabled, since Request B is the child 
of Request A, Requirement B is automatically created as the child of 
Requirement A.

If you later delete the relationship (the reference) between Request A and 
Request B in PPM Center, the relationship between Requirement A and 
Requirement B is automatically deleted in Quality Center. For integration with 
Quality Center version 11.00, instead of being a child of Requirement A, 
Requirement B is moved to the folder specified in the Default QC Folder Name 
field. 

For information about enabling request hierarchy synchronization with requirements in 
Quality Center version 10.00: 

 If a mapping has not been created between the Quality Center requirement and the 
PPM Center request type, see step 15 on page 176. 

 If a mapping has been created, see Enabling and Disabling Request Hierarchy 
Synchronization on page 200. 

For information about enabling request hierarchy synchronization with requirements in 
Quality Center version 11.00, see Integration with a Quality Center Requirement 
on page 224.

If Requirement A does not exist in Quality Center, creating a reference in PPM 
Center from Request B to Request A has no effect in Quality Center.
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When request hierarchy synchronization is first enabled, it does not cause 
immediate reorganization of existing requirements in Quality Center to 
retroactively match the hierarchy of associated requests. Thereafter, however:

 Any update to any field in an existing integrated request initiates an update 
to the hierarchy (folder structure) of the associated requirement to reflect 
the hierarchy of the request.

 Upon creation of any new PPM Center request, the integration creates a 
new Quality Center requirement in a matching hierarchy.

 Any changes you make to the hierarchy in PPM Center are automatically 
reflected in the hierarchy of the Quality Center requirements. Thus, 
changes made in Quality Center to the hierarchy of a requirement can be 
overridden later by updates to the associated PPM Center request.

PPM Center allows a request to have multiple parents, but Quality Center 
limits a requirement to only one parent. If a PPM Center request has multiple 
parents, Quality Center does not duplicate that hierarchy in the project, and 
PPM Center displays a message indicating a problem with hierarchy 
synchronization.

Example of Request Hierarchy Synchronization

The following screen shows a Quality Center requirement called 
Req. Hierarchy with three requirements. 

Field names ITG Request Id, ITG Server, and ITG Request Status are used for 
Quality Center version 10.00. In Quality Center version 11.00, these field names are 
PPM Request Id, PPM Server, and PPM Request Status. 
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Each requirement is mapped to a PPM Center request of type ALM - Request 
for Change (RFC). The request numbers in PPM Center are shown in the 
ITG Request Id column (for Quality Center version 10.00) or PPM Request Id 
column (for Quality Center version 11.00). When the requests were created, 
their RFC Summary fields were specified as Parent Requirement, Child 

Requirement, and Grand-child Requirement to indicate their intended hierarchy 
(first in PPM Center and then automatically as requirements in Quality Center) 
after establishing the relationships among the requests in PPM Center.

When you open a request, you can add a different request in the References 
section and specify the relationship of the reference request to the request you 
opened. For example, the reference request can be a child or a parent of the 
open request.

For the example, you could use any one of the following methods to establish 
the relationships among requests, which would then automatically synchronize 
the relationships among the associated Quality Center requirements:

 Open request 30002 and make it the parent of request 30003, and then open 
request 30003 and make it the parent of request 30004. 

 Open request 30003 and make it the child of request 30002, and then open 
request 30004 and make it the child of request 30003. 

 Open only request 30003 and make it both the child of request 30002 and 
the parent of request 30004. This method is slightly quicker and is used in 
the following procedure.

To create the relationships between the requests, in PPM Center:

1. Select and open the request for which you want to define one or more 
relationships.

In the example, open request 30003.
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2. In the Reference Additions section of the request, in the New Reference 
drop-down list, select Request (Existing). 
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3. Click Add. 

The Add Reference: Request window opens.
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4. Specify data about the request to be related to the open request, and click 
Search. 

In this example, type 30002 in the Request # field and click Search. 

If the search is successful, the following window opens.

The window allows you to select from the search results which requests 
will be references (in the example, 30002 is the only request found using 
the specified search criteria), and to select an option to specify the 
relationship the reference request (or requests) will have to the open 
request (30003 in the example).

5. In the Request Search Results section, select the check box for the request 
that is to be made a reference.

6. In the upper section of the window, select the option for the relationship 
you want this reference request to have to the open request. 

In this example, select Parent of this Request because you want reference 
request 30002 to be the parent of open request 30003.

7. Click Add. 

The reference request and its relationship are added to the References to be 

added on Save text box in the open request.
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8. Repeat step 2 on page 237 through step 7 (or step 3 on page 238 through 
step 7) as necessary to create parent and child relationships with additional 
requests.
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In this example, follow step 3 through step 7, but in step 4 type 30004 in 
the Request # field to make that request the one to reference, and in step 6 
select Child of this Request because you want reference request 30004 to be 
the child of open request 30003.
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9. Click Save. 

The reference requests with which you have defined relationships are listed 
in the References section, Requests subsection of the open request. 
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In Quality Center, the requirements (rows) are now reorganized and 
indented to reflect the relationship hierarchy you specified among the PPM 
Center requests.

Field names ITG Request Id, ITG Server, and ITG Request Status are used for 
Quality Center version 10.00. In Quality Center version 11.00, these field names are 
PPM Request Id, PPM Server, and PPM Request Status. 
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7 Integrating PPM Center with HP Release 
Control, Using ALM
Introduction to Integrating PPM Center with Release Control, 
Using ALM

Integrating PPM Center with Release Control enables you to link directly from 
a change request in PPM Center to associated impact analysis data in Release 
Control. Based on the information provided in Release Control, you can then 
decide whether to approve or reject the deployment of the change request. 

For more information about the benefits of this integration, see Integration of 
PPM Center with Release Control, Using ALM on page 21. 

For information about the versions supported for integration, see the System 
Requirements and Compatibility Matrix. 

For more information about Release Control, see its product documentation at 
the Web site described in Optional PPM Center Integrations on page 17.

No software needs to be installed on the Release Control server to integrate PPM 
Center with Release Control. However, see the System Requirements and 
Compatibility Matrix. 
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Configuring Release Control for the Integration

To configure Release Control for integration, you must do the following:

 Configure the PPM Center Web Services adapter in Release Control

 Configure the JavaScript files in Release Control

Before beginning this configuration, verify that Web services are enabled for 
use with PPM Center, as follows: 

1. Stop the PPM Server.

2. Run the following script:

sh ./kConfig.sh 

3. Verify that the ENABLE_WEB_SERVICES parameter in the PPM Center 
server.conf configuration file is set to true. 

4. Restart the PPM Server.

Configuring the PPM Center Web Services Adapter

To establish integration, you must configure the PPM Center Web Services 
adapter in Release Control to convert change requests that come from PPM 
Center to generic requests that Release Control can process, as follows:

1. Configure the PPM Center Web Services connector settings as described in 
the HP Release Control Installation and Configuration Guide. 

2. In the itg-ws-adapter.settings file, under <request-type 
level="1">, set the requestTypeName to the name of the PPM Center 
request type representing a PPM Center release, for example, 
ALM - Release Management. 

For more information about the steps in this procedure, see the Installation and 
Administration Guide. 

Before version 7.0, PPM Center was known as Mercury IT Governance Center or 
ITG. Release Control software and documentation might still refer to PPM Center 
as IT Governance Center or ITG.
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3. In the itg-ws-adapter.settings file, under <request-type 
level="2">, set the requestTypeName to the name of the PPM Center 
request type representing a PPM Center change, for example, 
ALM - Request for Change (RFC), and set the parentRequestTypeName to 
the value of the requestTypeName in step 2. 

Configuring the JavaScript Files

Configure the JavaScript files in Release Control for the integration with PPM 
Center. 

Refer to documentation for Release Control and contact HP Release Control 
Support as necessary.

Configuring PPM Center for the Integration

Before beginning to configure the integration as described in this section, make 
sure that ALM has been installed and initially configured as described in 
Chapter 2, Installing and Setting Up ALM Software, on page 23.

Establishing Server Connections for Supported Versions

Make sure that the HTTP port is open between the PPM Server and the Release 
Control machines. 

Verify that a supported version of Release Control is installed and running (see 
the System Requirements and Compatibility Matrix).

If PPM Center is (or will be) integrated with HP Universal CMDB as well, additional 
configuration steps may be required in Release Control before configuring the 
JavaScript.
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Configuring the server.conf Parameter in PPM Center

To be able to open Release Control from PPM Center as part of the integration, 
add and specify the parameter related to Release Control integration to the 
PPM Center server.conf configuration file, as follows:

1. Stop the PPM Server.

2. Run the following script: 

sh ./kConfig.sh 

Set the parameter and value as shown in the following table. (All parameter 
names begin with com.kintana.core.server. but that is not shown in 
the table.)

3. Verify that the ENABLE_WEB_SERVICES parameter in the server.conf file 
is set to true. 

4. Restart the PPM Server.

For more information about the steps in this procedure, see the Installation and 
Administration Guide. 

Parameter Value

CCM_MACHINE_URL

URL of the Release Control server:

http://<RC_Host>:<Port>/ccm/ 

where <RC_Host> represents the host machine on 
which Release Control is running
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Using the Integration of PPM Center with Release Control 

ALM provides the ALM - Releases portlet to facilitate the release request 
process (see ALM - Releases Portlet on page 82). If PPM Center and Release 
Control are integrated, for each release request you can click the Click to View 
link in the View Impact column in the portlet to log in to Release Control. 
When you log in, Release Control displays the Overview tab and other tabs. 
The information displayed for the selected change request includes the 
following, for example:

 The “service desk application” from which the request originated. From the 
perspective of Release Control, PPM Center is a service desk application in 
this context. 

 On the Request Details tab, the request ID number of the original change 
request, with a link to open the change request in PPM Center.

 On the Request Details tab, the planned and actual start and end times for 
execution of the request. 

 On the Overview tab, the number of configuration items (CIs) and 
applications that are affected by the request, with links that access the 

Impact Analysis tab, where details of the affected CIs and applications are 
displayed.

 On the Collaboration tab, the communication among users regarding action 
items.

If PPM Center is integrated with Release Control and with Universal CMDB, 
you can click the Launch HP Release Control button in the Impacted 

Configuration Items section of an ALM - Request for Change (RFC) request in 
PPM Center to access Release Control. 
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8 Integrating PPM Center Tasks with 
HP Service Manager RFCs
Introduction to Integrating PPM Center Tasks with Service 
Manager RFCs

For an overview of the integration of PPM Center tasks with Service Manager 
RFCs, see Integration of PPM Center Project Tasks with Service Manager 
RFCs on page 22.

This integration allows PPM Center project managers to specify which tasks in 
a project, if any, automatically create corresponding requests for change 
(RFCs) in Service Manager. As the RFCs are completed in Service Manager, 
the statuses of the associated PPM Center tasks are automatically set to 
Complete (or Cancelled).

The typical flow of this integration is as follows: 

 A project manager creates a task in a PPM Center project, which initiates 
an operational RFC in Service Manager.

 Key information is copied from the task to the RFC (and is updated when 
the task is modified).

 A Service Manager user works on the RFC, and the PPM Center task is 
automatically updated to reflect the RFC status.

 The project manager can review the status of the Service Manager RFC as 
reflected in the PPM Center task.

This integration does not use the ALM entities and does not require installing the ALM 
software.
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 Upon completion of the Service Manager RFC, the PPM Center task status 
is updated to Complete or Cancelled. 

Configuring the Integration of PPM Center Tasks and Service 
Manager RFCs

To configure this integration, perform the following steps in PPM Center and 
Service Manager. You must have system administrator privileges in both PPM 
Center and Service Manager. 

1. Stop the PPM Server.

2. Check the PPM Center Web services configuration. Make sure the basic 
authentication mode is enabled. 

a. Open the configuration file located at: <PPM_Home>\server\  
<PPM_Server_Name>\deploy\itg.war\WEB-INF\conf\axis2.xml, 
where <PPM_Server_Name> is the host name or IP address of your 
PPM Center instance.

b. Make sure the value of InFlowBasicAuth is true. 

3. Log on to Service Manager. In the cm3r table in Service Manager, add a 
new field for the PPM Center task ID (for example, PPMTaskId). The field 
name you specify here will be used for field mapping in step 4.

4. In PPM Center, check the field mapping file, which defines the field 
mapping from PPM Center to Service Manager:

a. In the <PPM_Home>\conf\smrfc directory, copy the field mapping file 
sm-rfc-mapping.xml.sample under the same directory and rename 
the copied file to sm-rfc-mapping.xml. 

b. In the new mapping file, map the TASK_ID field to the Service 
Manager field that you created in step 3. The fields in the mapping file 
are case-sensitive.

If PPM Center is operating in a cluster configuration, you must update the 
axis2.xml file for all of the nodes in the cluster.
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c. In the new mapping file, verify that the Status field in Service Manager 
is set to initial. This value will be maintained by Service Manager 
after the change record is created in Service Manager.

The following is an example of the sm-rfc-mapping.xml file:

<?xml version="1.0" ?>
<PPMSMIntegration>
<SMRFCMapping>

<field>
<smField>PPMTaskId</smField>
<ppmField>TASK_ID</ppmField>
<useOnCreate>true</useOnCreate>
<useOnUpdate>true</useOnUpdate>

</field>
<field>

<smField>BriefDescription</smField>
<ppmField>TASK_NAME</ppmField>
<useOnCreate>true</useOnCreate>
<useOnUpdate>true</useOnUpdate>

</field>
<field>

<smField>Description</smField>
<ppmField>TASK_DESCRIPTION</ppmField>
<useOnCreate>true</useOnCreate>
<useOnUpdate>true</useOnUpdate>
<defaultValue>ppm task does not have a description

</defaultValue>
</field>
<field>

<smField>RequestedDate</smField>
<ppmField>TASK_SCHEDULED_END_DATE</ppmField>
<useOnCreate>true</useOnCreate>
<useOnUpdate>true</useOnUpdate>

</field>
<field>

<smField>RequestedBy</smField>
<useOnCreate>true</useOnCreate>
<defaultValue>FALCON, JENNIFER</defaultValue>

</field>
.
.
.

</SMRFCMapping>
</PPMSMIntegration> 
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Each element in the mapping file is described in the following table: 

Notes: 

 You can add more mappings as needed. However, make sure that all 
the Service Manager fields specified in the field mapping file are 
exposed through the Service Manager ChangeManagement Web 
service. For more information, see step 5 on page 256.

 The tokens in the following table can be used in the ppmField element.

Element Description

field
Each field element represents a field mapping between PPM 
Center and Service Manager.

smField

Caption name of the Service Manager field. The Service 
Manager field must be exposed through the ChangeIIA object 
in the ChangeManagement Web service in Service Manager. 
For more information, see step 5 on page 256.

ppmField
Field name of the PPM Center task. For the tokens available 
for this element, see the notes following this table.

useOnCreate
Specifies whether or not the field value is sent to Service 
Manager when an RFC is created.

useOnUpdate
Specifies whether or not the field value is sent to Service 
Manager when an RFC is updated.

defaultValue
Provides a default value for the Service Manager field.

Note: If ppmField is not specified, or the value of ppmField 
is null or empty, then this default value is used.

Token Description

TASK_ID Task ID

TASK_NAME Name of the task

TASK_DESCRIPTION Description of the task

TASK_STATUS Status meaning of the task

TASK_PRIORITY Priority of the task

TASK_IS_MILESTONE Whether the task is a milestone
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TASK_IS_MAJOR_MILESTONE
Whether the task is a major 
milestone

TASK_SCHEDULED_END_DATE Scheduled finish date of the task

TASK_SCHEDULED_START_DATE Scheduled start date of the task

TASK_PATH

Path of the task in the following 
format: rootTask > 
firstLevelTask > 
secondLevelTask >... 

TASK_USERDATA_01 through 
TASK_USERDATA_20

User data fields 1 – 20 of the task

PROJECT_ID Project ID

PROJECT_NAME Name of the project

PROJECT_REQUEST_ID PFM request ID of the project

PROJECT_MANAGER_USER_ID User ID of the project manager

PROJECT_MANAGER_USERNAME User name of the project manager

PROJECT_MANAGER_FULLNAME Full name of the project manager

PROJECT_MANAGER_EMAIL
Email address of the project 
manager

SYS_USER_ID User ID of the current user

SYS_USERNAME user name of the current user

SYS_USER_FULLNAME Full name of the current user

SYS_USER_EMAIL Email address of the current user

Token Description
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5. Make sure that the Service Manager fields specified in the field mapping 
file are exposed through the ChangeIIA object in the ChangeManagement 
Web service in Service Manager.

In Service Manager, check that all the fields are listed on the Fields tab of 
the ChangeIIA object (for the cm3r table) in the ChangeManagement Web 
service. If any field is not listed, add the field name and caption name to the 
Field and Caption columns. For details on how to expose the fields of a 
table through a Service Manager Web service, see the Service Manager 
online help.
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6. Load the following files, located in the <PPM_Home>\conf\smrfc 
directory, into Service Manager:

 PPMIntegration.unl (the integration unload file)

 PPMIntegration_Schedule.unl (the ppmfailover schedule object 
file)

7. Configure the integration table in Service Manager. 

In Service Manager, open the related form for the ppmIntegration table 
and add the following new record to the table:

If you are using an Oracle database with Service Manager, loading of the 
PPMIntegration.unl file might fail the first time. Normally, reloading the file 
will solve the problem.

If you load the PPMIntegration_Schedule.unl file more than one time, 
duplicate ppmfailover schedules will be created in Service Manager. If this is 
the case, delete the redundant ppmfailover schedules.

Table Field Value

Id 1

Field to Store TaskId

The value of this field must match the field name you 
previously added to the cm3r table for the PPM 
Center task ID (see step 3 on page 252). For 
example, PPMTaskId. 

If the field names do not match, the integration will 
fail.

PPM Server URL
URL of the PPM Center Web services. For example:  
http://<Host_Name>:<Port>/itg/ppmservices/ 

PPM Server Username

The user name that Service Manager uses to call the 
PPM Center Web services. 

This user name must include only single-byte 
characters.

HP recommends that you create a separate user 
account for this purpose. 

PPM Server Password
The password of the user name that Service Manager 
uses to call the PPM Center Web services. 
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8. Modify the Service Manager processes as necessary. 

Modify the processes that will call the PPM Center Web services to update 
the RFC status and task status, by adding the following code to the Final 

Javascript tab of each process:

system.library.HPPPMSMIntegration.integratePPM(); 

9. Configure the ppmfailover schedule in Service Manager.

By default, the Repeat Interval of the ppmfailover schedule is one hour. 
You can change the default Repeat Interval to another value. However, do 
not change other field values. 

10. Start the ppmfailover schedule in Service Manager. 

The code was added to the cm.close, cm.reject, cm.update.save, and 
cm.next.phase processes when you loaded the PPMIntegration.unl file. The 
standard Save, Close, Reject, Next Phase, and Reopen actions for RFCs 
invoke these processes. If you have added any other actions used to update 
changes (through tailoring of your Service Manager instance), you must also 
modify the processes that these self-defined actions will invoke.
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11. Run the following script: 

sh ./kConfig.sh 

12. Add (if not present) and specify the parameters and values related to 
Service Manager integration to the PPM Center server.conf 
configuration file, as shown in the following table. (All parameter names 
begin with com.kintana.core.server. but that is not shown in the 
table.)

For more information about the following steps, see the Installation and 
Administration Guide. 

Parameter Value 

SM_RFC_INTEGRATION_ENABLED true

SM_USERNAME

User name that PPM Center uses to 
access Service Manager. 

This user name must include only 
single-byte characters. For example: 
admin. 

SM_PASSWORD

Password that PPM Center uses to 
access Service Manager. You must 
encrypt this password by using the 
kEncrypt.sh script, which is located 
in the bin directory of the PPM Server. 
Then remove #!# from the beginning 
and the end of the encrypted 
password.

SM_URL
Host name or IP address of Service 
Manager. For example:

http://<Host_Name>:13080

SM_WEB_URL

Address of Service Manager Web tier. 
For example:

http://<Host_Name>:<Port>/
<WebTier_Package_File_Name>/
index.do

ENABLE_WEB_SERVICES true
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13. Start the PPM Server. 

Enabling RFC Creation for a PPM Center Project Type

In the HP Service Manager project policy in PPM Center, you can enable or 
disable the RFC creation capability at the project type level. The settings of a 
project type affect all projects of that project type. However, the policy has an 
option to allow project managers to override the project type setting for 
particular projects.

To set the RFC creation capability for a project type:

1. Log on to PPM Center.

2. From the menu bar, select Open > 

Administration > Project Types & Templates > Manage Project Types. 

3. Open the project type you want to configure. 

The Modify Project Type window for that project type opens. 

4. In the list of policies, click HP Service Manager. 

The HP Service Manager policy opens. 

The default settings for the options enable RFC creation for projects of the 
selected project type and allow project managers to override that setting for 
particular projects of that type:
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5. To enable all projects of this project type for RFC creation and prevent 
project managers from disabling this capability, make sure that the Enable 

RFC creation capability check box is selected and the override option is set 
to No. 

If you want project managers to control the RFC creation capability for 
particular projects regardless of the setting of the Enable RFC creation 

capability check box, set the override option to Yes. 

6. Click Save. 
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Enabling RFC Creation for a PPM Center Project 

If the RFC creation capability is enabled for the project type used by a project, 
the RFC creation capability is, by default, enabled for the project when it is 
created. 

If the RFC creation capability is not enabled for a project, to enable it:

1. Log on to PPM Center.

2. Open the project in PPM Center.

3. On the Project Overview page, click Project Settings. 

4. In the list of policies, click HP Service Manager. 

The HP Service Manager policy opens.
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5. Use one of the following procedures to verify or enable your ability to 
create Service Manager RFCs for the project:

 If the Enable RFC creation capability check box is selected, you can 
create Service Manager RFCs for the project. 

 If the Enable RFC creation capability check box is not selected but you 
can select it, select it.

 If the Enable RFC creation capability check box is not selected and you 
cannot select it, the setting on the project type used by the project does 
not currently allow you to enable RFC creation for any projects of that 
type or to override that setting for particular projects. In this case, see 
Enabling RFC Creation for a PPM Center Project Type on page 260 
and set the override option on the project type to Yes, or contact the 
person who configures these settings. Then return to the HP Service 
Manager policy for the project and select the Enable RFC creation 

capability check box for the project.

6. Click Done. 

Creating a Service Manager RFC from a PPM Center Task

To create an RFC in Service Manager that is associated with a project task in 
PPM Center:

1. Log on to PPM Center, and do the following:

a. Make sure the RFC creation capability is enabled for the project. See 
Enabling RFC Creation for a PPM Center Project.

b. On the Project Overview page, click Edit Work Plan, and then 
double-click a task to open it.

The Task Details page for that task opens.

c. On the Operational RFC tab on the Task Details page, select the 
Create an Operational Request for Change (RFC) upon task save check 
box.
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d. Click Save. 

After the task is saved, PPM Center returns to the task page. If Service 
Manager returns an RFC Change ID, the information on the 
Operational RFC tab is automatically updated with the following 
information from Service Manager, which is read-only in PPM Center:

In addition, the status line, which is located at the bottom of the task 
page, indicates the success of the RFC creation.

Item Value

Change Number

Change ID (for example, C10029) of the RFC 
created in Service Manager, which is 
displayed as a link. Clicking the link takes 
you to the Service Manager logon screen.

Change Status
Value from the Status field of the RFC in 
Service Manager.

Closure Code
Value from the Closure Code field of the RFC 
in Service Manager.

Closure Comments
Reason entered when the RFC in Service 
Manager was closed or rejected. 

Change Last Update Date
Date (and time) when the RFC was last 
updated in Service Manager.

If Service Manager does not return an RFC Change ID, an error message is 
displayed on the status line. In most cases, this means the RFC was not 
created. However, it is possible that the RFC was successfully created but 
communication problems prevented Service Manager from returning the RFC 
Change ID to PPM Center. 

To prevent duplicate RFCs from being created for the same task, when the 
task is saved, PPM Center searches for an RFC Change in Service Manager 
to which the task should be attached. If an RFC is found, PPM Center 
integrates with it. If PPM Center does not find an RFC, it creates one.
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2. Log on to Service Manager, and do the following to verify that the RFC has 
been successfully created.

a. Click Menu Navigation > Change Management > Changes, and then 
double-click Search Changes. 

b. Click Search. 

A list of changes opens, where you can find the change (RFC) created 
for the PPM Center task with the following fields related to the PPM 
Center task:

Synchronizing an RFC with its Associated PPM Center Task 

When you update a Service Manager RFC that has an associated PPM Center 
task, the information on the PPM Center task’s Operational RFC tab is 
automatically updated. 

To update an RFC and then check the status of its associated task:

1. Log on to Service Manager.

2. From the change list, double-click a change (RFC) that has an associated 
PPM Center task.

3. Update the RFC in Service Manager.

4. In PPM Center, refresh the Task Details page for the task to verify that the 
Operational RFC tab displays the updated status of the associated RFC. 

Field Value

Change ID
Change ID generated for the task (shown as Change 
Number in PPM Center). For example, C10029.

Brief Description Name of the PPM Center task. For example, Task 6.

PPM Task ID
Task ID that PPM Center assigned to this task. For 
example, 36002. 
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Updating the Status of a PPM Center Task when the Associated 
RFC is Closed or Rejected 

When you close or reject a Service Manager RFC that has an associated PPM 
Center task, the status of the PPM Center task is automatically set to Complete 
or Cancelled, and the information on the task’s Operational RFC tab is updated 
accordingly. 

To close or reject an RFC and then check the status of its associated task:

1. Log on to Service Manager.

2. From the change list, double-click a change that has an associated PPM 
Center task.

3. Close or reject the change.

4. In PPM Center, refresh the Task Details page for the associated task to 
verify that the Operational RFC tab is updated and that the task status is also 
updated as shown in the following table: 

Field Value

Status One of the following:

 Complete (if the change was closed)

 Cancelled (if the change was rejected)

% Complete One of the following:

 100 (if the change was closed)

 0 (if the change was rejected)
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Error Logging

PPM Center includes a sample logging file to debug or monitor the integration. 
Configure logging as in the following example:

1. Open the sample logging file, located at: 

<PPM Server>/conf/smrfc/logging.conf.sample

2. Copy the last two lines from the sample logging file into the PPM Center 
logging file, which is located at:

<PPM Server>/conf/logging.conf

These two lines are as follows, and they enable logging for the 
integration-specific classes SmRfcFieldMap and SmRfcFieldMapReader: 

com.kintana.core.logging.CLASS_LOGGING_LEVEL=com.mercury.
itg.core.service.util.SmRfcFieldMap,DEBUG

com.kintana.core.logging.CLASS_LOGGING_LEVEL=com.mercury.
itg.core.service.util.SmRfcFieldMapReader,DEBUG

3. Revise the copied lines as needed. 

4. By default, the copied lines set the logging mode for the integration to 
DEBUG. When you do not need to debug the integration, set the logging 
mode on the copied lines to ERROR or comment out the copied lines.
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9 Integrating PPM Center with HP Universal 
CMDB for Service Portfolio
Introduction to Integrating PPM Center with Universal CMDB for 
Service Portfolio 

For service portfolio functionality, services can be associated with the Service 
field in PPM Center requests, and then labor costs can be tracked for each 
service. The list of services can be retrieved from Universal CMDB in real 
time, that is, each time a PPM Center user needs the list to specify the Service 
field.

The service list does not reside in PPM Center. After configuring the 
integration with Universal CMDB, the service list can be retrieved from 
Universal CMDB.

Configuring Universal CMDB for the Integration

To configure Universal CMDB for the integration:

1. In Universal CMDB, create a configuration item type (CI type) for the 
service list, if none has been created for the service list. The CI type should 
include Name and Service Description attributes. Later, this CI type will be 
specified in the server.conf configuration file in PPM Center.

This integration does not use the ALM entities and does not require installing the ALM 
software.
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2. Create CIs of this type, one for each service that is to be included in the 
service list.

(Optional) Configuring Universal CMDB to Support HTTPS for the Integration 

If you need to enable real-time integration with Universal CMDB using 
HTTPS, perform one of the following procedures, depending on whether or 
not the Universal CMDB server already supports HTTPS. Then proceed to 
Configuring PPM Center for the Integration on page 273.

Configuring Universal CMDB if the Server Already Supports HTTPS 

If the current Universal CMDB server is already configured to support HTTPS, 
you can use the existing keystore file directly:

1. Locate the keystore file.

2. Locate the certificate in the keystore.

3. Run the script below to export the certificate:

keytool -export -alias [Certificate alias name] -keystore 
<UCMDB_Server_HOME>\UCMDBServer\j2f\EJBContainer\server\

mercury\conf\<keystore or certs file name> -file c:\
<Certificate alias name>

4. Import the certificate to the PPM server:

keytool -import -trustcacerts -alias 
[Certificate alias name]

-keystore [keystore or certs file path]
-file c:\<Certificate alias name>

If your Universal CMDB server is configured to support HTTPS, additional 
configuration steps are required to enable the real-time integration with Universal 
CMDB. For details, see (Optional) Configuring Universal CMDB to Support HTTPS for 
the Integration. 
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Configuring Universal CMDB if the Server Does Not Support HTTPS Yet

If the current Universal CMDB server is not configured to support HTTPS yet, 
do the following:

1. Generate the keystore file on Universal CMDB.

Run the following scripts:

<UCMDB_Server_HOME>\UCMDBServer\j2f\JRE\bin>keytool -genkey 
-keystore 

<UCMDB_Server_HOME>\UCMDBServer\j2f\EJBContainer\server\
mercury\conf\ucmdb.keystore

Enter the keystore password and provide other information as necessary 
when prompted.

2. Enable SSL on the Web server for Universal CMDB Server.

a. To enable JBoss in SSL, edit the following file:

<UCMDB_Server_HOME>\j2f\EJBContainer\server\mercury\
deploy\jbossweb-tomcat55.sar\server.xml

Uncomment the following entry: 

<!-- SSL/TLS Connector configuration using the admin devl 
guide keystore:
<Connector port="8443" address="${jboss.bind.address}"

maxThreads="100" strategy="ms" 
maxHttpHeaderSize="8192"
emptySessionPath="true"
scheme="https" secure="true" clientAuth="false"
keystoreFile="${jboss.server.home.dir}/conf/

ucmdb.keystore"
keystorePass="changeit" [keyAlias="myCert"]
sslProtocol = "TLS" />

-->

Make sure that keystoreFile and keystorePass are set to the correct 
path of a java keystore and its password respectively.

If the keystore holds more than one certificate, the first one will be used. 

(Optional) To choose a specific certificate, use the keyAlias attribute with 
the alias of the certificate. 
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With the above settings, JBoss will look for the keystore in:

<UCMDB_Server_HOME>\j2f\EJBContainer\server\mercury\conf\
ucmdb.keystore

b. Restart the Universal CMDB server. 

Now, to access the Universal CMDB web page in SSL you can go to the 
URL 

https://<UCMDB_Server_HOST>:8443/ucmdb 

3. Generate a certificate in the keystore file with alias ucmdbCer, then export 
the certificate and import it to the PPM Server.

a. Run the script below to generate the certificate:

keytool -genkey -alias ucmdbCer -keyalg RSA -keystore 
<UCMDB_Server_HOME>\UCMDBServer\j2f\EJBContainer\server\

mercury\conf\ucmdb.keystore

b. Export the certificate:

keytool -export -alias ucmdbCer -keystore 
<UCMDB_Server_HOME>\UCMDBServer\j2f\EJBContainer\server\

mercury\conf\ucmdb.keystore -file c:\ucmdbCer

c. Import the certificate to the PPM server:

keytool -import -trustcacerts -alias ucmdbCer -keystore 
[keystore or certs file path] -file c:\ucmdbCer
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Configuring PPM Center for the Integration

To configure PPM Center for the integration, you configure the required 
server.conf parameters and a request type with the Service field, as 
described in the following sections.

Configuring server.conf Parameters in PPM Center

Add (if not present) and specify the parameters related to Universal CMDB 
integration for service portfolio to the PPM Center server.conf configuration 
file, as follows: 

1. Stop the PPM Server.

2. Run the following script: 

sh ./kConfig.sh 

Set the parameters and values as shown in the following table. (All 
parameter names begin with com.kintana.core.server. but that is not 
shown in the table.)

For more information about the steps in this procedure, see the Installation and 
Administration Guide. 

Parameter Description

SERVICE_LIST_SOURCE

Specifies the source of the list of available 
services:

 uCMDB to retrieve the list of services from 
Universal CMDB each time they are needed for 
PPM Center requests

 lookup to retrieve the list of services from 
PPM Center for PPM Center requests and 
project tasks

For integration with Universal CMDB, enter 
uCMDB. 
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SERVICE_LIST_UCMDB_
CACHE_TIMEOUT

Length of time (in seconds) the service list 
remains in PPM Center cache before it is 
retrieved again, for example, 300. For more 
information, see the Installation and 
Administration Guide. 

SERVICE_LIST_UCMDB_
CI_MAPPINGS

Service list mappings between the following pairs 
of attributes:

 The name attribute for the Service List uCMDB 
autocomplete list in PPM Center, and the CI 
name attribute in Universal CMDB

 The description attribute for the Service List 
uCMDB autocomplete list in PPM Center, and 
the CI description attribute in Universal CMDB

The mappings are formatted in pairs and 
separated by commas as follows (with no spaces 
or new lines): 
name:<uCMDB_CI_Name_Attribute>,
description:
<uCMDB_CI_Description_Attribute>
For example, the value of this parameter could be: 
name:data_name,description:
service_description
This example maps name in PPM Center to the CI 
name attribute data_name in Universal CMDB, 
and it maps description in PPM Center to the 
CI description attribute service_description 
in Universal CMDB.

Note: All items that are to be mapped must 
already exist in PPM Center or Universal CMDB. 

SERVICE_LIST_UCMDB_
CI_TYPE

Name of the CI type used to store the service list, 
for example, Service. HP recommends using 
the value Service. 

Note: You must create this CI type on the 
Universal CMDB server. For more information 
about creating a CI type, see the Universal CMDB 
documentation.

Parameter Description
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3. Restart the PPM Server.

SERVICE_LIST_UCMDB_
MAX_CI_NUMBER

The maximum number of Universal CMDB 
configuration items allowed in the service list, for 
example 1000. For more information, see the 
Installation and Administration Guide. 

UCMDB_SERVER_URL

URL of the Universal CMDB server:

http://<UCMDB_Host>:<port>/ucmdb/ 

or

https://<UCMDB_Host>:<port>/ucmdb

where <UCMDB_Host> represents the host 
machine on which Universal CMDB is running.

Note: If the Universal CMDB server is configured 
to support HTTPS, make sure you configure the 
UCMDB_SSL_KEYSTORE_PATH parameter. 
For information about enabling HTTPS for 
Universal CMDB, see (Optional) Configuring 
Universal CMDB to Support HTTPS for the 
Integration on page 270.

UCMDB_SERVER_
VERSION

Do not use.

UCMDB_SSL_
KEYSTORE_PATH

Universal CMDB keystore path, used only if the 
UCMDB_SERVER_URL parameter uses HTTPS.

UCMDB_WS_MAX_
CONNECTION_NUMBER

Maximum number of connections allowed to 
connect to the Universal CMDB server using the 
Web Service API, for example, 10. 

UCMDB_WS_
PASSWORD

Password for Universal CMDB user specified in 
UCMDB_WS_USER, logging in through Web 
service.

You must encrypt this password by using the 
kEncrypt.sh script, which is located in the bin 
directory of the PPM Server. 

UCMDB_WS_USER

Universal CMDB user name for logging in through 
Web service, for example, admin. 

This user name must include only single-byte 
characters.

Parameter Description
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Creating a Request Type with the Service Field

To create a request type that includes the Service field:

1. In PPM Center, create a request header type and enable its Service field 
group. 

2. Open the Service field in the request header type and make sure the 
validation for this field is Service List uCMDB. This validation is an 
autocomplete list. When users click the autocomplete for the Service field, 
this validation invokes a special command to retrieve the service list from 
Universal CMDB. (As with any request field, the administrator can make 
the Service field optional or required.)

3. Create a request type that uses the new request header type.

When users create a request of that new request type and click the 
autocomplete for the Service field, the service list options are retrieved from 
Universal CMDB at that time. 
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Index
A
adapter configuration files

PPM Center, for bidirectional integration of 
PPM Center requests with Service 
Manager changes, using ALM, 119

Service Manager, for integration of PPM 
Center requests with Service Manager 
changes, using ALM, 104

ALM, 11

ALM - Change Migration workflow, 59

ALM - Change Review and Approval Sub WF 
subworkflow, 48

ALM - Change Summary report, 65

ALM - Defect Template with Quality Center 
Integration request type, 154

ALM - Defect Template with Quality Center 
Integration workflow, 161

ALM - Deploy and Test Changes Sub WF 
subworkflow, 54

ALM - Deployed Releases portlet, 79

ALM - Forward Schedule of Changes for RFC 
report, 66

ALM - Forward Schedule of Releases report, 
87

ALM - Impact & Resource Assessment Sub 
WF subworkflow, 50

ALM - Infrastructure Changes Sub WF 
subworkflow, 51

ALM - My Releases portlet, 80

ALM - My RFCs portlet, 60

ALM - Non Release Sub WF subworkflow, 56

ALM - Open Releases portlet, 81

ALM - Open RFCs portlet, 61

ALM - Plan Tests Sub WF subworkflow, 52

ALM - Release Content report, 88

ALM - Release Distribution Sub WF 
subworkflow, 78

ALM - Release Distribution workflow, 78

ALM - Release Management request type, 68

ALM - Release Request workflow, 74

ALM - Release Sub WF subworkflow, 58

ALM - Release Summary report, 89

ALM - Releases By Category portlet, 83

ALM - Releases By Type portlet, 84

ALM - Releases portlet, 82

ALM - Request for Change (RFC) request type, 
32

ALM - Request For Change workflow, 41

ALM - RFC - Urgent Change Management Sub 
WF subworkflow, 47

ALM - RFCs By Category portlet, 62

ALM - RFCs By Reason for Change portlet, 63

ALM - RFCs By Status portlet, 64

ALM - RFCs per Release portlet, 85
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ALM-based integrations
See name of specific product that integrates 

with PPM Center using ALM.
Application Lifecycle Management

See ALM entries.

B
bidirectional integration of PPM Center 

requests and Service Manager changes, 91

C
change management, ITIL

portlets, 60
adding, 60
ALM - My RFCs, 60
ALM - Open RFCs, 61
ALM - RFCs By Category, 62
ALM - RFCs By Reason for Change, 

63
ALM - RFCs By Status, 64

reports, 65
ALM - Change Summary, 65
ALM - Forward Schedule of Changes 

for RFC, 66
request types

ALM - Defect Template with Quality 
Center Integration, 154

ALM - Request for Change (RFC), 32
workflows

ALM - Change Migration workflow, 59
ALM - Defect Template with Quality 

Center Integration workflow, 161
ALM - Request For Change workflow, 

41

CIs
See configuration items.

commands
special for integrations

See special commands: integrations 
using ALM.

configuration items
in Universal CMDB, 137, 143

configuring
ALM-related entities in PPM Center, 25
contact user data for integrations using 

ALM, 25
CRT - Priority - Enabled validation for 

integrations using ALM, 27
integration of PPM Center requests with 

Service Manager changes, using ALM, 
95

integration of PPM Center tasks with 
Service Manager RFCs, 252

integration of PPM Center with Quality 
Center, using ALM, 165

integration of PPM Center with Release 
Control, using ALM, 246

integration of PPM Center with Universal 
CMDB for CI selection, using ALM, 
139

integration of PPM Center with Universal 
CMDB for service portfolio (service 
list retrieval), 269

PPM Center adapter file for bidirectional 
integration of PPM Center requests 
with Service Manager changes, using 
ALM, 119

security groups for integrations using 
ALM, 28

Service Manager adapter file for 
integration of PPM Center requests 
with Service Manager changes, using 
ALM, 104

validation CRT - Priority - Enabled for 
integrations using ALM, 27

workflow security for integrations using 
ALM, 28

contact user data configuration for integrations 
using ALM, 25

CRT - Priority - Enabled validation 
configuration for integrations using ALM, 
27
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D
defects, Quality Center

See Quality Center.
documentation for products that integrate with 

PPM Center, 17

E
entities

ALM-related, 31

error logs
for integration of PPM Center requests with 

Service Manager changes, 133
for integration of PPM Center tasks with 

Service Manager RFCs, 267
for integration with Quality Center version 

11.00, 225

event logs
for integration of PPM Center requests with 

Service Manager changes, 133
for integration with Quality Center version 

11.00, 225

H
hierarchy synchronization of Quality Center 

requirements with PPM Center requests, 
234

I
impact analysis

See Universal CMDB.
installing

ALM
procedure, 24
system requirements, 23

integrating
PPM Center requests with Service Manager 

changes, using ALM
See Service Manager: integration of 

changes with PPM Center requests, 
using ALM.

PPM Center tasks with Service Manager 
RFCs
See Service Manager: integration of 

RFCs with PPM Center tasks.
PPM Center with Quality Center, using 

ALM
See Quality Center: integration with 

PPM Center, using ALM.
PPM Center with Release Control, using 

ALM
See Release Control: integration with 

PPM Center, using ALM.
PPM Center with Universal CMDB for CI 

selection, using ALM
See Universal CMDB: integration with 

PPM Center for CI selection, using 
ALM.

PPM Center with Universal CMDB for 
service portfolio
See Universal CMDB: integration with 

PPM Center for service portfolio 
(service list retrieval).

integration tool, PPM Center-Quality Center
See PPM Center-Quality Center Integration 

Tool (for Quality Center version 
10.00).

integrations with other HP products
See name of specific product that integrates 

with PPM Center.
ITIL Change Management, 14

See also change management, ITIL.
roles, 15

ITIL Release Management, 16
See also release management, ITIL.
roles, 17

K
kConfig.sh script, 131, 139, 170, 194, 246, 

248, 259, 273

kEncrypt.sh script, 117, 259, 275
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L
logging errors and events

for integration of PPM Center requests with 
Service Manager changes, 133

for integration of PPM Center tasks with 
Service Manager RFCs, 267

for integration of PPM Center with Quality 
Center version 11.00, 225

M
mapping of PPM Center and Quality Center 

fields, 152
See also Quality Center version 10.00: 

mapping of PPM Center and Quality 
Center fields.

See also Quality Center version 11.00: 
mapping of PPM Center and Quality 
Center fields.

N
Notes field in PPM Center, mapping to Quality 

Center version 10.00, 190

P
portlets

ALM - Deployed Releases, 79
ALM - My Releases, 80
ALM - My RFCs, 60
ALM - Open Releases, 81
ALM - Open RFCs, 61
ALM - Releases, 82
ALM - Releases By Category, 83
ALM - Releases By Type, 84
ALM - RFCs By Category, 62
ALM - RFCs By Reason for Change, 63
ALM - RFCs By Status, 64
ALM - RFCs per Release, 85
change management, 60
release management, 79

PPM Center
integration of requests with Service 

Manager changes, using ALM
See Service Manager: integration of 

changes with PPM Center requests, 
using ALM.

integration of tasks with Service Manager 
RFCs
See Service Manager: integration of 

RFCs with PPM Center tasks.
integration with Quality Center

See Quality Center: integration with 
PPM Center, using ALM.

integration with Release Control
See Release Control: integration with 

PPM Center, using ALM.
integration with Universal CMDB for CI 

selection, using ALM
See Universal CMDB: integration with 

PPM Center for CI selection, using 
ALM.

integration with Universal CMDB for 
service portfolio
See Universal CMDB: integration with 

PPM Center for service portfolio 
(service list retrieval).

PPM Center adapter file for bidirectional 
integration of requests with Service 
Manager changes, configuring, 119

PPM Center-Quality Center Integration Tool 
(for Quality Center version 10.00), 166
creating a field mapping, 178
default field mappings, 203
deploying a field mapping, 191
enabling a Quality Center project for 

integration, 171
installing, 169
managing existing mappings, 195
mapping Notes field in PPM Center to a 

Quality Center project, 190
Quality Center fields enabled by, 207

priority validation configuration for 
integrations using ALM, 27
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project tasks
integration with Service Manager RFCs

See Service Manager: integration of 
RFCs with PPM Center tasks.

Q
QC

See Quality Center.
Quality Center

See also Quality Center version 10.00.
See also Quality Center version 11.00.
integration with PPM Center, using ALM, 

20, 149
configuring, 165
using, 226

special commands for integration, 90
synchronization of requirements hierarchy 

with PPM Center requests hierarchy, 
234

Quality Center version 10.00
enabling a project for integration with PPM 

Center, 171
mapping of PPM Center and Quality Center 

fields
creating, 178
defaults, 203
deploying, 191
managing, 195
Notes field in PPM Center, 190

Quality Center version 11.00
added functionality compared to version 

10.00, 153
error and event logging, 225
mapping of PPM Center and Quality Center 

fields, 219

R
Release Control

integration with PPM Center, using ALM, 
21, 245
using, 249

release management, ITIL
portlets, 79

adding, 79
ALM - Deployed Releases, 79
ALM - My Releases, 80
ALM - Open Releases, 81
ALM - Releases, 82
ALM - Releases By Category, 83
ALM - Releases By Type, 84
ALM - RFCs per Release, 85

reports, 86
ALM - Forward Schedule of Releases, 

87
ALM - Release Content, 88
ALM - Release Summary, 89

request type
ALM - Release Management, 68

workflows
ALM - Release Distribution workflow, 

78
ALM - Release Request workflow, 74

reports
ALM - Change Summary, 65
ALM - Forward Schedule of Changes for 

RFC, 66
ALM - Forward Schedule of Releases, 87
ALM - Release Content, 88
ALM - Release Summary, 89
change management, 65
modifying ALM-related, 32
release management, 86

Request for Change, 32

request hierarchy synchronization for 
integration between PPM Center and 
Quality Center, 234

request types
ALM - Defect Template with Quality 

Center Integration, 154
ALM - Release Management, 68
ALM - Request for Change (RFC), 32
modifying ALM-related, 32
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requests
integration with Service Manager changes

See Service Manager: integration of 
changes with PPM Center requests, 
using ALM.

requirements, Quality Center
See Quality Center.

requirements, system
See system requirements.

RFC, 32

roles
ITIL Change Management, 15
ITIL Release Management, 17

S
scripts

kConfig.sh, 131, 139, 170, 194, 246, 248, 
259, 273

kEncrypt, 117, 259, 275
setServerMode.sh, 25, 29

security group configuration for integrations 
using ALM, 28

service list retrieval from Universal CMDB
See Universal CMDB: integration with 

PPM Center for service portfolio 
(service list retrieval).

Service Manager
integration of changes with PPM Center 

requests, using ALM, 18, 91
adapter file, configuring, 104
configuring, 95
logging of errors and events, 133

integration of RFCs with PPM Center tasks, 
22, 251
configuring, 252

service portfolio
See Universal CMDB: integration with 

PPM Center for service portfolio 
(service list retrieval).

setServerMode.sh script, 25, 29

special commands
integration of PPM Center with Quality 

Center using ALM, 90
modifying ALM-related, 32

stubs, Web services
generating for integration of PPM Center 

requests with Service Manager 
changes, using ALM, 103

subworkflows
See workflows.

system requirements
installing ALM, 23

T
tasks

integration with Service Manager RFCs
See Service Manager: integration of 

RFCs with PPM Center tasks.

U
Universal CMDB

integration with PPM Center for CI 
selection, using ALM, 19, 137
configuring, 139
using, 143

integration with PPM Center for service 
portfolio (service list retrieval), 22, 269
configuring, 269

Universal Configuration Management 
Database
See Universal CMDB.

V
validation configuration for integrations using 

ALM, 27
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W
Web services

stubs for integration of PPM Center 
requests with Service Manager 
changes, using ALM, 103

workflow security configuration for 
integrations using ALM, 28

workflows
ALM - Change Migration workflow, 59
ALM - Change Review and Approval Sub 

WF subworkflow, 48
ALM - Defect Template with Quality 

Center Integration workflow, 161
ALM - Deploy and Test Changes Sub WF 

subworkflow, 54
ALM - Impact & Resource Assessment Sub 

WF subworkflow, 50
ALM - Infrastructure Changes Sub WF 

subworkflow, 51
ALM - Non Release Sub WF subworkflow, 

56
ALM - Plan Tests Sub WF subworkflow, 

52
ALM - Release Distribution Sub WF 

subworkflow, 78
ALM - Release Distribution workflow, 78
ALM - Release Request workflow, 74
ALM - Release Sub WF subworkflow, 58
ALM - Request For Change workflow, 41
ALM - RFC - Urgent Change Management 

Sub WF subworkflow, 47
modifying ALM-related, 32
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